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UTS Overview 
About UTS 

The Unit Travel System, (UTS) is a Windows � based application developed by Professional 
Software Consortium to serve as a TDY  voucher preparation system for the U.S. 
Coast Guard.  In addition, UTS can be used to create Travel Authorizations, Travel Orders, and 
prepare Requests for Advances of travel expenses. UTS is not used for PCS at this time.   

Travel Authorizations, Advance Requests and Settlement Requests are created either by the 
individual Traveler or a designated Proxy.  Once an authorization or request is created, the 
transaction is transferred to an Authorizing Official for approval.  

Approved Settlement Requests are initially submitted to the travel claims processing office and 
then imported into the Integrated Automated Travel System (IATS) for computation.   

 

Logging into UTS 
In order to use the UTS program, all users must login to the program using a valid Employee ID 
and Password.  For initial logins, however, there are two situations that could apply: 

�� The user account was created systemically by importing the personnel file 

�� The user account was created by the System Administrator 

 Login Procedures if Account was Imported: 

1. At the UTS login screen enter your social security number.  If UTS recognizes the SSN, the 
UTS Login pop-up appears stating that the user must create a UTS Password and fill in 
other personal information.   

2. Click on OK to continue and the Password Information screen appears. 

  

3. At this screen enter the following information.  Refer to the links under the heading “See 
Also” below if additional instructions are needed: 
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�� New Logon Password 

�� New Secondary Password 

�� Mother’s Maiden Name 

�� Date of Birth 

�� Town of Birth 

Tip:  Passwords must be (8) characters.  In addition, (2) of the characters must be numeric 

4. After entering this information, click the Save button.  The UTS Request Status screen 
appears. 

 Login Procedures if Account Created by System Administrator: 

1. At the UTS Login screen, enter the Employee ID that was created by the System 
Administrator.  If UTS recognizes the Employee ID, the UTS Password screen appears. 

 

2. At this screen, enter the Password that was created by the System Administrator.  The UTS 
Request Status or UTS Requests Requiring Action screen will appear if the Employee ID 
and Password was entered correctly. 

3. If you don’t remember your password, click the Forgot my Password button.  The Password 
Information screen appears requiring you to enter authentication information.  Refer to the 
links Forgot my Password and Authentication Information listed below, under the heading 
“See Also, for additional instructions, if needed. 

4. Since passwords should only be known by the user, after logging in, the user should change 
his/her passwords.   

See Also  
New Logon Password  

New Secondary Password  

Authentication Information  

Forgot my Password  

Changing Passwords  
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Forgot my Password 
When logging into UTS, the user must first enter a valid Employee ID.  If UTS recognizes the 
Employee ID, the UTS Password screen appears.   

 

At this screen the user is required to enter a valid password, which has been previously 
established.  If unable to remember the password, however, the user must click the Forgot my 
Password button. 

After clicking the Forgot my Password button, the Password Information screen appears. 

 

At this screen, the user must enter the following information: 

�� Mother’s Maiden Name 

�� Date of Birth 

�� Town of Birth 

After entering the required information, the user must now click the Authenticate button.  If the 
information entered matches the authentication information in the UTS database, the New Logon 
and Secondary Password sections are displayed. 

The user must now enter a new Logon and Secondary password. 

When finished entering the new passwords, the user must click the Save button.  The UTS 
Request Status or UTS Requests Requiring Action screen appears. 
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See Also 
Logging into UTS  

New Logon Password  

New Secondary Password  

 

Entering Dates 
Dates can be entered into the UTS program using the following formats: 

�� MMDD Format:  For example; to enter the date February 1st, type 0201 and press Enter.  UTS 
will automatically default to the current year. The date will be displayed as 02/01/2002, if the 
current year is 2002. 

�� MMDDYY Format:  For example; to enter the date February 1st, 2002, type 020102 and press 
Enter.  The date will be displayed as 02/01/2002. 

�� Pop-up Calendar:  Users can also enter dates by using the built-in calendar that appears when 
double clicking on a date field. 

  

The calendar defaults to the current month and year.  Ensure that these are correct.  If not, click 
on the arrow in either of these fields to display a listing of months or years, then point and click 
on the desired choice.  After ensuring that the month and year is correct, point and click on the 
correct date to make a selection. 

 

Entering Amounts 
Amounts can be entered into the UTS program using the following formats: 

�� With Decimal Point:  If entering a number that involves cents, such as, $200.50, type 200.50 
and press Enter.  The amount will be displayed as 200.50. 

�� Without Decimal Point:  If entering a whole number, such as, $200.00, type 200 and press 
Enter.  UTS automatically enters the decimal and displays the amount as 200.00 
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Entering Accounting 
When creating a travel authorization, order, advance, or settlement, an accounting 
appropriation should be added.  This is necessary to determine whether funds are available and to 
charge the expenditures to the appropriate organization. 

 Use the following procedures to add an accounting appropriation: 

Regardless of which travel action is being processed, there will always be a Modify Acctng 
button on the input screen.  

  

1. Click on this button to bring up the Request Accounting screen.   

  

2. At this screen, perform one of the following actions: 

�� Enter Appropriations 

�� Select a RAN Code 

�� Enter Accounting Remarks 

 Complete the following steps to Add an Appropriation: 

  

1. Click in the r/d field and enter the appropriate information.  

2. Press Enter or Tab to advance to the next accounting field and enter the appropriate 
information. 

3. When finished populating all of the required fields, click on the Validate Accounting button. 

4. After clicking on the Validate Accounting button, a prompt may appear stating that you must 
select a RAN number.  If so, click the OK button. 
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5. A drop down listing of RAN codes now appears on the right side of the Request Accounting 
screen.  Click on the Up/Down arrows to navigate the listing and click on the desired RAN 
code to make a selection. 

6. After selecting a RAN code, click on the Validate Accounting button to complete the process 
and return to the previous input screen. 

 Complete the following steps to Add Accounting Remarks: 

On occasion, it may be beneficial add a remark when entering the accounting data to a travel 
request.  It might be necessary to explain why an appropriation was created or modified.  
Accounting Remarks can be added by using the following procedures: 

1. At the Request Accounting screen, there is a Remarks box displayed just below the Current 
Request Accounting Lines table.  Click inside of the box. 

2. Type the desired remarks.   

3. Click the Validate Accounting button to complete the process and return to the previous 
input screen. 

 

Entering Remarks 
When creating a travel authorization, order, advance, or settlement, it may be necessary or 
beneficial to add some remarks to the travel action.   

 Use the following procedures to add Remarks: 

Regardless of which travel action is being processed, there will always be a Remarks button on 
the input screen.   

  

1. Click this button to access the Settlement or Advance Request Remarks screen. 

  

2. At this screen you will find a Remarks text box.  Type the desired remarks in this box.   

3. When finished entering remarks, click the Return button to return to the previous input 
screen. 
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Rates Look-Up 
While using UTS, it may be necessary to lookup the locality per diem rate for a particular 
location.  This can be accomplished a variety of ways. 

 Complete the following steps to Lookup Locality Per Diem Rates: 

There are three methods that can be used to lookup locality per diem rates.  The method used 
however, depends on which input screen is currently displayed.   

1. At the UTS Request Status or UTS Requests Requiring Action screen, use one of the 
following methods to access the locality per diem rates: 

�� Method 1: - Click on the dollar sign ($) button.  

�� Method 2: - Click on the Tools menu, then click on the CONUS/OCONUS City Rates option. 

  

2. Method 3: - At the input screens for authorizations, orders, advances, and settlements, click 
on the View Other Info menu and then click on the Rates option. 

  

3. After using one of the methods described in items 1 - 3 above, the Location Lookup screen 
appears.   
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4. At the State/Country field, type the first letter of the state or country then click the Up/Down 
arrows until the desired name is displayed.  Click on the name to select.   

5. At the City field, type the first two letters of the city name.  This displays a listing of city 
names, for the previously selected state or country, beginning with those letters.  Click the 
Up/Down arrows until the desired name is displayed, then click on the desired city name to 
select. 

6. After selecting a State/Country and City, the UTS City Rate Lookup screen appears 
displaying the locality rates for the selected city. 

  

7. When finished looking at the locality rates, click the Return button. 
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Terminating UTS 
When finished using UTS, return to the UTS Request Status or UTS Requests Requiring 
Action screen and use one of the following methods to terminate the program: 

  

Method 1: - Click the X in the top right corner and then click on Yes. 

Method 2: - Click the File menu and then click the Exit option. 

Method 3: - Click on the Stop button in the lower right corner. 

 

Travel History 
A history record, which may be used by travelers for conducting research, is created for every 
travel transaction generated by the UTS program.   

 Accessing the Travel History Record: 

1. Login to UTS as a Traveler or change the view to Traveler if necessary. 

2. At the UTS Request Status screen, click on the Tools menu and then select the History 
option or click on the binoculars icon.  The Select Travel Order screen appears. 
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3. At this screen, point and click on the desired travel order number to make a selection.  If 
desired, all of the listed travel orders can be selected by clicking on the Select All button. 

Tip:  By first pressing and holding down the Ctrl key, the user may select more than one travel 
order.   

4. After selecting the desired travel order, click the Display/Print History button.  The History 
screen will appear. 

  

5. At the History screen, the following options are possible: 

�� Previous Order - If more than one travel order has been selected, click on this button to return 
to the previously displayed order. 

�� Next Order - If more than one travel order has been selected, click on this button to advance to 
the next available order. 

�� More Order Data - Click on this button to display the TDY  Travel Order screen. 

�� Print - Click on this button to generate a print-out of the history record.   

�� View Request - Click on this button to display the Local Travel - 1164 screen or the Request 
for Advance or Settlement screen. 
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�� Return - Clicking on this button returns the user to the Select Travel Order screen.  The user 
may then select another travel order and display or print the history, or go back to the UTS 
Request Status screen. 

 

UTS Help 
A Help System has been included with the UTS program that provides explanations for the 
numerous program features.  In addition, users will find detailed instructions that will guide them 
through the various functions involved in processing travel claims.   

Note:  The UTS Help System can be accessed from any screen by clicking on the Help menu.   

  

After clicking on Help, a drop down menu appears listing the following Help options: 

�� Contents - Select this option to see a display of the available topic categories. 

�� Index - Select this option to see an alphabetical listing of UTS Help topics. 

�� This Screen - Select this option to see a Help topic for the particular UTS screen that is 
currently displayed. 

�� About UTS - Select this option to see a Help topic describing the UTS program. 

Tips for using the UTS online system 

When a help window is open, the following options are available: 

�� Users can maximize or resize help windows as needed. 

�� Click on the Help Topics button to return to screen displaying the Contents, Index, and Find 
tabs. 

�� Click on the Print button to receive a print-out of the topic. 

�� Click on the >> button to advance to the next topic in the browse sequence, or the << button to 
return to the previous topic. 

�� Click on any word or phrase that is underlined and highlighted in green to automatically jump 
to a topic that describes the underlined item. 

�� Click on a link displayed under the heading See Also to jump from one topic to another related 
topic. 

�� After clicking on a link under the heading, See Also, click the Back button to return to the 
previous topic. 
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See Also 
Contents  

Index  

Find  

This Screen  

 

Help Contents 
Topics in the UTS Help system are categorized into Books.  Help Contents Books are displayed 
two ways: 

1. Click the Help menu at the top of any screen and then click on the Contents option. 

2. Click on the Contents tab at the Help Topics screen. 
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 Displaying Help Topics: 

1. Point and click on a Book, then click the Open button.  The Help system will then display 
Help topics contained within the selected Book. 

  

Tip:  Notice that there may be additional Books located within a Book. 

2. Point and click on a Topic, then click the Display button.  The Help system will display the 
contents of the selected topic. 
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Tips for using the UTS Online Help System 

When a help window is open, the following options are available: 

�� Users can maximize or resize Help windows as needed. 

�� Click on the Help Topics button to return to the screen displaying the Contents, Index, and 
Find tabs. 

�� Click on the Print button to receive a print-out of the topic. 

�� Click on the >> button to advance to the next topic in the browse sequence or the << button to 
return to the previous topic. 

�� Click on any word or phrase that is underlined and highlighted in green to automatically jump 
to a topic that describes the underlined item. 

�� Click on a link displayed under the heading See Also to jump from one topic to another related 
topic. 

�� After clicking on a link under the heading, See Also, click the Back button to return to the 
previous topic. 

See Also 
UTS Help  

Index  

Find  

This Screen  

 14 



 

Help Index 
Topics in the UTS Help system are listed alphabetically in an Index.  When the Index option is 
selected from the Help drop down menu or when then user clicks on the Index tab on the Help 
Topics screen, a listing of the UTS Help topics is displayed. 

  

 Use one of the following methods to display Help topics with the Index: 
�� Method 1: - In block 1, type the first few letters of a Help topic.  The Help system will 

highlight the first topic matching the letters entered.  If this is not the desired topic, click on the 
up/down arrows on the right side of the Index window to scroll through the listing until the 
correct topic is highlighted.  When the desired topic is highlighted, click the Display button. 

�� Method 2: - Click the up/down arrows on the right side of the Index window to scroll through 
the listing.  When the desired topic is displayed, point and click on this topic to highlight.  
When the correct topic is highlighted, click the Display button. 

�� Method 3: - Click the up/down arrows on the right side of the Index window to scroll through 
the listing.  When the desired topic is displayed, point and double click on this topic to display. 

When finished viewing a topic, click the Help Topics button to return to the Index. 

See Also 
UTS Help  

Contents  

Find  

This Screen  
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This Screen 
A “This Screen Help Topic has been created for every UTS screen.  These topics were developed 
to assist individuals who may be new users and don’t understand what a particular UTS screen is 
used for.  A This Screen topic can be accessed by clicking on the Help menu at the top of any 
screen and then selecting the This Screen option from the drop down menu. 

  

After clicking on the This Screen option, the topic for the current UTS screen is displayed.   

  

The “This Screen topic provides general information about the purpose of the screen and offers 
links to other topics providing more specific information about using the screen. 
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Find Help 
Another feature of the UTS Help System is a Find option to perform a    “Full-Text Search.  This 
feature enables the user to search every topic in the Help system for a particular word or phrase.  
The full-text search only finds topics containing the word or phrase the user is looking for. 

 Complete the following steps to use the Find option: 

1. Click the Find tab on the Help Topics screen.  The following screen appears: 

  

2. At this screen, type a word or phrase in block 1.  If the correct option is active, the program 
will begin the search automatically and display the matches in blocks 2 and 3.   

3. Click the up/down arrows on the right side of block 3 to scroll through the list of topics.   

4. Point and click on a topic to highlight and click the Display button, or simply double click on 
a topic.  The UTS Help System will display the selected topic. 

See Also 
UTS Help  

Contents  

Index  

This Screen  

 

Jumps 
A Jump occurs when a user is viewing a particular help topic and clicks on a word or phrase that 
is underlined and highlighted in green.  This action takes the user to a topic describing the word or 
phrase that was underlined. 
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UTS Screens 
UTS Login Screen 

All users of UTS must login to UTS by entering a valid Employee ID at the Login screen.  

  

At this screen, the user must enter their Employee ID, which is most likely their social security 
number, (SSN), and press Enter or click the Login button.  If the Employee ID is valid, the UTS 
Password screen appears. 

User accounts are typically created in the UTS database by importing a personnel information file.  
If logging into UTS for the first time, users should enter their SSN at the Employee ID field.  The 
Password Information screen appears requiring the user to establish a Logon and Secondary 
password. 

If the user account was manually created by the System Administrator, an Employee ID and 
Password was established for the user.  The user must enter the Employee ID that was created by 
the SA.  After the Employee ID is entered, the UTS Password screen appears requiring the user to 
enter the password that was created by the SA. 

Note:  After the initial login, the user should change the Logon and Secondary Passwords that 
were established by the System Administrator. 

See Also 
Logging Into UTS  

New Logon Password 

New Secondary Password 

Changing Passwords 

Forgot My Password 
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UTS Request Status Screen 
When a user logs into UTS in the Traveler view, the UTS Request Status screen appears.  This 
screen is used to initiate all requests for travel actions and determine the status of these requests.  
In addition, this screen gives the user the ability to view, modify, delete, print or release most 
travel actions. 

 

Along the top of this screen, the user will see the File, Profile, Log in as, Tools and Help menu 
selections.  If the user clicks on any of these items, a drop down menu appears offering additional 
selections.   

Just below the menu selections, the user will find several icons that can be used instead of clicking 
on a menu selection and choosing an option.   

  

If the user positions the mouse pointer on any of these icons, a pop-up tip appears explaining the 
purpose of the particular icon. 

The middle section of the UTS Request Status screen lists any transactions that are pending 
follow-up action by the Traveler, or Proxy, depending on which view the user is logged in with.  
By reviewing this section, the user can easily determine what travel authorizations, orders, or 
settlement claims have been entered and the status of each of these items. 

 The following functions can be performed from the UTS Request Status 
screen: 

Travel Authorizations 
Create Travel Authorizations 

View Travel Authorizations  

Modify Travel Authorizations 
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Delete Travel Authorizations   

Release Travel Authorizations  

Travel Orders 
Create TDY Travel Order  
  

Travel Advances 
Creating Travel Advances  

Viewing Travel Advances  

Modifying Travel Advances  

Deleting Travel Advances  

Releasing Travel Advances  

Local 1164 Travel 
Creating Local 1164 Claim  

Viewing Local 1164 Claim  

Modifying Local 1164 Claim  

Deleting Local 1164 Claim  

Releasing Local 1164 Claim  

Travel Settlements 
Creating Travel Settlements  

Viewing Travel Settlements  

Modifying Travel Settlements  

Deleting Travel Settlements  

Releasing Travel Settlements  

Profiles 
View or Modify Profile  

Change View   

Tools 
Rates Look-Up 

Display or Print Travel History 

Terminating UTS 

Create an Email Message 

 

UTS Requests Requiring Action Screen 
When a user logs into UTS in the Authorizing Official view, the UTS Request Requiring 
Action screen appears.  This screen is used to approve travel requests that were initiated by the 
Traveler or Proxy and then released to the AO for approval.  In addition, this screen gives the AO 
the ability to view, modify, or return travel requests. 
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Along the top of this screen, the user will see the File, Profile, Log in as, Tools, Forward and 
Help menu selections.  If the user clicks on any of these items, a drop down menu appears 
offering additional selections.   

Just below the menu selections, the user will find several icons that can be used instead of clicking 
on a menu selection and choosing an option.   

  

If the user positions the mouse pointer on any of these icons, a pop-up tip appears explaining the 
purpose of the particular icon. 

The middle section of the UTS Requests Requiring Action screen lists any transactions that are 
pending approval by the Authorizing Official.  By reviewing this section, the user can easily 
determine what travel authorizations, or settlement requests have been received and are requiring 
approval. 

 The following functions can be performed from the UTS Requests 
Requiring Action screen: 

Travel Authorizations 
View Travel Authorizations  

Modify Travel Authorizations 

Approving Travel Authorizations  

Returning Travel Authorizations  

Travel Orders 
Select a Travel Order  

Viewing Travel Orders  

Modifying Travel orders  
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Deleting Travel Orders  

Travel Settlements 
Viewing Travel Settlements  

Modifying Travel Settlements  

Approving Travel Settlements  

Returning Travel Settlements  

Profiles 
Change View   

Tools 
Rates Look-Up 

Terminating UTS 

Create an Email Message 

Forwarding Requests 
Forward Requests to Another AO  

Automatic Forwarding  

Manual Forwarding  

 

Select Travel Order Screen 
Depending on how this screen is accessed, the Select Travel Order screen allows the user to 
perform the following actions: 
�� Create a new travel order,  
�� View, Modify, or Delete an existing order 
�� Select an order for processing a request for Advance or Settlement 
�� Display or Print the History for a travel order 
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At this screen, any travel orders that have already been created for the traveler will be listed in the 
middle of the screen.  The user can select the correct order, then click on a function button to 
perform the desired action.  If necessary, the user can also click on the Create New Order button 
and create a new order.   

 The following links provide detailed instructions for performing the 
various functions that can be initiated after accessing the Select Travel 
Order screen: 

Create TDY Travel Order  

View Travel Orders  

Modify Travel Orders  

Delete Travel Orders  

Create Request for Advance  

Create Request for Settlement  

Display or Print Travel History  

 

TDY Travel Request Screen 
The TDY Travel Request screen is used to capture the data needed by the Authorizing Official 
(AO) to approve an authorization for TDY travel.  The information collected on this screen 
provides the AO with the requested trip dates, locations, mode of travel, funding appropriations, 
and anticipated expenditures. 

  

Tip:  Notice that the TDY Travel Request screen consists of (3) sections; Top, Itinerary, and 
Reimbursable Exp. 
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 The following links provide detailed instructions for completing each 
section of the TDY Travel Request screen: 

Top Section  

Itinerary  

Reimbursable Expenses  

 

MILPCS Travel Request Screen(Note: UTS is not used for PCS at this time) 
The MILPCS Travel Request screen is used to capture the data needed by the Authorizing Official 
(AO) to approve an authorization for Military PCS travel.  The information collected on this 
screen provides the AO with the requested travel dates, locations, mode of travel, funding 
appropriations, dependent information, and anticipated expenditures. 

  

Tip:  Notice that the MILPCS Travel Request screen consists of (4) sections; Top, Dependents, 
Itinerary, and Reimbursable Exp. 

 The following links provide detailed instructions for completing each 
section of the MILPCS Travel Request screen: (Note: UTS is not used for PCS) 

Top Section  

Dependents  

Itinerary  

Reimbursable Expenses  
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Request Accounting Screen 
The Request Accounting screen is used to enter an accounting appropriation for the request and 
add remarks that pertain to the accounting appropriation. 

  

Tip:  This screen is separated into three input boxes.    
�� Possible Valid Accounting Lines - This box is located at the top of the screen.  This section is 

not in use currently.   
�� Current Request Accounting Lines - This box is located in the middle of this screen.  This 

box is used to manually enter an accounting appropriation. 
�� Remarks - This box is located at the bottom of the screen.  This area is used to capture remarks 

pertaining to the accounting appropriations entered. 

 The following links provide detailed instructions for completing each 
section of the Request Accounting screen: 

Entering an Accounting Appropriation  

Adding Accounting Remarks  

 

Profile Screen 
A Personal Profile is a user account that is created for every individual who will use UTS and 
every traveler, who’s claim is processed through UTS.  The Profile screen is used to store 
personal, financial and security information, establish privileges, and designate the Authorizing 
Official and Signature Proxy. 
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 The following links provide detailed instructions for completing each 
section of the Profile screen: 

Personal Information  

Home Address  

Work Address  

Financial Information  

Security Information  
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Local Travel -1164 Screen 
The Local Travel - 1164 screen is used to enter the information needed to file a settlement claim 
for the performance of temporary duty within the defined local travel area of the traveler’s 
official duty station. 

  

 The following links will provide detailed instructions for completing each 
section of the Local Travel - 1164 screen: 

Creating Local 1164 Claim  

Entering Local 1164 Claim  

Inserting Expense  

Deleting Expense  

Entering Accounting  

Entering Remarks  

Canceling Local 1164 Claim  

Saving Local 1164 Claim  

Releasing Local 1164 Claim  

Printing Local 1164 Claim  

Deleting Local 1164 Claim  

Viewing Local 1164 Claim  

Modifying Local 1164 Claim  
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Request for Advance Screen 
The Request for Advance screen is used to enter the data necessary for processing an advance 
payment of TDY or MILPCS travel funds.  An approved Travel Authorization or Travel Order 
must be selected in order to access this screen. 

  

 The following links provide detailed instructions for completing the 
Request for Advance screen: 

Creating Request for Advance  

Entering Request for Advance  

Entering Accounting  

Entering Remarks  

 

Remarks Screen 
When creating a travel authorization, order, advance, or settlement, it may be necessary or 
beneficial to add some remarks to the travel action.  This can be accomplished by clicking on the 
Remarks button to access the Remarks screen. 
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 The following link provides detailed instructions for completing the 
Remarks screen: 

Entering Remarks  

 

Request for Settlement Screen 
The Request for Settlement screen is used to enter the data necessary for processing a settlement 
claim for a completed TDY or MILPCS trip.  An approved Travel Authorization or Travel 
Order must be selected in order to access this screen. 

  

 The following links provide detailed instructions for completing the 
Request for Settlement screen: 

Creating Request for Settlement  

Request for Settlement Itinerary  

Reason for Stop  

Method of Reimbursement  

Request for Settlement Reimb. Expenses  

Entering Accounting  

Entering Remarks  

Exceptions  

Occasional Expenses  

Deleting Request for 1351-2 Settlement  

Canceling Request for 1351-2 Settlement  

Releasing Request for 1351-2 Settlement  

Printing Request for 1351-2 Settlement  
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Saving Request for 1351-2 Settlement  

Viewing Request for 1351-2 Settlement  

Modifying Request for Settlement  

 

Trip Screen 
The Trip screen is used to capture the specific details regarding a completed TDY or MILPCS 
trip.  At this screen, the user must complete an itinerary and enter all of the claimed expenses.   

  

Tip:  Notice that there are (3) sections to the Trip screen; Top, Itinerary, and Reimbursable 
Expenses.  In addition, there are special buttons to access the Exceptions to Daily Expenses and 
Occasional Expenses screens. 

 The following links provide detailed instructions for completing the Trips 
screen: 

Top Section  

Itinerary  

Reason for Stop  

Method of Reimbursement  

Reimbursable. Expenses  

Exceptions to Daily Expenses  

Occasional Expenses  
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Exceptions Screen 
After completing a settlement itinerary, it may be necessary to access the Exceptions screen to 
make adjustments to the default values for the lodging costs and meal types.  Or, if Actual 
Expense (AE) was selected for the reimbursement method, then it is necessary to access the 
Exceptions screen to enter the daily amounts for meals and incidental expenses. 

  

 The following link provides detailed instructions for completing the 
Exceptions screen: 

Entering Exceptions  

 

Occasional Expenses Screen 
For certain types of travel situations, per diem is not payable.  If a traveler is required to use 
personal funds to purchase meals or lodging, however, these expenses are considered to be 
Occasional Expenses.  Reimbursement for the purchase of occasional expenses typically occur 
under one of the following circumstances: 
�� Round Trip performed in 12 Hours or Less 
�� Duty on board a Government Ship 
�� Field Conditions 

If one these situations apply, the Occasional Expenses screen is used to capture the expenses for 
lodging and meals purchased by the traveler with personal funds. 
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 The following link provides detailed instructions for completing the 
Occasional Expenses screen: 

Entering Occasional Expenses  

 

MILPCS Travel Order Screen (Note: UTS is not used for PCS at this time) 
The MILPCS Travel Order screen is used to establish the following details: 

�� Travel Order Number 
�� Type of PCS Travel 
�� Locations of the Old and New PDS 
�� Authorized Miles 
�� Agency Funding the Travel 
�� Purpose of the Travel 
�� Detach and Reporting Dates 
�� Order Issue Date 
�� Group Travel Rules 
�� Special Authorizations 
�� Accounting Appropriation 
�� Dependent Information 
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This screen must be completed before a Request for MILPCS Advance or Settlement can be 
entered. 

Note:  Information coming from a from an approved hard-copy travel order, that was generated 
outside of UTS, must be manually entered into this screen by the user.  UTS automatically 
populates this screen, however, for travel authorizations that were created with UTS and were 
approved by an AO.   

 The following links provide detailed instructions for completing the 
MILPCS Travel Order screen: 

MILPCS Order - Top Section  

MILPCS Order - Are These Authorized  

MILPCS Order - Dependents  

Entering Accounting  

Entering Remarks  

Canceling Travel Orders  

Saving Travel Orders  

Deleting Travel Orders  

Viewing Travel Orders  

Modifying Travel Orders  
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Select Traveler Screen 
The Select Traveler screen appears whenever an individual is logged into UTS in the Proxy 
View, and creates one of the following travel actions on behalf of another person: 

�� Request for TDY Travel Authorization 
�� Request for Military PCS Travel Authorization 
�� Local 1164 Claim 

  

Note:  The Proxy and the personnel listed on this screen are both assigned to a unit sharing the 
same OPFAC number. 

The purpose of this screen is to allow the Proxy to select the individual that the travel action is 
being created for.  When this screen appears, the Proxy should point and click on the desired 
name, then click on the appropriate action button at the bottom of the screen.   

Tip:  The action button available will depend on which create option was selected. 
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Select Traveler and Travel Order Screen 

The Select Traveler and Travel Order screen appears when a user is logged into UTS as a 
Proxy and a Request for Advance or Settlement is created on the behalf of another person.  This 
screen is used to select the specific traveler and travel order that will be used for the transaction.   

  

The table at the top of this screen lists all of the traveler’s the Proxy may process transactions for.  
Point and click on the desired name, and the table at the bottom  lists all travel orders existing in 
the database for the selected traveler. 

Point and click on the desired order, then click on the appropriate action button at the bottom of 
the screen.   

Note:  The action button available will depend on which create option was selected. 

See Also 
Creating TDY Travel Orders  

Creating MILPCS Travel Orders  

Creating Request for Advance  

Creating Request for Settlement  
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City & County Screen 
The City & County screen appears when clicking on the Tools menu from the UTS Request 
Status or Requests Requiring Action screen and selecting the CONUS/OCONUS City Rates 
option.  This screen also appears when completing an itinerary and accessing the Location field, 
or clicking on the Choose City button. 

  

When this screen is displayed, the user must first select a state or county by entering the first two 
letters of the state or country name and then pointing and clicking on the desired choice from the 
listing.   

After selecting a state or country, the user must also use the same procedure to select a city name. 

See Also 
Rates Look-Up  

UTS City Rate Lookup Screen  

 36 



 

UTS City Rate Lookup Screen 
This screen lists the per diem rates, by effective date, for the city selected.  If you wish to look 
the rates up for another city, click the Chose City button. 

  

 The following links provide detailed instructions for looking up City 
Rates: 

Rates Look-Up 

City & County Screen  

 

History Screen 
The History screen is used to provide historical information for research and inquiry purposes.  
By accessing this screen, the user can view travel order information and travel settlement 
information.  In addition, the user can also generate a print-out of the historical record for a 
single order or all of the existing orders.   
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At this screen, the user has the following options: 
�� Previous Order - If more than one travel order has been selected, click on this button to return 

to the previously displayed order. 
�� Next Order - If more than one travel order has been selected, click on this button to advance to 

the next available order. 
�� More Order Data - Click on this button to display the TDY or MILPCS Travel Order 

screen. 
�� Print - Click on this button to generate a print-out of the history record.   
�� View Request - Click on this button to display the Local Travel - 1164 screen or the Request 

for Advance or Settlement screen. 
�� Return - Clicking on this button returns the user to the Select Travel Order screen.  The user 

may then select another travel order, display and print the history, or go back to the UTS 
Request Status screen. 

See Also  
Travel History  

 

Authorizing Official Reassignment Screen 
When user accounts are created in UTS, a default Authorizing Official (AO) is established for the 
purpose of approving travel authorizations, advances and settlements.  If a particular AO will be 
unavailable to approve the requested action, however, a substitute AO can be assigned.  This is 
accomplished by accessing the UTS Maintenance Module and displaying the Authorizing 
Official Reassignment Screen.   
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At this screen, the user must select the AO, who will have their pending travel actions reassigned 
to another AO. 

 The following link provides detailed instructions for reassigning an AO: 
Reassigning Authorizing Official  

 

Reassign Requests Screen 
The Reassign Requests screen is the next screen to appear after having selected an AO at the 
Authorizing Official Reassignment screen and clicking the Reassign Requests button.   

  

At this screen, the travel requests pending approval by the AO selected at the Authorizing Official 
Reassignment screen are displayed.  The user must select the desired travel request and then click 
on the appropriate action button at the bottom of the screen. 

 The following link provides detailed instructions for reassigning 
requests: 

Reassigning Authorizing Official  
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Forward Claims to Selected AO Screen 
After selecting a travel request at the Reassign Requests screen the Forward Claims to Selected 
AO screen appears when the Forward to Another AO button is clicked.  

  

At this screen the user must select the AO, who will receive the reassigned transaction. 

 The following link provides detailed instructions for forwarding claims to 
another AO: 

Reassigning Authorizing Official  
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Replacement AO Screen 
The Replacement AO screen appears after clicking on the Replace as Default AO button at the 
Reassign Requests screen. 

  

At this screen the user must select the AO who will replace the original default AO.  After 
selecting a new AO and clicking the Replace as Default AO button, this new AO becomes the 
default AO for all travelers, who previously had the replaced AO selected as their default AO. 

 The following link provides detailed instructions for replacing a default 
AO: 

Reassigning Authorizing Official  

 

UTS Maintenance Screen 
The UTS Maintenance screen is the main menu screen for the UTS Maintenance Module.  From 
this screen, the System Administrator can perform the following actions: 

�� Create the IATS Interface File 
�� Maintain User Accounts 
�� Maintain City Names and Rates 
�� Reassign Authorizing Officials 
�� Maintain Ships Table 

 41



 

�� Maintain Miscellaneous Parameters 
�� Maintain Units 
�� Maintain Reimbursable Expense Table 
�� Import Personnel Data 
�� Import Accounting Data 

  

 The following links provide detailed instructions for performing the 
various functions available from the Maintenance Module: 

Exporting Claims  

Maintaining User Accounts  

Maintaining City Names and Rates  

Reassigning Authorizing Officials  

Maintain Ships Table  

Maintain Miscellaneous Parameters  

Maintaining Units  

Importing Unit Data  

Importing Reimbursable Exp. Descriptions  

Importing Personnel Data  
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Importing Accounting Data  

Importing Object Codes  

Importing RAN Codes  

 

UTS Export Claims Screen 
The UTS Export Claims screen is used to perform the following actions: 
�� Specify the type of claims to export 
�� Specify the location where the UTS Export File will reside 
�� Specify the location where the IATS Reply File will reside 
�� Create the UTS Export File 

  

Once the correct configuration information is entered, the user can click the Start Export button 
to create the export file. 

 The following link provides detailed instructions for completing the UTS 
Export Claims screen: 

Exporting Claims  

 

Unit Maintenance Screen 
All organizations, having Coast Guard members or employees assigned, have been given a Unit 
Number.  In addition, any organization that funds official travel for members or employees of the 
Coast Guard has also been assigned an Unit Number.   

Unit information is stored in the UTS Maintenance Module and can be added, modified, or 
deleted by accessing the UTS Maintenance Module and clicking on the Add/Modify Units 
button.  After clicking this button, the Unit Maintenance screen appears. 
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Use this screen to add, modify, or delete unit information. 

 The following link provides detailed instructions for maintaining the Unit 
Table: 

Maintaining Unit Table  

 

UTS Rates/Cities Update Screen 
CONUS and OCONUS locality City Names and Per Diem Rates are stored in the UTS 
Maintenance Module.  The maintenance tables storing these names and rates must be continually 
updated to ensure that travel claims are accurately processed.  This is accomplished by accessing 
the UTS Maintenance Module and displaying the UTS Rates/Cities Update Screen.   

  

 The following links provide detailed instructions for looking up locality 
per diem rates and updating the UTS Rates/Cities tables: 

Rates Look-Up 

City & County Screen  

Maintaining Cities and City Rates  
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Select Authorizing Official Screen 
All requests for Travel Authorizations, Advances, and Settlements must be forwarded to a designated 
Authorizing Official for approval.  After completing a travel action, and the Send to AO button has been 
selected, the Select Authorizing Official screen appears for the purpose of designating the desired AO.  

  

At this screen, users may also select a different site and display a new listing of Authorizing Officials. 

 The following link provides detailed instructions for completing the 
Select Authorizing Official screen: 

Releasing Travel Authorizations  

Releasing Advances  

Releasing Settlements  

 

Import Ships Screen 
The UTS database includes a table that contains names of ships belonging to the US Coast Guard.  
The information stored in this table is used to identify the traveler’s assigned vessel.  This table is 
populated and updated by importing a file that contains the ship information. 

To automatically update the Ships List, access the UTS Maintenance Module and click the 
Update Ships List button.  The Import Ships screen appears. 
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Use this screen to enter the filename and path, or search for the file containing the ships 
information.  Once the filename and path is entered, the user can click the Start Import button to 
begin the import process. 

 The following link provides detailed instructions for importing the Ships 
file: 

Maintaining Ships Table  

 

Import Units Screen 
All organizations, having Coast Guard members or employees assigned, have been given a Unit 
Number.  In addition, any organization that funds official travel for members or employees of the 
Coast Guard has also been assigned an Unit Number.   

Unit information is stored in the Unit Table, which resides in the UTS Maintenance Module.  
This table can be populated and updated by importing the data from a file that is generated 
periodically by PMIS-JUMPS.   

To automatically update the Unit Table by processing an interface file, access the UTS 
Maintenance Module and click the Import - Update button.  The Import Units from File screen 
appears. 

 

Use this screen to enter the unit filename and path, or search for the unit file.  Once the filename 
and path is entered, the user can click the Start Import button to begin the import process. 
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 The following link provides detailed instructions for importing the Unit 
Data File: 

Importing Unit Data File  

 

Import Reimbursable Description Screen 
Reimbursable Expense Descriptions are stored in the Reimbursable Expense Table which 
resides in the UTS Maintenance Module.  This table can be populated and updated by importing 
the data from a file that is generated by IATS. 

To automatically update the Reimbursable Expense Table by processing an interface file, access 
the UTS Maintenance Module and click the Import Reimbursable Desc. button.  The Import 
Reimbursable Descriptions from IATS screen appears. 

 

Use this screen to enter the filename and path, or search for the file containing the reimbursable 
expense descriptions.  Once the filename and path is entered, the user can click the Start Import 
button to begin the import process. 

 The following link provides detailed instructions for importing the 
Reimbursable Expenses Description File: 

Importing Reimbursable Expense Descriptions  

 

Import Personnel Screen 
User accounts in the UTS database are automatically added and updated by importing a file 
containing personnel information.   

To automatically update the Personnel Data, access the UTS Maintenance Module and click the 
Import/Update Personnel button.  The Import Personnel screen appears. 
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Use this screen to enter the filename and path, or search for the file containing the personnel 
information.  Once the filename and path is entered, the user can click the Start Import button to 
begin the import process. 

 The following link provides detailed instructions for importing the 
Personnel file: 

Importing Personnel Data File  

 

Help Topics Screen 
A Help System has been included with the UTS program that provides explanations for the 
numerous program features.  In addition, users will find detailed instructions that will guide them 
through the various functions involved in processing travel claims.   

The UTS Help Topics screen is displayed when a user clicks on the Help menu at the top of any 
UTS screen, then selects the Contents, or Index option. 
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At this screen the user can display help topics by using the Contents, Index, or Find options.  
Help topics may also be printed from this screen if desired. 

 The following links provide detailed instructions for using the Help 
Topics screen: 

Contents  

Index  

Find  
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Security Information Screen 
The Security Information screen is used to capture the information needed to grant access and 
privileges to UTS users.  In addition, this screen is used to establish the user’s default 
Authorizing Official and to designate a Signature Proxy. 

  

 The following links provide detailed instructions for completing the 
Security Information screen: 

Creating Profiles  

Privileges  

Logon Password  

Secondary Password  

Authentication Information  

Additional Information  

 

Financial Information Screen 
The Financial Information screen is used to establish whether the traveler possesses a Government 
issued Charge Card. 

The Financial Information screen can be accessed by users in the Traveler View mode only.  To 
access this screen, the user must first access the Personal Profile screen and then click the 
Financial button.  The following screen will appear: 
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At this screen, the user can select or change the existing Credit Card Status.   

 The following link provides detailed instructions for completing the 
Credit Card Information section: 

Credit Card Information  

 

Forward Requests Screen 
If an AO knows that he/she will be unavailable to process travel requests during a certain period, 
UTS provides a feature that allows the AO to forward requests to another AO.  

  

The Forward Requests screen is used to select which AO the selected request will be forwarded 
to. 

 The following links provide detailed instructions for Forwarding 
Requests to another AO: 

Forwarding Requests  

Automatic Forwarding  
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Manual Forwarding  

 

TDY Travel Order Screen 
The TDY Travel Order screen is used to establish the following details: 

�� Travel Order Number 
�� Type of Travel Order 
�� Purpose of the Trip 
�� Funding Organization 
�� Period Covered 
�� Order Issue Date 
�� Authorized Mode of Transportation 
�� Special Authorizations 
�� Accounting Appropriation 
�� Special Remarks 

  

This screen must be completed before a Request for TDY Advance or Settlement can be 
entered. 

Note:  Information coming from a from a pre-existing hard-copy TDY travel order, that was 
generated outside of UTS, must be manually entered into this screen by the user.  UTS 
automatically populates this screen, however, for travel authorizations that were created with 
UTS and were approved by an AO.   

 The following link provides detailed instructions for completing the TDY 
Travel Order screen: 

Completing the TDY Travel Order screen  
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Import Object Codes from File Screen  
Object Classification codes are stored in the Object Codes Table, which resides in the UTS 
Maintenance Module.  This table can be populated and updated by importing the data from a file 
that is generated periodically by FINCEN. 

To automatically update the Object Codes Table by processing an interface file, access the UTS 
Maintenance Module and click the Import/Update Object Codes button.  The Import Object 
Codes from File screen appears. 

  

Use this screen to enter the filename and path, or search for the file containing the Object codes.  
Once the filename and path is entered, the user can click the Start Import button to begin the 
import process. 

 The following link provides detailed instructions for importing the Object 
Codes File: 

Importing Object Codes  

 

Import RAN from File Screen 
Reimbursable Agreement Number (RAN) codes are stored in the RAN Codes Table, which 
resides in the UTS Maintenance Module.  This table can be populated and updated by importing 
the data from a file that is generated periodically by FINCEN. 

To automatically update the RAN Codes Table by processing an interface file, access the UTS 
Maintenance Module and click the Import RAN Codes button.  The Import RAN from File 
screen appears. 
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Use this screen to enter the filename and path, or search for the file containing the RAN codes.  
Once the filename and path is entered, the user can click the Start Import button to begin the 
import process. 

 The following link provides detailed instructions for importing the RAN 
Codes File: 

Importing RAN Codes  

 

Import Accounting File Screen 
Accounting Strings are stored in the Accounting Table, which resides in the UTS Maintenance 
Module.  This table can be populated and updated by importing the data from a file that is 
generated periodically by FINCEN. 

To automatically update the Accounting Table by processing an interface file, access the UTS 
Maintenance Module and click the Import/Update Accounting button.  The Import Accounting 
File screen appears. 

  

Use this screen to enter the filename and path, or search for the file containing the Accounting 
Strings.  Once the filename and path is entered, the user can click the Start Import button to 
begin the import process. 

 The following link provides detailed instructions for importing the 
Accounting Strings File: 

Import Accounting Strings  
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Email Message Screen 
A new feature has been added to UTS that allows a Traveler, Proxy or AO to send an E-mail 
message to each other to notify the recipient that a Request for Authorization, Settlement, or 
Advance was forwarded.  When this new feature is used, UTS automatically generates an E-mail 
message containing information pertaining to the Traveler’s ID, Travel Order Number and the 
Trip Dates.   

In addition, the user may also include a Personal Email Message if additional information is 
needed.  UTS automatically appends this message to the system-generated message when a 
Request for Authorization, Settlement, or Advance is forwarded.   

The Email Message screen, displayed below, is the screen used when creating a personal message 
to be added to the system-generated message: 

  

 The following link provides detailed instructions for using the UTS Email 
feature: 

Set-up Email Address  

Create Personal Message  

Sending Email  
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UTS Maintenance 
About UTS Maintenance 

The UTS Maintenance module is used to perform a variety of functions that are restricted to users 
with System Administrator privileges.  After logging into the UTS Maintenance module, the user 
has the ability to perform the following actions: 

�� Export travel claims from UTS to IATS for computation 
�� Create, modify, and delete user profiles 
�� Maintain per diem rates and city names 
�� Reassign travel requests from one Authorizing Official to another 
�� Import data files containing ship information 
�� Establish Miscellaneous Parameters 
�� Modify or delete unit information 
�� Import data files containing unit information 
�� Import data files containing reimbursable expense information 
�� Import data files containing personnel information 
�� Import data files containing accounting appropriations 

 

Maintenance Login 
Access to the UTS Maintenance module is limited to users with System Administrator 
privileges. 

  
�� User ID - At this field, the System Administrator must type his/her assigned Employee ID 

number and press Enter.   
�� Password - At this field, the System Administrator must type his/her assigned Password and 

press Enter or click on the Login button.   

See Also 
About UTS Maintenance  
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About System Administrators  

New Logon Password 

Changing Passwords 

 

Exporting Claims 
After a Request for Advance or Settlement has been approved by the Authorizing Official, an 
export file must be created.  The export file can then be imported into the Integrated Automated 
Travel System      (IATS) for computation. 

 Use the following procedures to create a UTS Export File. 

1. Login to the UTS Maintenance Module as a System Administrator.   

2. Click on the Export Claims to IATS button.  The UTS Export Claims screen appears. 

  

3. At the UTS Export Claims screen, establish the export configuration by completing 
following fields: 

�� Export All New Claims - This option is activated by default when this screen appears.  If 
creating an export file for new claims only, no action is necessary at this field.  When this 
option is used, UTS will create an export file containing the data for any new claims that were 
not previously exported. 

�� Re-Export Old Claims From a Particular Date - Click on this field to activate the option if 
wishing to generate an export file from claims that were previously transmitted.  When this 
option is selected, UTS displays the current date as the default.  If this date is correct, 
proceed with the process.  If the date is not correct, enter the desired date. 

�� Export To Directory - At this field, enter the location where the export file will reside once 
created.  For example; C:\FROMUTS.   

�� IATS Reply Directory - At this field, enter the location where the notification of claims 
accepted by IATS will reside.  For example; C:\FROMUTS\TOUTS. 
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Note:  If the correct path and directory name is not known, click on the Browse button to search 
the various system drives and directories until the desired directory is located. 

4. After entering the configuration information, click the Start Export button to begin creating 
the export file. 

5. If the process must be aborted while the file is being created, click the Stop button. 

6. When finished creating the export file, click the Main Menu button. 

7. At the UTS Maintenance screen, click the Exit button to terminate the Maintenance module. 

 

Maintaining Cities and City Rates 
Each month, a file is distributed that updates the per diem rates that are stored in the UTS 
database.  There is also a table storing the CONUS/OCONUS city names that is also updated 
periodically.  These tables can be updated by a user with System Administrator privileges.   

 Complete the following steps to update the Cities and City Rates tables: 

1. Login to the UTS Maintenance module. 

2. At the UTS Maintenance menu, click the Cities and City Rates button.  The UTS 
Rates/Cities Update screen appears. 

  

3. At this screen, click either the Update Rates or the Update City List tab, depending on 
which table is being updated.   

4. Type the path and the filename of the update file being processed at the Rates File field.  If 
the correct path and filename is not known, click on the Browse button to search the various 
system drives and directories until the desired update file is located. 

5. After the correct path and the filename are entered, click the Start Rates or City Update 
button. 

6. If the process must be aborted while the update is running, click the Stop button. 

7. When finished updating the Cities and City Rates table, click the Main Menu button. 

8. At the UTS Maintenance screen, click the Exit button to terminate the Maintenance module. 
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Reassigning Authorizing Official 
When user accounts are created in UTS, a default Authorizing Official,  (AO), is established for 
the purpose of approving travel authorizations, advances and settlements.  If a particular AO 
will be unavailable to approve the requested action, however, a substitute AO can be assigned.  
This is accomplished through the Maintenance Module by reassigning the AO.   

 Use the following procedures to reassign an Authorizing Official: 

1. Login to the UTS Maintenance Module as a System Administrator.   

2. Click on the Authorizing Officer Maintenance button.  The Authorizing Official 
Reassignment screen appears. 

  

3. At the Authorizing Official Reassignment screen, enter the unit number, for the AO who’s 
requests are to be re-assigned, at the Unit field. 

4. Display a listing of individuals eligible for selection as a substitute AO by entering the first 
two characters of either the Last Name or the Employee ID in the corresponding fields. 

5. When the list of names is displayed, click on the desired name or press the Up/Down arrows 
on the keyboard to highlight the correct name and press Enter. 

6. After selecting the substitute AO, click the Reassign Requests button.  The Reassign 
Requests screen appears. 
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7. At the Reassign Requests screen, the following options are available: 

�� Select All - Click on this button to select all of the travel requests listed at the Reassign 
Requests screen.  Once the items are selected, the user can click on the Return To Submitter 
or Forward To Another AO option. 

�� Clear All - Click on this button to de-select all of the travel requests presently highlighted. 
�� Return To Submitter - After selecting a travel request, click on this button to return the 

selected request back to the submitting individual. 
�� Forward To Another AO - After selecting a travel request, click on this button to forward 

the transaction to a different AO.  When this option is selected, UTS displays the Forward 
Claims to Selected AO screen.  At this screen the user must select the AO, who will receive 
the transaction. 

�� Replace As Default AO - Click on this button to replace the AO selected at the Authorizing 
Official Reassignment screen.  After clicking this button, UTS displays the Replacement 
AO screen.  At this screen the user must select the AO, who will replace the original default 
AO. 

�� Previous Screen - Click on this button to return to the previous screen -  

8. When finished performing the reassignments, click the Previous Screen button until the UTS 
Maintenance menu reappears. 

 

Maintaining Ships Table 
When a claim is processed for a Coast Guard member involving sea duty on board a government 
ship, a transaction is generated by IATS for the purpose of making pay adjustments.  The UTS 
database includes a table that contains the names of ships belonging to the US Coast Guard.  The 
information stored in this table is used to identify the traveler’s assigned vessel.  This table is 
populated and updated by importing a file that contains the ship information. 

 Use the following procedures to import the Ships file: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Update Ships List button.  The Import Ships 
screen appears. 
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3. At this screen, enter the path, where the import file can be located, and the filename, at the 
Import Filename field.  For example; A:\SHIPS.XXX. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the Ships data file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the Stop 
button. 

5. When finished using the Import Ships screen, click the Main Menu button to return to the UTS 
Maintenance screen. 

 

Establishing Miscellaneous Parameters 
On occasion, it may be necessary to make an adjustment to a limiting value for a particular input 
field.  This is accomplished by accessing the UTS Maintenance module and selecting the 
Miscellaneous feature. 

Note:  At this time, the only parameter that may be adjusted at this screen is the number of miles 
that is considered to be Local Travel mileage. 

 Use the following procedures to establish a Miscellaneous parameter: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Miscellaneous button.  The Miscellaneous 
Maintenance screen appears. 

  

3. At this screen, enter the number of miles that should be used as the maximum range for the 
consideration of Local Travel mileage.   
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4. After entering the Local Travel mileage, click the Previous Screen button.  If no changes were 
made, however, click the Cancel button.   

 

Maintaining Unit Table 
All organizations, having Coast Guard members or employees assigned, have been given a Unit 
Number.  In addition, any organization that funds official travel for members or employees of the 
Coast Guard has also been assigned a Unit Number.   

When a user account is established in UTS, this Unit Number becomes part of the traveler’s 
personal profile.  UTS uses the Unit Number to associate Travelers, Proxies, and Authorizing 
Officials.  

Unit information is stored in the UTS Maintenance Module and can be added, modified, or 
deleted by an individual with System Administrator privileges.   

 The following links provide detailed instructions for Adding, Modifying, 
or Deleting Unit Information: 

Adding Unit Information  

Modifying Unit Information  

Deleting Unit Information  

 

Add New Unit Information 

 Adding New Unit Information: 

1. Login to the UTS Maintenance Module as a System Administrator.   

2. Click on the Add/Modify Units button.  The Unit Maintenance screen appears. 

  

 63



 

3. At this screen, a drop down listing of Unit Numbers with a Description appears at the Unit 
field.   

4. At the Unit field, type the unit number for the new organization being added, then click the 
Create New Unit button. 

5. After clicking the Create New Unit button, the following screen appears: 

  

6. At this screen, enter the required information at the following fields: 
��Description - Click in this field, and enter a description of the new organization being added. 
��Default AO Unit - Click in this field and a listing of all of the organizations in the Units Table is 

displayed.  Select a unit by using any of the following methods. 

    (a). Type the unit number for the desired organization.  When the desired Unit 
Number/Description is highlighted, click on this organization. 

    (b). Click on the Up/Down arrows on the right side of the unit listing window until the desired 
Unit Number/Description is displayed, then click on this organization. 

    (c). Press the Up/Down arrows on the keyboard until the desired Unit Number/Description is 
highlighted and then click on this organization. 

Note:  The unit number for the organization being added cannot be used, since the organization 
doesn’t exist yet.  After the process to add this unit to the table is completed, modify the Unit 
Table to select this new organization as the Default AO Unit, if desired. 

�� Default AO - Any individuals with AO privileges for the unit shown at the Default AO 
Unit field will be listed at this field.  Point and click on the desired name to make a selection. 

�� Funds Type - At this field a listing of various funding organizations is displayed.  Point and 
click on the desired organization to make a selection. 

Tip:  Click on the Cancel button if wishing to abort the input prior to saving the entries. 

7. After entering the required information, click the Save Changes button.   

8. When finished using the Unit Maintenance screen, click the Previous Screen button and click on 
Yes at the Cancel This Screen pop-up to return to the UTS Maintenance screen. 
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Modify or Delete Unit Information 
 Modify or Delete Unit Information: 

1. Login to the UTS Maintenance Module as a System Administrator.   

2. Click on the Add/Modify Units button.  The Unit Maintenance screen appears. 

  

3. At this screen, a drop down listing of Unit Numbers with a Description appears at the Unit 
field.  Use any of the following methods to select a unit: 

�� Type the unit number for the desired organization.  When the desired Unit 
Number/Description is highlighted, click on this organization. 

�� Click on the Up/Down arrows on the right side of the unit listing window until the desired 
Unit Number/Description is displayed, then click on this organization. 

�� Press the Up/Down arrows on the keyboard until the desired Unit Number/Description is 
highlighted and then click on this organization. 

4. After selecting a unit, by using either method described above, the following screen appears: 
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5. At this screen, the user may remove the unit from the table by clicking on the Delete 
Organization button, or modify the existing information displayed at the following fields: 

�� Description - Click in this field, and enter a new description or modify the existing 
information as required. 

�� Default AO Unit - Click in this field, and a listing of all of the organizations in the Units 
Table is displayed.  Select a new unit by using any of the methods described in step (3) above. 

�� Default AO - Any individuals with AO privileges for the unit shown at the Default AO 
Unit field will be listed at this field.  Point and click on the desired name to make a selection. 

�� Funds Type - At this field, a listing of various funding organizations is displayed.  Point and 
click on the desired organization to make a selection. 

Tip:  Click on the Cancel button if wishing to abort the changes prior to saving the entries. 

6. After modifying any existing information, click the Save Changes button.   

7. When finished using the Unit Maintenance screen, click the Previous Screen button and 
click on Yes at the Cancel This Screen pop-up to return to the UTS Maintenance screen. 

 

Importing Unit Data File 
All organizations, having Coast Guard members or employees assigned, have been given a Unit 
Number.  In addition, any organization that funds official travel for members or employees of the 
Coast Guard has also been assigned an Unit Number.   

When a user account is established in UTS, this Unit Number becomes part of the traveler’s 
personal profile and is used by UTS to associate Travelers, Proxies, and Authorizing Officials.   

Unit information is stored in the Unit Table, which resides in the UTS Maintenance Module.  
This table can be populated and updated by importing the data from a file that is generated 
periodically, by PMIS-JUMPS.   
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 Use the following procedures to import the Unit Data File: 

1. Login to the UTS Maintenance Module.   

2. Click on the Import - Update button.  The Import Units from File screen appears. 

  

3. At this screen, enter the path where the import file can be located and the filename at the 
Import Filename field.  For example; A:\UNITS.XXX. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the Unit Data file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import Units from File screen, click the Main Menu button to 
return to the UTS Maintenance screen. 

 

Importing Reimbursable Expense Descriptions 
While processing a travel authorization or settlement using UTS, a pop-up table appears at the 
Reimbursable Expenses section when the cursor is positioned at the Description field.   

The Reimbursable Expense Descriptions are stored in the Reimbursable Expense Table, which 
resides in the UTS Maintenance Module.  This table can be populated and updated by importing 
the data from a file that is generated by IATS. 

 Use the following procedures to import the Reimbursable Expenses Data 
File: 

1. Login to the UTS Maintenance Module.   

2. Click on the Import Reimbursable Desc. button.  The Import Reimbursable Descriptions 
from IATS screen appears. 
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3. At this screen, enter the path where the import file can be located and the filename at the 
Import Filename field.  For example; A:\EXPENSE.XXX. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the Reimbursable Expense Data file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import Reimbursable Descriptions from IATS screen, click the 
Main Menu button to return to the UTS Maintenance screen. 

 

Importing Personnel Data File 
User accounts in the UTS database are automatically added and updated by importing a file 
containing personnel information.   

 Use the following procedures to import the Personnel file: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Import/Update Personnel button.  The Import 
Personnel screen appears. 

  

3. At this screen, enter the path, where the import file can be located, and the filename at the 
Import Filename field.  For example; A:\PERSONS.XXX. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the personnel file is located. 
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4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import Personnel screen, click the Main Menu button to return to 
the UTS Maintenance screen. 

 

Importing Accounting Data 
Accounting Appropriations in the UTS database are automatically added and updated by 
importing a file containing accounting lines.   

 Use the following procedures to import the Accounting file: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Import/Update Accounting button.  The 
Import Accounting screen appears. 

  

3. At this screen, enter the path, where the import file can be located, and the filename at the 
Import Filename field.  For example; A:\RT200038.DAT. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the accounting file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import Accounting screen, click the Main Menu button to return to 
the UTS Maintenance screen. 
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Importing Object Codes 
Object Codes in the UTS database are automatically added and updated by importing a file 
containing Object Codes by Fiscal Year.   

 Use the following procedures to import Object Codes: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Import/Update Object Codes button.  The 
Import Object Codes from File screen appears. 

  

3. At this screen, enter the path, where the import file can be located, and the filename at the 
Import Filename field.  For example; A:\OBJFY02. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the accounting file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import Object Codes from File screen, click the Main Menu 
button to return to the UTS Maintenance screen. 

 

Importing RAN Codes 
RAN Codes in the UTS database are automatically added and updated by importing a file 
containing RAN Codes.   

 Use the following procedures to import the RAN Codes file: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Import/Update RAN Codes button.  The 
Import RAN Codes from File screen appears. 
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3. At this screen, enter the path, where the import file can be located, and the filename at the 
Import Filename field.  For example; A:\RAN00038.DAT. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the accounting file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import RAN Codes from File screen, click the Main Menu button 
to return to the UTS Maintenance screen. 

 

Personal Profiles 
About Profile 

A Personal Profile is a user account that is created for every individual who will use UTS and 
every traveler, who’s claim is processed through UTS.  This profile is used to store personal 
information for the user and establishes their privileges.  Profiles can only be created or deleted by 
a user with System Administrator privileges. 

The capabilities for a user to create, view, modify, or delete a personal profile varies according to 
their View or Privilege as follows: 

�� Traveler - May view, modify, or delete his/her own profile. 
�� System Administrator - May create, view, modify, or delete any personal profile.  

Note:  Privileges can only be modified by users with a System Administrator View. 
 

Creating Profiles 
Personal Profiles for UTS users or travelers are ordinarily created automatically by importing a 
personnel file.  Profiles may also be created manually through the UTS Maintenance module by 
an individual possessing the System Administrator privilege. 

 Manually creating a user Profile: 

1. Login to the UTS Maintenance module. 
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2. Click on the Profiles: Add/Update/Delete button and the Profile Maintenance screen 
appears: 

  

3. Click on the Create New button and the following Profile screen appears. 

  

4. Complete each section with the information needed to identify the user.   

5. Point to the field you wish to access, click the left mouse button. 

6. Type the required information.  

7. When finished, press Enter or Tab to advance to the next field or point to the desired field 
and click the left mouse button. 

Note:  The Work Address section is optional and every field except Phone can be left blank.  

Tip:  Don’t forget to click on the Security and Financial buttons and complete those screens also. 

8. When finished completing the Personal Profile, Financial Information, and Security 
Information screens, click the Save button. 

See Also 
Personal Information  

Financial Information Screen  

Security Information  

Privileges  

New Logon Password 

New Secondary Password 
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Additional Information  

Authentication Information  

Modifying Profiles  

Deleting Profiles  

 

Modifying Profiles 
To modify a Personal Profile, the UTS user must login to UTS in either the Traveler or System 
Administrator View mode.   

 Modifying a Profile using the System Administrator View: 

1. Login to the UTS Maintenance module. 

2. Click on the Profiles: Add/Update/Delete button and the Profile Maintenance screen 
appears. 

  

3. At this screen, enter either the first (2) letters of the last name or the first (2) digits of the 
Employee ID for the profile being modified.  Any profiles matching the criteria appear in the 
table.   
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4. Click on the desired profile, then click the Modify/View/Delete button.  The Personal 
Profile screen appears. 

 

5. At the Personal Profile screen, press Enter or Tab to advance through the input fields, or 
point to the desired field and click the left mouse button. 

6. Type the required change. 
7. Click on the Save button when finished. 

 Modifying a Profile using the Traveler View: 

1. Login to the UTS Processing module in the Traveler View.  If logged in as a Proxy or 
Authorizing Official, click on the Log in as menu at the top of the UTS Request Status 
screen and change the View to Traveler. 

2. At the UTS Request Status screen, click on the Profile menu.   

  

3. At the Profile drop down menu, click on the Modify or View Profile option. 

4. At the Personal Profile screen, press Enter or Tab to advance through the input fields, or 
point to the desired field and click the left mouse button. 

5. Type the required change. 
6. Click on the Save button when finished. 

Tip:  It may be necessary to click on the Security and Financial buttons and make changes at 
those screens also. 
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See Also 
Personal Information  

Financial Information Screen  

Security Information  

Privileges  

New Logon Password 

New Secondary Password 

Additional Information  

Authentication Information  

 

Deleting Profiles 
Personal Profiles may only be deleted by users with System Administrator privileges. 

 Deleting a Profile: 

1. Login to the UTS Maintenance module. 

2. Click on the Profiles: Add/Update/Delete button and the Profile Maintenance screen 
appears. 
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3. At this screen, enter either the first (2) letters of the last name or the first (2) digits of the 
User ID for the profile being modified.  Any profiles matching the criteria appear in the table.   

4. Click on the desired profile, then click the Modify/View/Delete button.  The Personal 
Profile screen appears. 
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5. At the Personal Profile screen, click the Delete button. 

 

Personal Information 

 Enter the information needed to identify the Traveler: 

1. ID:  Enter the traveler’s Employee ID number to be used for logging into UTS.  This 
number must be (9) numeric characters. 

2. SSN:  Enter the traveler’s Social Security Number.  When entering this number, do not use 
spaces or dashes.  This field must also be (9) numeric characters. 

3. Last Name:  Enter the traveler’s last name.   

4. First Name:  Enter the traveler’s first name. 

5. Middle Initial:  Enter the traveler’s middle initial. (Optional). 

6. Grade/Rank:  At this field, a table appears listing the pay grades   CIV, E1-E9, O1-O10, 
W1-W5, O1E-O3E, GS1-GS16, GM1-GM16, WG1-WG16 and WS1-WS16.  Either type 
the traveler’s pay grade or click the Up/Down arrow buttons until the desired pay grade is 
displayed.  Place the pointer on the desired pay grade and click the left mouse button to make 
a selection. 

7. Unit:  Enter the (7) digit number representing the unit or agency the traveler is assigned to. 

8. AO’s Unit: Enter the (7) digit number representing the unit or agency the traveler’s 
Authorizing Official is assigned to. 

9. Privilege:   When creating a traveler profile, the default privilege is Traveler.  To change the 
privilege, click on the Security Information button. 

10. Cost Center:  Enter the (5) digit number representing the Cost Center associated to the 
traveler’s assigned Unit. 

Note:  The Privileges section can only be accessed by the System Administrator. 

 

Home Address 
A Home Address must be entered into the Home Address section of the Personal Profile screen 
for every profile created.   
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 Enter the required information at each field to complete the Home 
Address section. 

1. Point to the field you wish to access, click the left mouse button and the color changes to 
gray. 

2. Type the required information.   

3. When finished, press Enter or Tab to advance to the next field or point to the desired field 
and click the left mouse button. 

Tip:  At the State field, a drop down listing appears.  Click the up/down arrows on the right side 
of the listing until the desired state or country name appears.  Click on the name to populate the 
State field. 

Note:  Address line 2 and the Phone fields are optional.  These fields may be left blank. 

 

Work Address 
With the exception of a Work Phone Number, the Work Address is optional, when creating a 
user profile.  It is always a good idea, however, to obtain as much information as possible in case 
it is necessary to route documentation through the traveler’s office. 

  

 Enter the required information at each field to complete the Work 
Address section. 

1. Point to the field you wish to access, click the left mouse button and the color changes to 
gray. 

2. Type the required information.   

3. When finished, press Enter or Tab to advance to the next field or point to the desired field 
and click the left mouse button. 

Tip:  At the State field, a drop down listing appears.  Click the Up/Down arrows on the right side 
of the listing until the desired state or country name appears.  Click on the name to populate the 
State field. 

Note:  The Phone field cannot be left blank.  A work phone number is mandatory when creating 
a user profile. 
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Financial Information 
Credit Card Information 

The Credit Card Information section of the Financial Information screen is used to identify 
whether the traveler is participating in the Government Charge Card Program. 

  

 Enter the following Information to complete the Credit Card Information 
section: 

1. Make the appropriate selection to identify the traveler’s credit card status: 

�� Credit Card Status - At this field, a drop down listing appears displaying several options.  
Point and click on the desired option to make a selection. 

2. When finished making a selection, click the Previous Screen button.  

3. At the Personal Profile screen, click the Save button to save the credit card information. 
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Security Information 
Click the Security Information button on the Personal Profile screen and  the Security 
Information screen appears:  This screen is used to capture the information needed to grant access 
to the UTS program.  

  

At this screen, the Traveler or System Administrator must enter the appropriate information to 
complete each section.   

 The following links provide detailed information for completing these 
sections: 

Privileges 

New Logon Password 

New Secondary Password  

Authentication Information  

Additional Information  

 

Privileges 

Privileges are associated with the View Modes.  The privilege or view identifies what capabilities 
and access the user possesses.  When a user profile is created, the default privilege is Traveler.  A 
user can be granted more than one privilege, however. 
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Note:  The Privileges for Authorizing Official, or System Administrator: can only be added or 
changed by a System Administrator. 

 Changing or Adding Privileges: 

1. Login to the UTS Maintenance Module. 

2. At the UTS Maintenance Menu, click on the Profiles: Add/Update/Delete button. 

3. The next screen to appears requires the System Administrator to select a traveler. At this 
screen, enter either the first (2) letters of the last name or the first (2) digits of the Employee 
ID for the profile being modified.  Any profiles matching the criteria appear in the table. 

4. Click on the desired profile, then click the Modify/View/Delete button.  The Personal 
Profile screen appears. 

5. At the Personal Profile screen, click the Security Information button. 

6. At the Security Information screen, press Enter, Tab, or use the left and right arrow keys to 
highlight the desired privilege. 

7. Point to the desired or highlighted option and click the left mouse button.  A check mark 
appears next to the selected privilege. 

Tip:  Clicking on a privilege that has a check mark  causes the check mark to disappear and de-
selects the privilege.   

 

New Logon Password 
The New Logon Password section is used to establish a unique Logon Password for every user 
who will access UTS. 

Tip:  The Logon Password must be (8) characters.  In addition, (2) of the characters must be 
numeric. 

  

At the Enter field, type the Password the user will enter when logging into UTS.  After typing 
the password and pressing Enter, the user is required to type the password a second time at the Re-
enter field. 

Note:  Passwords should only be known by the individual user.  If the passwords were initially 
created by the System Administrator, users should change their passwords after accessing UTS 
for the first time. 

See Also  
Changing Passwords 
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New Secondary Password 
The Secondary Password serves as the electronic signature for releasing travel authorizations and 
settlements for further processing.  A Secondary Password must be created before a user is able to 
login to UTS.   

Tip:  The Secondary Password must be (8) characters.  In addition, (2) of the characters must be 
numeric. 

  

At the Enter field, type the Secondary Password the user will type when releasing travel 
authorizations and settlements.  After typing the password and pressing Enter, the user is required 
to type the password a second time at the Re-enter field. 

Note:  Passwords should only be known by the individual user.  If the passwords were initially 
created by the System Administrator, users should change their passwords after accessing UTS 
for the first time. 

See Also 
Changing Passwords  

 

Authentication Information 
The Authentication Information section of the Security Information screen is used to verify a users 
access to the UTS program.  When logging into UTS, the user is required to enter a password at 
the UTS Password screen.  If the user cannot remember their password, access can be gained by 
clicking on the Forgot my Password button and entering the authentication information.  If this 
information matches the authentication information previously entered into the UTS database, 
access is granted. 

  

At this screen enter the following information: 

�� Mother’s Maiden Name 

�� Date of Birth 

�� Town of Birth 

See Also 
Logging into UTS  

Forgot my Password  

 82 



 

Additional Information 
The additional Information section is used to establish who is designated as an Authorizing 
Official to approve travel actions.  This section is also used to establish who can act as a 
Signature Proxy on behalf of the Traveler.   

  

�� Default Authorizing Officer:  At this field, a listing of Names appears for individuals 
possessing AO privileges for the Traveler’s unit.  Point to the desired name and click the left 
mouse button to make a selection. 

�� Signature Proxy:  Any individual belonging to the same unit as the Traveler, may be 
designated as a Signature Proxy on behalf of the Traveler.  At this field, the user must enter the 
first (2) letters of the desired Signature Proxy’s last name.  A listing of Names, beginning with 
the two letters entered, appears.  If the desired name is highlighted, press Enter.  If the desired 
name is not highlighted, click the Up/Down arrows on the keyboard to scroll through the list 
until the correct name appears.   

�� Office Email Address:  Enter an email address at this field in order to send/receive UTS 
generated notifications that a Request for Authorization, Advance, or Settlement has been 
forwarded to the AO, Traveler, or Proxy. 

�� Home Email address:  For future use. 

 

Changing Passwords 
Passwords should only be known by the individual user.  If the passwords were initially created 
by the System Administrator, users should change their passwords after accessing UTS for the 
first time. 

 Complete the following steps to change a Logon or Secondary 
Password: 

1. Login to UTS.  If the View mode displayed on the UTS Request Status or UTS Requests 
Requiring Action screen is other than Traveler, change the view to Traveler to continue. 

2. At the UTS Request Status or UTS Requests Requiring Action screen, click on the Profile 
menu.   

3. At the Profile drop down menu, click on Modify or View Profile. 

4. At the Personal Profile screen, click on the Security Information button. 

5. At the Security Information screen, press Enter or Tab to advance through the input fields 
or point and click on the Enter field at the New Logon Password or New Secondary 
Password sections. 
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6. Type a new Logon or Secondary Password and press Enter.  

7. At the Re-enter field, type the new Logon or Secondary Password and press Enter. 

8. Click on the Previous Screen button when finished. 

9. At the Profile screen, click the Save button. 

See Also 
Changing View  

 



 

UTS Maintenance 
About UTS Maintenance 

The UTS Maintenance module is used to perform a variety of functions that are restricted to users 
with System Administrator privileges.  After logging into the UTS Maintenance module, the user 
has the ability to perform the following actions: 

�� Export travel claims from UTS to IATS for computation 
�� Create, modify, and delete user profiles 
�� Maintain per diem rates and city names 
�� Reassign travel requests from one Authorizing Official to another 
�� Import data files containing ship information 
�� Establish Miscellaneous Parameters 
�� Modify or delete unit information 
�� Import data files containing unit information 
�� Import data files containing reimbursable expense information 
�� Import data files containing personnel information 
�� Import data files containing accounting appropriations 

 

Maintenance Login 
Access to the UTS Maintenance module is limited to users with System Administrator 
privileges. 

  
�� User ID - At this field, the System Administrator must type his/her assigned Employee ID 

number and press Enter.   
�� Password - At this field, the System Administrator must type his/her assigned Password and 

press Enter or click on the Login button.   

See Also 
About UTS Maintenance  
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About System Administrators  

New Logon Password 

Changing Passwords 

 

Exporting Claims 
After a Request for Advance or Settlement has been approved by the Authorizing Official, an 
export file must be created.  The export file can then be imported into the Integrated Automated 
Travel System      (IATS) for computation. 

 Use the following procedures to create a UTS Export File. 

1. Login to the UTS Maintenance Module as a System Administrator.   

2. Click on the Export Claims to IATS button.  The UTS Export Claims screen appears. 

  

3. At the UTS Export Claims screen, establish the export configuration by completing 
following fields: 

�� Export All New Claims - This option is activated by default when this screen appears.  If 
creating an export file for new claims only, no action is necessary at this field.  When this 
option is used, UTS will create an export file containing the data for any new claims that were 
not previously exported. 

�� Re-Export Old Claims From a Particular Date - Click on this field to activate the option if 
wishing to generate an export file from claims that were previously transmitted.  When this 
option is selected, UTS displays the current date as the default.  If this date is correct, 
proceed with the process.  If the date is not correct, enter the desired date. 

�� Export To Directory - At this field, enter the location where the export file will reside once 
created.  For example; C:\FROMUTS.   

�� IATS Reply Directory - At this field, enter the location where the notification of claims 
accepted by IATS will reside.  For example; C:\FROMUTS\TOUTS. 
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Note:  If the correct path and directory name is not known, click on the Browse button to search 
the various system drives and directories until the desired directory is located. 

4. After entering the configuration information, click the Start Export button to begin creating 
the export file. 

5. If the process must be aborted while the file is being created, click the Stop button. 

6. When finished creating the export file, click the Main Menu button. 

7. At the UTS Maintenance screen, click the Exit button to terminate the Maintenance module. 

 

Maintaining Cities and City Rates 
Each month, a file is distributed that updates the per diem rates that are stored in the UTS 
database.  There is also a table storing the CONUS/OCONUS city names that is also updated 
periodically.  These tables can be updated by a user with System Administrator privileges.   

 Complete the following steps to update the Cities and City Rates tables: 

1. Login to the UTS Maintenance module. 

2. At the UTS Maintenance menu, click the Cities and City Rates button.  The UTS 
Rates/Cities Update screen appears. 

  

3. At this screen, click either the Update Rates or the Update City List tab, depending on 
which table is being updated.   

4. Type the path and the filename of the update file being processed at the Rates File field.  If 
the correct path and filename is not known, click on the Browse button to search the various 
system drives and directories until the desired update file is located. 

5. After the correct path and the filename are entered, click the Start Rates or City Update 
button. 

6. If the process must be aborted while the update is running, click the Stop button. 

7. When finished updating the Cities and City Rates table, click the Main Menu button. 

8. At the UTS Maintenance screen, click the Exit button to terminate the Maintenance module. 
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Reassigning Authorizing Official 
When user accounts are created in UTS, a default Authorizing Official,  (AO), is established for 
the purpose of approving travel authorizations, advances and settlements.  If a particular AO 
will be unavailable to approve the requested action, however, a substitute AO can be assigned.  
This is accomplished through the Maintenance Module by reassigning the AO.   

 Use the following procedures to reassign an Authorizing Official: 

1. Login to the UTS Maintenance Module as a System Administrator.   

2. Click on the Authorizing Officer Maintenance button.  The Authorizing Official 
Reassignment screen appears. 

  

3. At the Authorizing Official Reassignment screen, enter the unit number, for the AO who’s 
requests are to be re-assigned, at the Unit field. 

4. Display a listing of individuals eligible for selection as a substitute AO by entering the first 
two characters of either the Last Name or the Employee ID in the corresponding fields. 

5. When the list of names is displayed, click on the desired name or press the Up/Down arrows 
on the keyboard to highlight the correct name and press Enter. 

6. After selecting the substitute AO, click the Reassign Requests button.  The Reassign 
Requests screen appears. 
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7. At the Reassign Requests screen, the following options are available: 

�� Select All - Click on this button to select all of the travel requests listed at the Reassign 
Requests screen.  Once the items are selected, the user can click on the Return To Submitter 
or Forward To Another AO option. 

�� Clear All - Click on this button to de-select all of the travel requests presently highlighted. 
�� Return To Submitter - After selecting a travel request, click on this button to return the 

selected request back to the submitting individual. 
�� Forward To Another AO - After selecting a travel request, click on this button to forward 

the transaction to a different AO.  When this option is selected, UTS displays the Forward 
Claims to Selected AO screen.  At this screen the user must select the AO, who will receive 
the transaction. 

�� Replace As Default AO - Click on this button to replace the AO selected at the Authorizing 
Official Reassignment screen.  After clicking this button, UTS displays the Replacement 
AO screen.  At this screen the user must select the AO, who will replace the original default 
AO. 

�� Previous Screen - Click on this button to return to the previous screen -  

8. When finished performing the reassignments, click the Previous Screen button until the UTS 
Maintenance menu reappears. 

 

Maintaining Ships Table 
When a claim is processed for a Coast Guard member involving sea duty on board a government 
ship, a transaction is generated by IATS for the purpose of making pay adjustments.  The UTS 
database includes a table that contains the names of ships belonging to the US Coast Guard.  The 
information stored in this table is used to identify the traveler’s assigned vessel.  This table is 
populated and updated by importing a file that contains the ship information. 

 Use the following procedures to import the Ships file: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Update Ships List button.  The Import Ships 
screen appears. 
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3. At this screen, enter the path, where the import file can be located, and the filename, at the 
Import Filename field.  For example; A:\SHIPS.XXX. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the Ships data file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the Stop 
button. 

5. When finished using the Import Ships screen, click the Main Menu button to return to the UTS 
Maintenance screen. 

 

Establishing Miscellaneous Parameters 
On occasion, it may be necessary to make an adjustment to a limiting value for a particular input 
field.  This is accomplished by accessing the UTS Maintenance module and selecting the 
Miscellaneous feature. 

Note:  At this time, the only parameter that may be adjusted at this screen is the number of miles 
that is considered to be Local Travel mileage. 

 Use the following procedures to establish a Miscellaneous parameter: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Miscellaneous button.  The Miscellaneous 
Maintenance screen appears. 

  

3. At this screen, enter the number of miles that should be used as the maximum range for the 
consideration of Local Travel mileage.   
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4. After entering the Local Travel mileage, click the Previous Screen button.  If no changes were 
made, however, click the Cancel button.   

 

Maintaining Unit Table 
All organizations, having Coast Guard members or employees assigned, have been given a Unit 
Number.  In addition, any organization that funds official travel for members or employees of the 
Coast Guard has also been assigned a Unit Number.   

When a user account is established in UTS, this Unit Number becomes part of the traveler’s 
personal profile.  UTS uses the Unit Number to associate Travelers, Proxies, and Authorizing 
Officials.  

Unit information is stored in the UTS Maintenance Module and can be added, modified, or 
deleted by an individual with System Administrator privileges.   

 The following links provide detailed instructions for Adding, Modifying, 
or Deleting Unit Information: 

Adding Unit Information  

Modifying Unit Information  

Deleting Unit Information  

 

Add New Unit Information 

 Adding New Unit Information: 

1. Login to the UTS Maintenance Module as a System Administrator.   

2. Click on the Add/Modify Units button.  The Unit Maintenance screen appears. 
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3. At this screen, a drop down listing of Unit Numbers with a Description appears at the Unit 
field.   

4. At the Unit field, type the unit number for the new organization being added, then click the 
Create New Unit button. 

5. After clicking the Create New Unit button, the following screen appears: 

  

6. At this screen, enter the required information at the following fields: 
��Description - Click in this field, and enter a description of the new organization being added. 
��Default AO Unit - Click in this field and a listing of all of the organizations in the Units Table is 

displayed.  Select a unit by using any of the following methods. 

    (a). Type the unit number for the desired organization.  When the desired Unit 
Number/Description is highlighted, click on this organization. 

    (b). Click on the Up/Down arrows on the right side of the unit listing window until the desired 
Unit Number/Description is displayed, then click on this organization. 

    (c). Press the Up/Down arrows on the keyboard until the desired Unit Number/Description is 
highlighted and then click on this organization. 

Note:  The unit number for the organization being added cannot be used, since the organization 
doesn’t exist yet.  After the process to add this unit to the table is completed, modify the Unit 
Table to select this new organization as the Default AO Unit, if desired. 

�� Default AO - Any individuals with AO privileges for the unit shown at the Default AO 
Unit field will be listed at this field.  Point and click on the desired name to make a selection. 

�� Funds Type - At this field a listing of various funding organizations is displayed.  Point and 
click on the desired organization to make a selection. 

Tip:  Click on the Cancel button if wishing to abort the input prior to saving the entries. 

7. After entering the required information, click the Save Changes button.   

8. When finished using the Unit Maintenance screen, click the Previous Screen button and click on 
Yes at the Cancel This Screen pop-up to return to the UTS Maintenance screen. 
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Modify or Delete Unit Information 
 Modify or Delete Unit Information: 

1. Login to the UTS Maintenance Module as a System Administrator.   

2. Click on the Add/Modify Units button.  The Unit Maintenance screen appears. 

  

3. At this screen, a drop down listing of Unit Numbers with a Description appears at the Unit 
field.  Use any of the following methods to select a unit: 

�� Type the unit number for the desired organization.  When the desired Unit 
Number/Description is highlighted, click on this organization. 

�� Click on the Up/Down arrows on the right side of the unit listing window until the desired 
Unit Number/Description is displayed, then click on this organization. 

�� Press the Up/Down arrows on the keyboard until the desired Unit Number/Description is 
highlighted and then click on this organization. 

4. After selecting a unit, by using either method described above, the following screen appears: 
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5. At this screen, the user may remove the unit from the table by clicking on the Delete 
Organization button, or modify the existing information displayed at the following fields: 

�� Description - Click in this field, and enter a new description or modify the existing 
information as required. 

�� Default AO Unit - Click in this field, and a listing of all of the organizations in the Units 
Table is displayed.  Select a new unit by using any of the methods described in step (3) above. 

�� Default AO - Any individuals with AO privileges for the unit shown at the Default AO 
Unit field will be listed at this field.  Point and click on the desired name to make a selection. 

�� Funds Type - At this field, a listing of various funding organizations is displayed.  Point and 
click on the desired organization to make a selection. 

Tip:  Click on the Cancel button if wishing to abort the changes prior to saving the entries. 

6. After modifying any existing information, click the Save Changes button.   

7. When finished using the Unit Maintenance screen, click the Previous Screen button and 
click on Yes at the Cancel This Screen pop-up to return to the UTS Maintenance screen. 

 

Importing Unit Data File 
All organizations, having Coast Guard members or employees assigned, have been given a Unit 
Number.  In addition, any organization that funds official travel for members or employees of the 
Coast Guard has also been assigned an Unit Number.   

When a user account is established in UTS, this Unit Number becomes part of the traveler’s 
personal profile and is used by UTS to associate Travelers, Proxies, and Authorizing Officials.   

Unit information is stored in the Unit Table, which resides in the UTS Maintenance Module.  
This table can be populated and updated by importing the data from a file that is generated 
periodically, by PMIS-JUMPS.   
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 Use the following procedures to import the Unit Data File: 

1. Login to the UTS Maintenance Module.   

2. Click on the Import - Update button.  The Import Units from File screen appears. 

  

3. At this screen, enter the path where the import file can be located and the filename at the 
Import Filename field.  For example; A:\UNITS.XXX. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the Unit Data file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import Units from File screen, click the Main Menu button to 
return to the UTS Maintenance screen. 

 

Importing Reimbursable Expense Descriptions 
While processing a travel authorization or settlement using UTS, a pop-up table appears at the 
Reimbursable Expenses section when the cursor is positioned at the Description field.   

The Reimbursable Expense Descriptions are stored in the Reimbursable Expense Table, which 
resides in the UTS Maintenance Module.  This table can be populated and updated by importing 
the data from a file that is generated by IATS. 

 Use the following procedures to import the Reimbursable Expenses Data 
File: 

1. Login to the UTS Maintenance Module.   

2. Click on the Import Reimbursable Desc. button.  The Import Reimbursable Descriptions 
from IATS screen appears. 
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3. At this screen, enter the path where the import file can be located and the filename at the 
Import Filename field.  For example; A:\EXPENSE.XXX. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the Reimbursable Expense Data file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import Reimbursable Descriptions from IATS screen, click the 
Main Menu button to return to the UTS Maintenance screen. 

 

Importing Personnel Data File 
User accounts in the UTS database are automatically added and updated by importing a file 
containing personnel information.   

 Use the following procedures to import the Personnel file: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Import/Update Personnel button.  The Import 
Personnel screen appears. 

  

3. At this screen, enter the path, where the import file can be located, and the filename at the 
Import Filename field.  For example; A:\PERSONS.XXX. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the personnel file is located. 
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4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import Personnel screen, click the Main Menu button to return to 
the UTS Maintenance screen. 

 

Importing Accounting Data 
Accounting Appropriations in the UTS database are automatically added and updated by 
importing a file containing accounting lines.   

 Use the following procedures to import the Accounting file: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Import/Update Accounting button.  The 
Import Accounting screen appears. 

  

3. At this screen, enter the path, where the import file can be located, and the filename at the 
Import Filename field.  For example; A:\RT200038.DAT. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the accounting file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import Accounting screen, click the Main Menu button to return to 
the UTS Maintenance screen. 
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Importing Object Codes 
Object Codes in the UTS database are automatically added and updated by importing a file 
containing Object Codes by Fiscal Year.   

 Use the following procedures to import Object Codes: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Import/Update Object Codes button.  The 
Import Object Codes from File screen appears. 

  

3. At this screen, enter the path, where the import file can be located, and the filename at the 
Import Filename field.  For example; A:\OBJFY02. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the accounting file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import Object Codes from File screen, click the Main Menu 
button to return to the UTS Maintenance screen. 

 

Importing RAN Codes 
RAN Codes in the UTS database are automatically added and updated by importing a file 
containing RAN Codes.   

 Use the following procedures to import the RAN Codes file: 

1. Login to the UTS Maintenance Module.   

2. At the UTS Maintenance screen, click on the Import/Update RAN Codes button.  The 
Import RAN Codes from File screen appears. 
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3. At this screen, enter the path, where the import file can be located, and the filename at the 
Import Filename field.  For example; A:\RAN00038.DAT. 

Note:  If the correct path and filename is not known, click on the Browse button to search the 
various system drives and directories until the accounting file is located. 

4. Once the correct path and filename is entered, click the Start Import button.  UTS will begin 
importing the file.  If it is necessary to terminate the process prior to completion, click the 
Stop button. 

5. When finished using the Import RAN Codes from File screen, click the Main Menu button 
to return to the UTS Maintenance screen. 

 

Personal Profiles 
About Profile 

A Personal Profile is a user account that is created for every individual who will use UTS and 
every traveler, who’s claim is processed through UTS.  This profile is used to store personal 
information for the user and establishes their privileges.  Profiles can only be created or deleted by 
a user with System Administrator privileges. 

The capabilities for a user to create, view, modify, or delete a personal profile varies according to 
their View or Privilege as follows: 

�� Traveler - May view, modify, or delete his/her own profile. 
�� System Administrator - May create, view, modify, or delete any personal profile.  

Note:  Privileges can only be modified by users with a System Administrator View. 
 

Creating Profiles 
Personal Profiles for UTS users or travelers are ordinarily created automatically by importing a 
personnel file.  Profiles may also be created manually through the UTS Maintenance module by 
an individual possessing the System Administrator privilege. 

 Manually creating a user Profile: 

1. Login to the UTS Maintenance module. 
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2. Click on the Profiles: Add/Update/Delete button and the Profile Maintenance screen 
appears: 

  

3. Click on the Create New button and the following Profile screen appears. 

  

4. Complete each section with the information needed to identify the user.   

5. Point to the field you wish to access, click the left mouse button. 

6. Type the required information.  

7. When finished, press Enter or Tab to advance to the next field or point to the desired field 
and click the left mouse button. 

Note:  The Work Address section is optional and every field except Phone can be left blank.  

Tip:  Don’t forget to click on the Security and Financial buttons and complete those screens also. 

8. When finished completing the Personal Profile, Financial Information, and Security 
Information screens, click the Save button. 

See Also 
Personal Information  

Financial Information Screen  

Security Information  

Privileges  

New Logon Password 

New Secondary Password 
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Additional Information  

Authentication Information  

Modifying Profiles  

Deleting Profiles  

 

Modifying Profiles 
To modify a Personal Profile, the UTS user must login to UTS in either the Traveler or System 
Administrator View mode.   

 Modifying a Profile using the System Administrator View: 

1. Login to the UTS Maintenance module. 

2. Click on the Profiles: Add/Update/Delete button and the Profile Maintenance screen 
appears. 

  

3. At this screen, enter either the first (2) letters of the last name or the first (2) digits of the 
Employee ID for the profile being modified.  Any profiles matching the criteria appear in the 
table.   
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4. Click on the desired profile, then click the Modify/View/Delete button.  The Personal 
Profile screen appears. 

 

5. At the Personal Profile screen, press Enter or Tab to advance through the input fields, or 
point to the desired field and click the left mouse button. 

6. Type the required change. 
7. Click on the Save button when finished. 

 Modifying a Profile using the Traveler View: 

1. Login to the UTS Processing module in the Traveler View.  If logged in as a Proxy or 
Authorizing Official, click on the Log in as menu at the top of the UTS Request Status 
screen and change the View to Traveler. 

2. At the UTS Request Status screen, click on the Profile menu.   

  

3. At the Profile drop down menu, click on the Modify or View Profile option. 

4. At the Personal Profile screen, press Enter or Tab to advance through the input fields, or 
point to the desired field and click the left mouse button. 

5. Type the required change. 
6. Click on the Save button when finished. 

Tip:  It may be necessary to click on the Security and Financial buttons and make changes at 
those screens also. 
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See Also 
Personal Information  

Financial Information Screen  

Security Information  

Privileges  

New Logon Password 

New Secondary Password 

Additional Information  

Authentication Information  

 

Deleting Profiles 
Personal Profiles may only be deleted by users with System Administrator privileges. 

 Deleting a Profile: 

1. Login to the UTS Maintenance module. 

2. Click on the Profiles: Add/Update/Delete button and the Profile Maintenance screen 
appears. 
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3. At this screen, enter either the first (2) letters of the last name or the first (2) digits of the 
User ID for the profile being modified.  Any profiles matching the criteria appear in the table.   

4. Click on the desired profile, then click the Modify/View/Delete button.  The Personal 
Profile screen appears. 
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5. At the Personal Profile screen, click the Delete button. 

 

Personal Information 

 Enter the information needed to identify the Traveler: 

1. ID:  Enter the traveler’s Employee ID number to be used for logging into UTS.  This 
number must be (9) numeric characters. 

2. SSN:  Enter the traveler’s Social Security Number.  When entering this number, do not use 
spaces or dashes.  This field must also be (9) numeric characters. 

3. Last Name:  Enter the traveler’s last name.   

4. First Name:  Enter the traveler’s first name. 

5. Middle Initial:  Enter the traveler’s middle initial. (Optional). 

6. Grade/Rank:  At this field, a table appears listing the pay grades   CIV, E1-E9, O1-O10, 
W1-W5, O1E-O3E, GS1-GS16, GM1-GM16, WG1-WG16 and WS1-WS16.  Either type 
the traveler’s pay grade or click the Up/Down arrow buttons until the desired pay grade is 
displayed.  Place the pointer on the desired pay grade and click the left mouse button to make 
a selection. 

7. Unit:  Enter the (7) digit number representing the unit or agency the traveler is assigned to. 

8. AO’s Unit: Enter the (7) digit number representing the unit or agency the traveler’s 
Authorizing Official is assigned to. 

9. Privilege:   When creating a traveler profile, the default privilege is Traveler.  To change the 
privilege, click on the Security Information button. 

10. Cost Center:  Enter the (5) digit number representing the Cost Center associated to the 
traveler’s assigned Unit. 

Note:  The Privileges section can only be accessed by the System Administrator. 

 

Home Address 
A Home Address must be entered into the Home Address section of the Personal Profile screen 
for every profile created.   
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 Enter the required information at each field to complete the Home 
Address section. 

1. Point to the field you wish to access, click the left mouse button and the color changes to 
gray. 

2. Type the required information.   

3. When finished, press Enter or Tab to advance to the next field or point to the desired field 
and click the left mouse button. 

Tip:  At the State field, a drop down listing appears.  Click the up/down arrows on the right side 
of the listing until the desired state or country name appears.  Click on the name to populate the 
State field. 

Note:  Address line 2 and the Phone fields are optional.  These fields may be left blank. 

 

Work Address 
With the exception of a Work Phone Number, the Work Address is optional, when creating a 
user profile.  It is always a good idea, however, to obtain as much information as possible in case 
it is necessary to route documentation through the traveler’s office. 

  

 Enter the required information at each field to complete the Work 
Address section. 

1. Point to the field you wish to access, click the left mouse button and the color changes to 
gray. 

2. Type the required information.   

3. When finished, press Enter or Tab to advance to the next field or point to the desired field 
and click the left mouse button. 

Tip:  At the State field, a drop down listing appears.  Click the Up/Down arrows on the right side 
of the listing until the desired state or country name appears.  Click on the name to populate the 
State field. 

Note:  The Phone field cannot be left blank.  A work phone number is mandatory when creating 
a user profile. 
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Financial Information 
Credit Card Information 

The Credit Card Information section of the Financial Information screen is used to identify 
whether the traveler is participating in the Government Charge Card Program. 

  

 Enter the following Information to complete the Credit Card Information 
section: 

1. Make the appropriate selection to identify the traveler’s credit card status: 

�� Credit Card Status - At this field, a drop down listing appears displaying several options.  
Point and click on the desired option to make a selection. 

2. When finished making a selection, click the Previous Screen button.  

3. At the Personal Profile screen, click the Save button to save the credit card information. 
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Security Information 
Click the Security Information button on the Personal Profile screen and  the Security 
Information screen appears:  This screen is used to capture the information needed to grant access 
to the UTS program.  

  

At this screen, the Traveler or System Administrator must enter the appropriate information to 
complete each section.   

 The following links provide detailed information for completing these 
sections: 

Privileges 

New Logon Password 

New Secondary Password  

Authentication Information  

Additional Information  

 

Privileges 

Privileges are associated with the View Modes.  The privilege or view identifies what capabilities 
and access the user possesses.  When a user profile is created, the default privilege is Traveler.  A 
user can be granted more than one privilege, however. 
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Note:  The Privileges for Authorizing Official, or System Administrator: can only be added or 
changed by a System Administrator. 

 Changing or Adding Privileges: 

1. Login to the UTS Maintenance Module. 

2. At the UTS Maintenance Menu, click on the Profiles: Add/Update/Delete button. 

3. The next screen to appears requires the System Administrator to select a traveler. At this 
screen, enter either the first (2) letters of the last name or the first (2) digits of the Employee 
ID for the profile being modified.  Any profiles matching the criteria appear in the table. 

4. Click on the desired profile, then click the Modify/View/Delete button.  The Personal 
Profile screen appears. 

5. At the Personal Profile screen, click the Security Information button. 

6. At the Security Information screen, press Enter, Tab, or use the left and right arrow keys to 
highlight the desired privilege. 

7. Point to the desired or highlighted option and click the left mouse button.  A check mark 
appears next to the selected privilege. 

Tip:  Clicking on a privilege that has a check mark  causes the check mark to disappear and de-
selects the privilege.   

 

New Logon Password 
The New Logon Password section is used to establish a unique Logon Password for every user 
who will access UTS. 

Tip:  The Logon Password must be (8) characters.  In addition, (2) of the characters must be 
numeric. 

  

At the Enter field, type the Password the user will enter when logging into UTS.  After typing 
the password and pressing Enter, the user is required to type the password a second time at the Re-
enter field. 

Note:  Passwords should only be known by the individual user.  If the passwords were initially 
created by the System Administrator, users should change their passwords after accessing UTS 
for the first time. 

See Also  
Changing Passwords 
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New Secondary Password 
The Secondary Password serves as the electronic signature for releasing travel authorizations and 
settlements for further processing.  A Secondary Password must be created before a user is able to 
login to UTS.   

Tip:  The Secondary Password must be (8) characters.  In addition, (2) of the characters must be 
numeric. 

  

At the Enter field, type the Secondary Password the user will type when releasing travel 
authorizations and settlements.  After typing the password and pressing Enter, the user is required 
to type the password a second time at the Re-enter field. 

Note:  Passwords should only be known by the individual user.  If the passwords were initially 
created by the System Administrator, users should change their passwords after accessing UTS 
for the first time. 

See Also 
Changing Passwords  

 

Authentication Information 
The Authentication Information section of the Security Information screen is used to verify a users 
access to the UTS program.  When logging into UTS, the user is required to enter a password at 
the UTS Password screen.  If the user cannot remember their password, access can be gained by 
clicking on the Forgot my Password button and entering the authentication information.  If this 
information matches the authentication information previously entered into the UTS database, 
access is granted. 

  

At this screen enter the following information: 

�� Mother’s Maiden Name 

�� Date of Birth 

�� Town of Birth 

See Also 
Logging into UTS  

Forgot my Password  
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Additional Information 
The additional Information section is used to establish who is designated as an Authorizing 
Official to approve travel actions.  This section is also used to establish who can act as a 
Signature Proxy on behalf of the Traveler.   

  

�� Default Authorizing Officer:  At this field, a listing of Names appears for individuals 
possessing AO privileges for the Traveler’s unit.  Point to the desired name and click the left 
mouse button to make a selection. 

�� Signature Proxy:  Any individual belonging to the same unit as the Traveler, may be 
designated as a Signature Proxy on behalf of the Traveler.  At this field, the user must enter the 
first (2) letters of the desired Signature Proxy’s last name.  A listing of Names, beginning with 
the two letters entered, appears.  If the desired name is highlighted, press Enter.  If the desired 
name is not highlighted, click the Up/Down arrows on the keyboard to scroll through the list 
until the correct name appears.   

�� Office Email Address:  Enter an email address at this field in order to send/receive UTS 
generated notifications that a Request for Authorization, Advance, or Settlement has been 
forwarded to the AO, Traveler, or Proxy. 

�� Home Email address:  For future use. 

 

Changing Passwords 
Passwords should only be known by the individual user.  If the passwords were initially created 
by the System Administrator, users should change their passwords after accessing UTS for the 
first time. 

 Complete the following steps to change a Logon or Secondary 
Password: 

1. Login to UTS.  If the View mode displayed on the UTS Request Status or UTS Requests 
Requiring Action screen is other than Traveler, change the view to Traveler to continue. 

2. At the UTS Request Status or UTS Requests Requiring Action screen, click on the Profile 
menu.   

3. At the Profile drop down menu, click on Modify or View Profile. 

4. At the Personal Profile screen, click on the Security Information button. 

5. At the Security Information screen, press Enter or Tab to advance through the input fields 
or point and click on the Enter field at the New Logon Password or New Secondary 
Password sections. 
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6. Type a new Logon or Secondary Password and press Enter.  

7. At the Re-enter field, type the new Logon or Secondary Password and press Enter. 

8. Click on the Previous Screen button when finished. 

9. At the Profile screen, click the Save button. 

See Also 
Changing View  

 



 

Views 
 About Views 

The Unit Travel System (UTS) can be operated in one of four different view modes.  The various 
view modes are used to determine what privileges and capabilities the user possesses.  View 
modes are associated to the users profile and are established by the System Administrator.  

When a user account is created, the default view is Traveler unless the System Administrator 
gives the user Authorizing Official or System Administrator privileges.   

Note:  Any user can change their view to Proxy and perform services on behalf of any other 
Traveler sharing the same unit number.   

Tip:  A View can also be defined as the user’s Privilege. 

See Also 
Changing Views  

About Profiles  

About Travelers  

About Proxies  

About Authorizing Officials  

About System Administrators  

 

View Modes 
Traveler, Proxy, Authorizing Official, System Administrator 

 

Changing View 
When a Personal Profile is created, a user may be given privileges for several different View 
modes.  In order to perform the functions associated with a particular view, however, it may be 
necessary to change the View after logging into UTS.   

 Complete the following steps to change a View mode: 

1. Login to UTS.  Notice that the type of View is displayed at the View field on the UTS 
Request Status or UTS Requests Requiring Action screen. 

2. Click on the Log in as menu.  A drop down menu appears listing the various view modes that 
the user has privileges for. 
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3. Click on the View mode you wish to use.   

4. The new mode will appear at the View field. 

See Also 
View Modes  

About Travelers  

About Proxies  

About Authorizing Officials  

About System Administrators  

 

Traveler 
About Travelers 

The Traveler View mode is used by individuals who perform travel on behalf of the US 
Government and will use UTS to process their requests for advance or reimbursement of travel 
expenses.  When logged into UTS in the Traveler View, the user has the ability to generate a 
variety of travel actions. 

By clicking on the File menu at the UTS Request Status screen and then selecting the Create 
option, the following drop down menu appears.  The user may then select the desired action. 

  

Travelers will use UTS to initially request a travel authorization and then a subsequent request 
for advance, or settlement at the conclusion of the trip.   
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See Also  
About Travel Authorizations  

About Travel Orders  

About Travel Advances  

About Travel Settlements  

About Local 1164 Travel  

 

Proxy 
About Proxy 

There are two different Proxy capabilities that can be established within UTS.   

�� Agency Proxy 

�� Signature Proxy 

Agency Proxy 
Any individual possessing an active UTS user account may act as a Proxy for requesting travel 
actions on the behalf of any traveler within the same organization.  When logged into UTS in the 
Proxy view, the user has the ability to initiate a variety of travel actions for any other individual 
assigned to the same unit.  The Agency Proxy completes the initial request on the behalf of the 
traveler, but cannot release the action for further processing.  The action may only be released by 
the Traveler or the Signature Proxy. 

By clicking on the File menu and then selecting the Create option at the UTS Request Status 
screen, the following drop down menu appears.  The Agency Proxy may then select the desired 
option. 

  

Note:  Requests for authorizations and  settlement actions completed by the Agency Proxy are 
returned to the traveler to be released to the AO for approval.   

Signature Proxy 
Occasionally, a traveler may be unable or unavailable to access UTS to release their own 
requested travel action.  When this situation is anticipated, or simply as a precaution, a traveler 
may designate another individual as a Signature Proxy.  Signature Proxies have the same 
capabilities as Agency Proxies to request or complete various travel actions for other individuals.  
In addition, settlement actions released by the Signature Proxy are electronically signed on behalf 
of the traveler and forwarded to the Authorizing Official. 
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Note:  A Signature Proxy acts on the behalf of the Traveler and has the same capabilities. 

See Also 
Designating an Agency Proxy  

Designating a Signature Proxy  

 

Designating an Agency Proxy 
No special action is required to designate an individual to be an Agency Proxy for a particular 
unit.  All personnel who are authorized to use UTS may perform Proxy services for any other 
individual assigned to the same Unit. 

To perform Proxy services, however, an individual must change their view to Proxy after logging 
into UTS. 

See Also 
Changing View  

 

Designating a Signature Proxy 
When necessary, Travelers may designate another individual to act as a Signature Proxy for 
initiating and releasing travel actions on their behalf. 

 Complete the following steps to designate a Signature Proxy: 

1. Login to UTS in the Traveler view mode or change the view to Traveler if necessary. 

2. At the UTS Request Status screen, click on the Profile menu.   

3. At the Profile drop down menu, click on Modify or View Profile. 

4. At the Personal Profile screen, click on the Security button. 

5. At the Security Information screen, click the Signature Proxy field.   

  

6. At the Signature Proxy field, the user must enter the first (2) letters of the desired Signature 
Proxy’s last name.  A listing of Names, beginning with the two letters entered, appears.  If 
the desired name is highlighted, press Enter.  If the desired name is not highlighted, click the 
Up/Down arrows on the keyboard to scroll through the list until the correct name appears...  

7. When the desired name is highlighted, press Enter to make the selection. 

8. When finished, click the Previous Screen button. 

9. At the Personal Profile screen, click the Save button. 

See Also 
About Proxies  
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Authorizing Official 
About Authorizing Officials 

Authorizing Officials (AO’s) are individuals who have been designated to approve requests for 
travel authorizations, advances, and settlements for a specific organization or individual 
traveler.  This designation is generally pre-determined and incorporated into the UTS database 
when the personnel file is imported.  AO’s may also be designated by the UTS System 
Administrator.   

When units and personnel are added to the UTS database, a default AO is established.  UTS 
System Administrators have the ability to change or reassign the default AO’s as required.   

When travelers are forwarding their requests to the AO for approval, they have the ability to 
select a different AO if necessary. 

A request for advance or settlement cannot be processed until a travel authorization has been 
approved by an AO or there is an approved travel order in the UTS database.   

Requests for advances and settlements cannot be transmitted to the Integrated Automated Travel 
System (IATS) for computation until approved by an AO. 

See Also 
Approving Requests  

Returning Requests  

Forwarding Requests  

 

Approving Requests 
A request for advance or settlement cannot be processed without one of the following: 

�� A UTS created Travel Authorization approved by an AO.  

�� A Travel Order, for the associated claim, in the UTS database.   

In addition, requests for advances and settlements cannot be transmitted to the Integrated 
Automated Travel System (IATS) for computation until approved by an AO. 

After travel requests are processed by a Traveler or Proxy, they must be released to an AO for 
approval.  Once released, AO’s approve travel requests by logging into UTS in the Authorizing 
Official view, selecting the transactions, and reviewing the entries.  The AO can then either 
approve the transactions or return them to the source. 

 Complete the following steps to approve a Travel Request: 
1. Login to UTS in the Authorizing Official view, or change the view to AO if necessary. 

2. At the UTS Requests Requiring Action screen, any transactions pending approval by the AO are 
displayed in the Claims List.  Point and click on the desired transaction.   
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3. Once a transaction is selected, either click the Modify or View button, or click the File menu 
and then click on the Modify or View option.  Depending on the type of transaction selected, 
either the Request for Authorization or Request for Settlement screen appears. 

  

4. At either the Request for Authorization or Request for Settlement screen, the AO must 
review the entries and then click the Send To button.   

5. After clicking on the Send To button, a pop-up appears with the choices Return to Traveler or 
Approved.  Click on Approved. 

6. A screen appears next requiring the AO to enter a confirmation password.  This is the 
Secondary Password that was created when the AO’s Personal Profile was created.  Enter the 
confirmation password and click the Done button. 

See Also 
Returning Requests  

Forwarding Requests  
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Returning Requests 
Rather than approving a requested travel action, an AO may elect to return the request to the 
traveler.  The request could be disapproved or corrections may be required prior to approval. 

 Complete the following steps to Return a travel request: 

1. Login to UTS in the Authorizing Official view, or change the view to AO if necessary. 

2. At the UTS Requests Requiring Action screen , any transactions pending approval by the 
AO are displayed in the Claims List.  Point and click on the desired transaction.   

  

3. Once a transaction is selected, there are (3) methods for returning travel request: 

�� Method 1: - Click the Return to Traveler button. 

�� Method 2: - Click the File menu and then click on the Return to Traveler option.   

�� Method 3: - Click the Modify or View button.  Depending on the type of transaction 
selected, either the Request for Authorization or Request for Settlement screen appears.  At 
this screen, the AO must review the entries and then click the Send To button.  After clicking 
on the Send To button, a pop-up appears with the choices Return to Traveler or Approved.  
Click on Return to Traveler. 

4. After using one of the methods described above, UTS displays the Remarks screen.  At this 
screen, the AO can enter an explanation as to why the request is being return and what action 
is required.   

  
5. Enter the desired remark and click the Continue button.  UTS returns the request. 
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See Also 
Approving Requests  

Forwarding Requests  

 

Forwarding Requests 
If an AO knows that he/she will be unavailable to process travel requests during a certain period, 
UTS provides a feature that allows the AO to automatically or manually forward all incoming 
requests to another AO.  This could occur if an AO is going on vacation or TDY.   

Note:  Forwarding can be done automatically by UTS or manually by the original AO.   

�� Automatic Forwarding is done through the Enable Forwarding option.  When Forwarding is 
enabled, UTS automatically routes travel requests released to the original AO to the designated 
AO for a specified period.  Only requests that are released after Forwarding is enabled are 
affected.  Any requests that have already been released and are pending action by the AO, must 
be manually forwarded. 

�� Manual Forwarding is done by the original AO by using the Forward This Request or 
Forward all Requests options. 

 The following links provide detailed instructions on how to Forward 
requests: 

Automatic Forwarding  

Manual Forwarding  

 

Automatic Forwarding 

 Complete the following steps to Enable Automatic Forwarding: 

1. Login to UTS in the Authorizing Official view, or change the view to AO if necessary. 

  

2. At the UTS Requests Requiring Action screen, click on the Forwarding menu and then 
click on the Enable Forwarding option. 
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3. After clicking the Enabling option, a screen appears requiring the AO to specify the period 
and select a new AO.  Enter the required information in the following fields to complete this 
screen: 

�� Effective Starting Date - The current date defaults to this field.  Enter a new date, or press the 
Tab key to continue. 

�� Effective Ending Date - The current date defaults to this field.  Enter a new date, or press the 
Tab key to continue. 

�� New AO - Click in the New AO field and a drop down listing of possible AO’s appears.  Point 
and click on the desired AO to make a selection. 

4. After selecting a new AO, click the Done button. 

5. A pop-up appears indicating the name of the new AO requests will now be forwarded to.  
Click OK to complete the process. 

 Complete the following steps to Disable Automatic Forwarding: 

1. Login to UTS in the Authorizing Official view, or change the view to AO if necessary. 

  

2. At the UTS Requests Requiring Action screen, click on the Forward menu and then click 
on the Disable Forwarding option. 

  

3. A pop-up appears indicating the name of the AO the requests are currently being forwarded 
to and whether this option should be disabled.  Click on the Yes button. 

See Also 
Manual Forwarding  
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Manual Forwarding 

 Complete the following steps to Manually Forward requests. 

1. Login to UTS in the Authorizing Official view or change the view to AO if necessary. 

2. At the UTS Requests Requiring Action screen, any transactions pending approval by the 
AO are displayed in the Claims List.  Point and click on the desired transaction.   

  

3. Once a transaction is selected, click the Forward menu and then click on either the Forward 
This Request or Forward all Requests options. 

4. After selecting one of the manual forwarding options, a screen appears requiring the AO to 
specify which new AO the requests should be sent to.  Click in the New Authorizing Official 
field and a drop down listing of possible AO’s appears.  Point and click on the desired AO to 
make a selection. 

  

5. After selecting a new AO, click the Done button. 

See Also 
Automatic Forwarding  
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System Administrator 
About System Administrators 

UTS System Administrators have exclusive access to the UTS Maintenance Module.  Only users 
with this privilege can log into this module.   

As a System Administrator (SA), the user has the ability to create user accounts manually and 
assign privileges.  In addition to creating accounts, the SA can also modify or delete them.  The 
SA is also responsible for importing data files to update various tables and creating export files 
to interface with the travel computation system (IATS).  

The System Administrator designation is generally pre-determined and incorporated into the UTS 
database when the personnel file is imported.  A System Administrator can also grant the SA 
privilege when creating or modifying user profiles.   

 The following links provide detailed instructions for performing the 
various System Administrator functions: 

Exporting Claims  

Maintaining User Accounts  

Maintaining City Names and Rates  

Reassigning Authorizing Officials  

Maintain Ships Table  

Establish Miscellaneous Parameters  

Maintaining Units  

Importing Unit Data  

Importing Reimbursable Exp. Descriptions  

Importing Personnel Data  

Importing Accounting Data  

 



 

Travel Authorizations 
About Travel Authorizations 

A Travel Authorization is the basis for reimbursement of travel expenses.  An Authorization 
outlines the details of the trip and requests the various items necessary for the accomplishment 
for the mission.  In addition, an Authorization provides the funding information necessary for 
reporting the obligation and expenditure to the accounting system.   

�� A Travel Authorization must be initiated by either the Traveler, Agency Proxy, or Signature 
Proxy.   

�� After a Travel Authorization is created, it must be released to the Authorizing Official for 
approval.   

�� A request for advance or settlement cannot be processed unless there is an approved Travel 
Authorization or Travel Order in the database. 

See Also 
Creating Travel Authorizations  

Canceling Travel Authorizations  

Saving Travel Authorizations  

Releasing Travel Authorizations 

Deleting Travel Authorizations  

Printing Travel Authorizations  

Viewing Travel Authorizations  

Modifying Travel Authorizations 

About Travel Orders  

 

Creating Travel Authorizations 
A Travel Authorization must be initiated by either a Traveler, Agency Proxy, or Signature 
Proxy.  Without an approved Travel Authorization or Travel Order in the database, a request for 
advance or settlement cannot be processed. 

 Creating a Travel Authorization as a Traveler:  

1. Login to UTS in the Traveler mode or change the view to Traveler if necessary. 

2. At the UTS Request Status screen, there are two ways to initiate a Request for TDY or 
MILPCS Travel Authorization: 

��Click on the Fill out button. 

��Click on the File menu and then point to the Create option.   

If either of these two options is used, a drop down menu appears listing a variety of travel actions. 
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3. Click on either the Request for TDY or MILPCS Travel Authorization option.  The TDY 
or MILPCS Travel Request screen appears. 

  

Note:  The TDY Travel Request screen consists of (3) sections; Top, Itinerary, and 
Reimbursable Exp.  The MILPCS Travel Request screen consists of (4) sections.  Top, 
Dependents, Itinerary, and Reimbursable Exp. 

4. Enter the required information in each applicable section to create the request for 
authorization.  Refer to the links listed under the “See Also” heading below for additional 
instructions. 

 Creating a Travel Authorization as a Proxy: 

1. Login to UTS in the Proxy mode or change the view to Proxy if necessary. 

2. At the UTS Request Status screen, there are two ways to access the TDY or MILPCS 
Travel Request screen: 

��Click on the Fill out button.  

��Click on the File menu and then point to the Create option.  
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If either of these two options is used, a drop down menu appears listing a variety of travel actions. 

3. Click on either the Request for TDY or MILPCS Travel Authorization option.  The Select 
Traveler screen appears. 

  

4. The Select Traveler screen displays a listing of the Travelers the Proxy may perform services 
for.  Select a Traveler by pointing and clicking on the desired name. 

5. After selecting the Traveler, click the Create TDY or MILPCS Travel Auth for Selected 
Traveler button.  The TDY or MILPCS Travel Request screen appears. 

6. Enter the required information in each of the applicable sections to create the request for 
authorization.  Refer to the links listed under the “See Also” heading below for additional 
instructions. 

See Also 
Travel Authorizations - Itinerary  

Travel Authorizations - Reimbursable Expenses  

TDY Travel Authorization - Top Section  

MILPCS Travel Authorization - Top Section  

MILPCS Travel Authorization - Dependents  

Canceling Travel Authorizations  

Saving Travel Authorizations  

Printing Travel Authorizations  

Viewing Travel Authorizations  

 99



 

Modifying Travel Authorizations  

Deleting Travel Authorizations  

 

Travel Authorizations - Itinerary 
The Itinerary section is used to record the anticipated details regarding the trip.   

 Completing the Itinerary section 

1. Click the Itinerary button at the top of the Travel Request screen or the down arrow on the 
slide bar at the right side of the screen to access the Itinerary section. 

  

2. Complete the itinerary by entering the following information: 

�� Variations Authorized - Click on this item if the traveler should be allowed to deviate from 
the ordered itinerary.  Click on this item again to de-select, if necessary. 

�� Depart Date - The departure date on the first line of the itinerary automatically defaults from 
the beginning date entered at the Period Covered field in the Top section.  Press Enter to 
continue or type a different date, if necessary. 

�� Depart Location - At this field, the Location Lookup screen automatically appears.  
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At the State/Country field, type the first letter of the state or country then click the Up/Down 
arrows until the desired name is displayed.  Click on the name to select.   

At the City field, type the first two letters of the city name.  This displays a listing of city names, 
for the previously selected state or country, beginning with those letters.  Click on the desired city 
name to select. 

�� Transportation - At this field, a drop down listing of various transportation modes appears.  
Click the Up/Down arrows until the desired mode is displayed.  Click on the correct mode to 
select. 

�� Group? - When Group Travel Rules has been activated in the Top Section, and the 
transportation mode is PP, CP, CV, GP, GV, TP, TV, AF, CS, the user must specify whether 
Group Travel rules apply.  If Group Travel rules apply to the leg, click this box. 

Note:  When Group Travel rules are selected, the computation program will not calculate any 
per diem for the Group Travel leg. 

�� Arrive Date - The date at the previous Departure Date field defaults to the Arrival Date 
field.  Press Enter to accept this date or type a new date if necessary. 

�� Arrive Location - Use the same method explained at the Depart Location field to complete 
the Arrive Location field.  This should be the location where the traveler will stop to perform 
official duty. 

Note:  At the Arrival Location Lookup screen, click the Onboard Ship box if the location the 
traveler is arriving at is a Government Vessel. 
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A drop down listing of US Coast Guard ship names appears.  Begin typing the name of the ship 
or click the Up/Down arrows until the desired ship name is displayed, then click on the correct 
ship’s name to make a selection. 

�� Reason for Stop - At this field, a drop down listing of various reasons for stopping appears.  The 
default value for this field is TD - Temporary Duty.  Press Enter if this is correct.  If not, click 
the Up/Down arrows until the desired reason is displayed.  Click on the correct reason to select. 

�� Method of Reimbursement - At this field, a drop down listing of various per diem computation 
methods appears. The default value for this field is LDP - Lodgings Plus.  Press Enter if this is 
correct.  If not, click the Up/Down arrows until the desired method is displayed.  Click on the 
correct method to select. 

�� Quarters - At this field, a drop down listing of various lodging types appears. The default value 
for this field is CQ - Commercial Lodging. Press Enter if this is correct.  If not, click the 
Up/Down arrows until the desired type is displayed.  Click on the correct type to select. 

�� Messing - At this field, a drop down listing of various meal types appears. The default value for 
this field is CM - Commercial Meals. Press Enter if this is correct.  If not, click the Up/Down 
arrows until the desired type is displayed.  Click on the correct type to select. 

�� Lodging Cost - At this field, enter the anticipated daily lodging cost for the location where the 
traveler will remain overnight.   

�� POC Miles - At this field, enter the official distance for the ordered travel, if a privately owned 
vehicle was used.  

Tip:  Use the procedures previously explained to complete the return travel leg or additional travel 
legs for the itinerary.  

3. When finished with the itinerary, complete the Reimbursable Expenses section, if necessary, 
or save the authorization and release it to the Authorizing Official for approval. 

See Also 
Entering Dates  

Deleting Itinerary Legs 

Inserting Itinerary Legs 

Travel Authorizations - Reimbursable Expenses 

Printing Travel Authorizations 

Canceling Travel Authorizations 

Releasing Travel Authorizations 

Saving Travel Authorizations 

 102 



 

Inserting Itinerary Legs 
When completing the itinerary section of a Request for Travel Authorization or Settlement, it 
may be necessary to insert an additional leg rather than re-entering the entire itinerary.   

 Complete the following steps to insert an itinerary leg: 

1. Point and click in either the arrive or depart date fields where the new itinerary should be 
inserted. 

2. Click on the Insert Leg button.  UTS will insert a new leg at the selected location. 

  

Note:  After the new leg is inserted, it may be necessary to change the arrive/depart dates or the 
arrive/depart locations. 

3. Make any necessary changes to the newly inserted itinerary leg. 

 

Deleting Itinerary Legs 
When completing the itinerary section of a Request for Travel Authorization or Settlement, it 
may be easier to delete a travel leg rather than re-entering the entire itinerary.  This action may be 
necessary when a travel leg was entered unnecessarily or erroneously. 

 Complete the following steps to delete an itinerary leg: 

1. Point and click in either the arrive or depart date fields of the leg that should be deleted. 

  

2. Click on the Delete Leg button.  UTS will delete the selected itinerary leg. 
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Note:  An itinerary leg consists of a depart and arrive line.  Both will be deleted. 

Travel Authorizations - Reimbursable Expenses 
The Reimbursable Expenses section is used to record the anticipated expenses the traveler will 
incur that are not associated with per diem or POC mileage. 

 Completing the Reimbursable Expenses section: 

1. Click the Reimbursable Exp button at the top of the Travel Request screen or the down 
arrow on the slide bar at the right side of the screen to access the Reimbursable Expenses 
section. 

  

2. Complete this section by entering the following information: 

�� Nature of Expense - At this field, a drop down listing of various expense items appears.  
Click the Up/Down arrows until the desired expense item is displayed.  If the user types the 
first letter of the description, UTS scrolls the listing until locating the first item beginning 
with this letter.  The user may then use the Up/Down arrows to display the exact item.  Once 
the correct item is displayed, click on this item to select. 

�� Amount Proposed- At this field, enter the expected amount of the expense.   

3. When finished entering the anticipated reimbursable expenses, take the required action to 
save the authorization and forward it to the Authorizing Official for approval.  

See Also 
Inserting Expense 

Deleting Expense 

Printing Travel Authorizations 

Canceling Travel Authorizations 

Releasing Travel Authorizations 

Saving Travel Authorizations 
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Inserting Expense 
When completing the Reimbursable Expenses section of a Request for Travel Authorization or 
Settlement, it may be necessary to insert an additional expense item before one that was already 
entered. 

 Complete the following steps to insert an Expense: 

1. Point and click in the field where the new expense should be inserted. 

2. Click on the Insert Expense button.  UTS will insert a new line at the selected location in the 
expenses listing. 

3. Enter the required expense. 

  

See Also 
Entering Reimbursable Expenses  

Deleting Expense  

 

Deleting Expense 
When completing the Reimbursable Expenses section of a Request for Travel Authorization or 
Settlement, it may be necessary to delete an expense that was previously entered. 

 Complete the following steps to delete an Expense: 

1. Point and click in the field for the expense to be deleted. 

2. Click on the Delete Expense button.  UTS will delete the entire line for the field selected. 
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See Also 
Entering Reimbursable Expenses  

Inserting Expense  

Canceling Travel Authorizations 
There are two ways to cancel a Travel Authorization that has not been saved.: 

1. Click the Cancel button at the bottom of the Travel Request screen. 

2. Click on the File menu at the top of the Travel Request screen, then click on the Cancel all 
changes option. 

  

After clicking on cancel, by using either method, a pop-up appears asking if you wish to cancel the 
screen.  Click Yes if you wish to cancel without saving any of the input. 

Note:  If you wish to get rid of a Travel Authorization that has previously been saved, it must be 
deleted. 

See Also  
Deleting a Travel Authorization  

 

Saving Travel Authorizations 
There are two ways to save a Travel Authorization: 

1. Click the Save button at the bottom of the Travel Request screen. 

2. Click on the File menu at the top of the Travel Request screen, then click one of the 
following options: 
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�� Save and Return to Previous Screen - Use this option if you have finished creating the 
authorization and wish to exit UTS or perform another task. 

�� Save and Continue editing - Use this option if you are not finished creating the 
authorization, but would like to save what is completed so far. 

 

Deleting Travel Authorizations 
A Traveler or Proxy may delete Travel Authorizations that have not been released to an AO. 

 Delete a Travel Authorization in the Traveler or Proxy View: 

1. Login to UTS in the Traveler or Proxy mode, or change the view if necessary. 

  

2. At the UTS Request Status screen, select the Travel Authorization you wish to delete by 
pointing and clicking on the desired authorization displayed in the Claims List. 

3. After selecting an authorization, use one the following methods to delete the authorization: 

�� Method 1: - Click the Delete button at the bottom of the UTS Request Status screen and 
then click Yes at the Are You Sure pop-up. 

�� Method 2: - Click the File menu and select the Delete option from the drop down menu.  
Click Yes at the Are You Sure pop-up. 

�� Method 3: - Click the Modify or View button at the bottom of the UTS Request Status 
screen to access the Travel Request screen.  At this screen, click the Delete Travel Request 
button.  Click Yes at the Are You Sure pop-up. 

Note:  The Proxy may delete his/her own authorization or one created by the Proxy on behalf of 
another individual. 

 Delete a Travel Authorization in the Authorizing Official View: 

1. Login to UTS in the Authorizing Official mode or change the view to AO if necessary. 

2. At the UTS Requests Requiring Action screen, select the Travel Authorization you wish to 
delete by pointing and clicking on the desired authorization displayed in the Claims List. 
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3. After selecting an authorization, click the Modify or View button.   

4. At the TDY or MILPCS Travel Request screen, click the Delete Travel Request button. 

5. A pop-up will appear asking if you wish to delete this request.  Click on Yes. 

 

Releasing Travel Authorizations 
There are several ways to release a travel authorization for approval.  In addition, this process can 
be performed by either the Traveler or the Signature Proxy designated by the Traveler. 

 Use one of the following methods to release a Travel Authorization: 

�� Method 1: - Click the Send to AO button at the bottom of the Travel Request screen. 

  

�� Method 2: - Click on the File menu at the top of the Travel Request screen, then click on 
the Send to AO option. 
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�� Method 3: - Point and click on the desired authorization listed in the Claims List on the UTS 
Request Status screen, then click the Send to Auth button. 

  

�� Method 4: - Point and click on the desired authorization listed in the Claims List on the UTS 
Request Status screen, click on the File menu, then click on the Send to Authorizing 
Official option. 

1. After using one of the above methods to release a Travel Authorization, the Select 
Authorizing Official screen appears requiring the user to select an AO.  

  

2. At the Select Authorizing Official screen, the name of the traveler’s unit will be displayed at 
the Site field and the designated Authorizing Officials are listed below.  If the correct AO is 
listed, click on the desired name, then click on the Transmit to AO button.  The user can also 
click on the Change Site button to select a different unit and see a list of Authorizing 
Officials for the newly selected unit.   

3. After selecting an AO, a pop-up appears requiring the entry of a Confirmation Password.  
This is the Secondary Password that was created when the user’s Personal Profile was 
created. 

4. After selecting an AO, UTS forwards the transaction to the AO and returns to the UTS 
Request Status screen. 
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Printing Travel Authorizations 
There are two ways to print a Travel Authorization: 

1. Click the Print button at the bottom of the Travel Request screen. 

2. Click on the File menu at the top of the Travel Request screen, then click on the Print 
option. 

  

 

Viewing Travel Authorizations 
Regardless of whether the user is logged into UTS as a Traveler, Proxy, or Authorizing Official, 
the process for viewing a Travel Authorization is essentially the same.  The only difference is that 
the name of the initial screen is titled (UTS Request Status) for the Traveler and Proxy.  For the 
AO, this screen is titled (UTS Requests Requiring Action). 

 Complete the following steps to View a Travel Authorization: 

1. Login to UTS. 

2. At the UTS Request Status or UTS Requests Requiring Action screen, there are two ways 
to view the TDY or MILPCS Travel Request screen: 

  

�� Method 1:  Select the Travel Authorization you wish to view by pointing and clicking on the 
desired authorization displayed in the Claims List.  After selecting an authorization, click the 
File menu and select the Modify or View option from the drop down menu.  
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�� Method 2:  Select the Travel Authorization you wish to view by pointing and clicking on the 
desired authorization displayed in the Claims List.  After selecting an authorization, click the 
Modify or View button at the bottom of the screen. 

3. After using method 1 or 2 to select an authorization for viewing, the TDY or MILPCS 
Travel Request screen appears. 

4. When finished viewing the authorization, click the Cancel button or the X in the top right 
corner of the Travel Request screen, then click on Yes to cancel the screen and return to the 
UTS Request Status or UTS Requests Requiring Action screen.  

 

Modifying Travel Authorizations 
Regardless of whether the user is logged into UTS as a Traveler, Proxy, or Authorizing Official, 
the process for modifying a Travel Authorization is essentially the same.  The only difference is 
that the name of the initial screen is titled (UTS Request Status) for the Traveler and Proxy.  For 
the AO, this screen is titled (UTS Requests Requiring Action). 

 Complete the following steps to Modify a Travel Authorization: 

1. Login to UTS. 

2. At the UTS Request Status or UTS Requests Requiring Action screen, there are two ways 
to access the TDY or MILPCS Travel Request screen. 

  

�� Method 1:  Select the Travel Authorization you wish to modify by pointing and clicking on 
the desired authorization displayed in the Claims List.  After selecting an authorization, click 
the File menu and select the Modify or View option from the drop down menu.  

�� Method 2:  Select the Travel Authorization you wish to modify by pointing and clicking on 
the desired authorization displayed in the Claims List.  After selecting an authorization, click 
the Modify or View button at the bottom of the screen. 

3. At the TDY or MILPCS Travel Request screen, press Enter or Tab to advance through the 
input fields, or point to the desired field and click the left mouse button.   

4. Type the required change or select a new option as needed. 

5. When finished modifying the authorization, click the Save button. 
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TDY Travel Authorizations 
TDY Travel Authorization - Top Section 

The Top section of the TDY Travel Request screen is used to determine the following: 

�� Travel Order Number 

�� Type of Travel Order 

�� Purpose of the Trip 

�� Funding Organization 

�� Period Covered 

�� Authorized Mode of Transportation 

�� Special Authorizations 

�� Accounting Appropriation 

�� Special Remarks 

  

 Completing the Top Section of the TDY Travel Request screen: 

Tip:  Press Enter or Tab to advance through the fields or point to the desired field and click the 
left mouse button. 

�� TONO - Type the travel order number for the request being created. 

�� Type of Order - At this field, a drop down listing appears.  Click the Up/Down arrows on 
the right side of the listing until the desired travel order type appears.  Click on the desired 
type to populate the Type of Order field. 

�� Purpose - At this field, a drop down listing appears.  Click the Up/Down arrows on the right 
side of the listing until the desired purpose of the trip type appears.  Click on the correct 
purpose to populate the Purpose field. 

�� Funds Used - At this field, a drop down listing appears.  Click the Up/Down arrows on the 
right side of the listing until the name of the organization funding the travel appears.  Click on 
the correct organization to populate the Funds Used field. 

�� Covered - Enter the anticipated beginning and ending dates of the trip at the From/To fields.   

�� Mode of Travel - At this section, point to the requested mode of travel and click the left 
mouse button.  A check mark appears indicating a selection.  Click on the item again to de-
select, if necessary.  At the Privately Owned Vehicle field, a drop down listing appears. 
Point and click on the desired type to make a selection. 
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�� Special Authorizations - On the right side of the Top Section, a list of special authorizations 
appear.  Point and click on any of these applicable items.  Click on the item again to de-
select, if necessary. 

See Also 
Type of Orders  

Entering Accounting  

Entering Remarks  

Travel Authorizations - Itinerary  

Travel Authorizations - Reimbursable Expenses  
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Travel Orders 
About Travel Orders 

A Travel Order is the basis for reimbursement of travel expenses and must be created by the 
Traveler, Agency Proxy, or Signature Proxy.  It is used to outline the details of the trip and to 
approve the various items necessary for the accomplishment for the mission.  In addition, it 
provides the funding information necessary for reporting the obligation and expenditures to the 
accounting system.   

When a Travel Authorization, which was created using UTS, is approved by an AO, UTS 
automatically creates a Travel Order record.  If the Travel Order was published using an order 
writer system, other than UTS, the Travel Order record must be manually created by the UTS 
user.   

A request for advance or settlement cannot be processed unless there is a Travel Order record in 
the database. 

See Also 
Creating TDY Travel Orders  

Creating MILPCS Travel Orders  

Canceling Travel Orders  

Saving Travel Orders  

Deleting Travel Orders  

Viewing Travel Orders  

Modifying Travel Orders  

 

Type of Orders 
When creating TDY travel authorizations or travel orders, UTS requires the user to specify what 
type of orders are being created.  The type of travel order specified has a direct impact on the way 
program functions, and the computation of the travel entitlement.  Following, is a listing of the 
various types of TDY travel authorizations or orders that may be created and an explanation of the 
specific purpose: 

�� Normal - Use this option if creating a travel authorization or travel order for a regular TDY 
trip that involves one round trip.  

�� Blanket - Use this option when one travel order will be used repeatedly for a specified 
period of time and an unlimited number of trips. 
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Selecting Travel Orders 
When creating a request for advance or settlement, a previously approved travel order must first 
be selected or a new order must be created.   

 Selecting a Travel Order - Traveler View: 

1. Login to UTS as a Traveler or change the view to Traveler, if necessary. 

2. At the UTS Request Status screen, click the Fill out button, then select either the Request 
for Advance or Request for 1351-2 Settlement option.  The Select Travel Order screen 
appears.   

  

3. At this screen, all previously created travel orders for the traveler are listed.  Select an order 
by pointing and clicking on one of the listed orders. 

 Selecting a Travel Order - Proxy View: 

1. Login to UTS as a Proxy or change the view to Proxy, if necessary. 

2. At the UTS Request Status screen, click the Fill out button, then select either the Request 
for Advance or Request for 1351-2 Settlement option.  The Select Traveler and Travel 
Order screen appears.   
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3. At this screen, the Travelers table lists all of the Travelers the Proxy can perform services 
for.  Click the desired Traveler’s name.  The Travel Orders table lists any travel orders 
already existing for the selected Traveler.  Select an order by pointing and clicking on one of 
the listed orders. 

 Selecting a Travel Order - Authorizing Official View: 

1. Login to UTS as an Authorizing Official or change the view to AO, if necessary. 

2. At the UTS Requests Requiring Action screen, click the Orders button.  The Select 
Traveler and Travel Order screen appears.   

  

3. At this screen, the Travelers table lists all of the Travelers the AO can perform services for.  
Point and click on the desired Traveler’s name.  The Travel Orders table lists any travel 
orders already existing for the selected Traveler.  Select an order by pointing and clicking on 
one of the listed orders. 
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See Also  
Viewing Travel Orders  

Modifying Travel Orders  

Canceling Travel Orders  

Deleting Travel Orders  

 

Canceling Travel Orders 
There are two ways to cancel a Travel Order that has not been saved: 

1. Click the Cancel button at the bottom of the TDY or MILPCS Travel Order screen. 

2. Click on the File menu at the top of the TDY or MILPCS Travel Order screen, then click 
on the Cancel all changes option. 

  

After clicking on cancel, by using either method, a pop-up appears asking if you wish to cancel the 
screen.  Click Yes if you wish to cancel without saving any of the input. 

Note:  If you wish to get rid of a travel order that has previously been saved, it must be deleted. 

See Also 
Deleting Travel Orders  

 

Saving Travel Orders 
There are two ways to save a Travel Order: 

1. Click the Save button at the bottom of the TDY or MILPCS Travel Order screen. 

2. Click on the File menu at the top of the TDY or MILPCS Travel Order screen, then click 
one of the following options:  
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�� Save and Return to Previous Screen - Use this option if you have finished creating the order 
and wish to exit UTS or perform another task. 

�� Save and Continue editing - Use this option if you are not finished creating the order, but 
would like to save what is completed so far. 

 

Deleting Travel Orders 
Note:  Travel Order records may be deleted by Authorizing Officials only. 

 Complete the following steps to Delete a Travel Order 

1. Login to UTS in the Authorizing Official mode or change the view to AO if necessary. 

2. At the UTS Request Requiring Action screen, click the Orders button.  The Select 
Traveler and Travel Order screen appears. 

  

3. At this screen, the Travelers table lists all of the Travelers the AO can perform services for.  
Click the desired Traveler’s name.  The Travel Orders table lists any travel orders already 
existing for the selected Traveler.  Select an order by pointing and clicking on one of the 
listed orders. 

4. After selecting an order, click the Modify/View button. 
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5. Depending on the type of order selected, either the TDY or MILPCS Travel Order screen 
appears next.   

  

6. At this screen, click the Delete Travel Request button, or click on the File menu and select the 
Delete this Travel Order option. 

7. A pop-up appears asking if you want to delete this travel order.  Click on the Yes button. 

 

Viewing Travel Orders 
The steps required for viewing a Travel Order record depend on the View Mode being used. 

 Viewing Travel Orders - Traveler or Proxy View Mode: 

Note:  While using the Traveler view, an order may be viewed while creating a Request for 
Advance or Settlement, or when viewing the Travel History. 

1. Select the desired Travel Order to be viewed by following the procedures explained in the 
“Selecting Travel Orders” help topic. 

2. After selecting an order, click the Create Settlement for Selected Travel Order button.  The 
Request for Advance or Settlement screen appears next.   

3. At the Request for Advance or Settlement screen, click the View Other Info menu at the 
top of the screen and then click the Travel Order option.  The Travel Order screen appears. 
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4. When finished viewing the order, click the Return button or the X in the top right corner of 
the TDY or MILPCS Travel Order screen to return to the Request for Advance or 
Settlement screen.   

5. At the Request for Advance or Settlement screen continue entering the request information, 
or click the X in the top right corner and click on Yes to return to the UTS Request Status 
screen.  

 Viewing Travel Orders - Authorizing Official View: 

1. Login to UTS in the Authorizing Official mode or change the view to AO if necessary. 

2. Select the desired Travel Order to be viewed by following the procedures explained in the 
“Selecting Travel Orders” help topic. 

  

3. After selecting an order, click the Modify/View button at the bottom of the Select Traveler 
and Travel Order screen.  The TDY or MILPCS Travel Order screen appears depending 
on the type of order selected. 

4. When finished viewing the order, click the Cancel button or the X in the top right corner of 
the TDY or MILPCS Travel Order screen and click on Yes to cancel the screen. 

5. At the Select Traveler and Travel Order screen, click on the Return button to return to the 
UTS Requests Requiring Action screen. 

See Also 
Travel History  
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Modifying Travel Orders 
Note: Travel Orders may only be modified by an Authorizing Official.   

 Complete the following steps to Modify a Travel Order: 

1. Login to UTS in the Authorizing Official mode or change the view to AO if necessary. 

2. At the UTS Requests Requiring Action screen, click the Orders button and the Select 
Traveler and Travel Order screen appears.   

  

3. At this screen, the Travelers table lists all of the Travelers the AO can perform services for.  
Point and click on the desired Traveler’s name.  The Travel Orders table lists any travel 
orders already existing for the selected Traveler.  Select an order by pointing and clicking on 
one of the listed orders. 
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4. After selecting an order, click the Modify/View button. 

5. At the TDY or MILPCS Travel Order screen, press Enter or Tab to advance through the 
input fields, or point to the desired field and click the left mouse button.   

6. Type the required change or select a new option as needed. 

7. When finished modifying the order, click the Save button. 

8. At the Select Traveler and Travel Order screen, click on the Return button to return to the 
UTS Requests Requiring Action screen. 

 

TDY Travel Orders 
Creating TDY Travel Orders 

A request for advance or settlement of TDY travel allowances cannot be processed without one of 
the following: 

�� An approved TDY Travel Authorization in the database  

�� A TDY Travel Order record created by either a Traveler, Agency Proxy, or Signature 
Proxy 

 Creating a TDY Travel Order - Traveler View: 

1. Login to UTS in the Traveler mode or change the view to Traveler if necessary. 

2. At the UTS Request Status screen, click on the Fill out button or click on the File menu and 
then point to the Create option.  A drop down menu appears listing a variety of travel 
actions. 

  

3. Click on Request for 1351-2 Settlement and the Select Travel Order screen appears. 
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4. At this screen, click on the Create Settlement for NEW Travel Order button. 

5. After clicking the Create Settlement for NEW Travel Order button, a pop-up appears 
requiring the user to select TDY or Military PCS.  Click on TDY. 

6. After clicking on TDY, the TDY Travel Order screen appears. 

  

7. Refer to the various links listed below under the heading “See Also” for detailed instructions 
on completing the TDY Travel Order screen. 

 Creating a TDY Travel Order - Proxy View 

1. Login to UTS in the Proxy mode or change the view to Proxy if necessary. 

2. At the UTS Request Status screen, click on the Fill out button or on the File menu and then 
point to the Create option.  A drop down menu appears listing a variety of travel actions.   
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3. Click on Request for 1351-2 Settlement and the Select Traveler and Travel Order screen 
appears. 

  

4. At this screen, the Travelers table lists all of the Travelers the Proxy can perform services 
for.  Click the desired Traveler’s name, then click the Create Settlement for NEW Travel 
Order button.   

5. After clicking the Create Settlement for NEW Travel Order button, a pop-up appears 
requiring the user to select TDY or Military PCS.  Click on TDY. 

6. After clicking on TDY, the TDY Travel Order screen appears.   

7. Refer to the various links listed below under the heading “See Also for detailed instructions 
on completing the TDY Travel Order screen. 

See Also 
TDY Order - Top Section  

Entering Accounting  

Entering Remarks  
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Canceling Travel Orders  

Saving Travel Orders  

Deleting Travel Orders  

Viewing Travel Orders  

Modifying Travel Orders  

 

TDY Order - Top Section 
The Top Section of the TDY Travel Order screen is used to establish the following details: 

�� Travel Order Number 

�� Type of Travel Order 

�� Purpose of the Trip 

�� Funding Organization 

�� Period Covered 

�� Issue Date of Order 

�� Authorized Mode of Transportation 

�� Special Authorizations 

�� Accounting Appropriation 

�� Special Remarks 

  

 Completing the Top Section of the TDY Travel Order screen: 

Tip:  Press Enter or Tab to advance through the fields or point to the desired field and click the 
left mouse button. 

�� TONO - Type the travel order number for the order being created.  If Coast Guard funds 
are being used, the travel order number must comply with the following requirements: 

1. The first two digits must be (11) if the order is a Normal TDY order. 

2. The first two digits must be (13) if the order is a Blanket TDY order. 

3. The order number must be (16) characters. 

4. The last three digits must be (000) zeros. 
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�� Type of Order - At this field, a drop down listing appears.  Click the Up/Down arrows on 
the right side of the listing until the desired travel order type appears.  Click on the correct 
type to populate the Type of Order field. 

�� Purpose - At this field, a drop down listing appears.  Click the Up/Down arrows on the right 
side of the listing until the desired purpose of the trip type appears.  Click on the correct 
purpose to populate the Purpose field. 

�� Funds Used - At this field, a drop down listing appears.  Click the Up/Down arrows on the 
right side of the listing until the name of the organization funding the travel appears.  Click on 
the correct organization to populate the Funds Used field. 

�� Covered - Enter the anticipated beginning and ending dates of the trip at the From/To fields.  

�� Issue Date - At this field, enter the date that the travel order was issued in MMDDYY format. 

�� Mode of Travel - At this section, point to the requested mode of travel and click the left 
mouse button.  A check mark appears indicating a selection.  Click on the item again to de-
select, if necessary.  At the Privately Owned Vehicle field, a drop down listing appears.  
Point and click on the desired type to make a selection. 

�� Special Authorizations - On the right side of the Top Section, a list of special authorizations 
appear.  Point and click on any of these applicable items.  Click on the item again to de-
select, if necessary. 

See Also 
Entering Accounting  

Entering Remarks  

Canceling Travel Orders  

Saving Travel Orders  

Deleting Travel Orders  

Viewing Travel Orders  

Modifying Travel Orders  

 

MILPCS Travel Orders(Note: UTS is not used for PCS at this time) 
Creating MILPCS Travel Orders 

A request for advance or settlement of Military PCS travel allowances cannot be processed 
without one of the following: 

�� An approved MILPCS Travel Authorization in the database  

�� A MILPCS Travel Order record created by either a Traveler, Agency Proxy, or Signature 
Proxy 

 Creating a MILPCS Travel Order - Traveler View: 

1. Login to UTS in the Traveler mode or change the view to Traveler if necessary. 

2. At the UTS Request Status screen, click on the Fill out button or click on the File menu and 
then point to the Create option.  A drop down menu appears listing a variety of travel 
actions. 
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3. Click on Request for 1351-2 Settlement and the Select Travel Order screen appears. 

  

4. At this screen, click on the Create Settlement for NEW Travel Order button. 

5. After clicking the Create Settlement for NEW Travel Order button, a pop-up appears 
requiring the user to select TDY or Military PCS.  Click on Military PCS. 

6. After clicking on Military PCS, the MILPCS Travel Order screen appears. 
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Travel Advances (Note: UTS is not used for PCS at this time)

About Travel Advances 
The UTS program gives you the capability to create a Request for Advance for both TDY and 
MILPCS travel using a pre-determined amount.  The user must manually calculate the entitlement 
or use the amount requested by the traveler when creating a Request for Advance with UTS. 

A Request for Advance cannot be processed unless there is an approved Travel Authorization 
or Travel Order record in the database. 

See Also 
Creating Request for Advance  

Entering Request for Advance  

Deleting Request for Advance  

Canceling Request for Advance  

Releasing Request for Advance  

Saving Request for Advance  

Viewing Request for Advance  

Modifying Request for Advance  

Printing Request for Advance  

 

Creating Request for Advance 
When there is an approved Travel Authorization or Travel Order record in the database, a 
Request for Advance may be created by either a Traveler, Agency Proxy, or a Signature 
Proxy. 

The steps involved in creating an Advance Request depend on which of the following View modes 
is used: 

�� Traveler 
�� Proxy 
�� Signature Proxy 

 Creating Request for Advance - Traveler View: 

1. Login to UTS as a Traveler or change the view to Traveler if necessary. 

2. At the UTS Request Status screen, click on the Fill out button or click on the File menu and 
then point to the Create option.  A drop down menu appears listing a variety of travel 
actions. 

 137

REtheridge
Note: UTS is not used for PCS at this time)



 

  

3. Click on Request for Advance and the Select Travel Order screen appears. 

4. At this screen point and click on an order displayed in the table and then click the Create 
Advance for Selected Order button.  If the correct order is not displayed, click on the 
Create Advance for New Travel Order button. 

5. After clicking the Create Advance for Selected Order button or creating a new order, the 
Request for TDY or MILPCS Advance screen appears. 

6. Complete the Request for Advance screen.  Refer to the links listed below under the heading 
“See Also” for additional instructions. 

 Creating Request for Advance - Proxy View: 

1. Login to UTS as a Proxy or change the view to Proxy if necessary. 

2. At the UTS Request Status screen, click on the Fill out button or click on the File menu and 
then point to the Create option.  A drop down menu appears listing a variety of travel 
actions. 

  

3. Click on the Request for Advance option and the Select the Traveler & Travel Order 
screen appears. 
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4. At this screen, the Travelers table lists all of the Travelers the Proxy can perform services 
for.  Click the desired Traveler’s name.  The Travel Orders table lists any travel orders 
already existing for the selected Traveler.   

5. At this screen, point and click on the correct order, if listed, and then click the Create 
Advance for Selected Order button.  If the correct order is not displayed, click on the 
Create Advance for New Travel Order button. 

6. After clicking the Create Advance for Selected Order button or creating a new order, the 
Request for TDY or MILPCS Advance screen appears. 

7. Complete the Request for Advance screen.  Refer to the links listed below under the heading 
“See Also for additional instructions. 

See Also 
Entering Request for Advance  

Deleting Request for Advance  

Canceling Request for Advance  

Releasing Request for Advance  

Saving Request for Advance  

Viewing Request for Advance  

Modifying Request for Advance  

Printing Request for Advance  
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Entering Request for Advance 
The Request for Advance screen is used to capture the specific details regarding the Advance. 

  

 Complete this screen by entering the following information: 

1. Amount - Click in this field, and then type the amount to be advanced to the traveler. 

2. Method of Payment - At this field, a listing of various payment methods appears.  Click on 
the desired method to make a selection. 

3. Accounting - If the accounting appropriations is not already present, click on the Modify 
Acctng button.  This brings up the Request Accounting screen.  Enter the correct 
appropriation into the appropriate fields.   

  

4. Accounting Remarks - Notice the Remarks box appearing directly below the Current 
Request Accounting Lines table.  This box is used to add remarks pertaining to the 
accounting appropriations for the current travel action.  Click inside the text box and type the 
desired remarks.  Click the Validate Accounting button when finished. 

5. Request Remarks - Back at the Request for Advance screen, It may be necessary or 
beneficial to add remarks to the Advance Request.  Click the Remarks button to access the 
Advance Request Remarks screen.  Type the desired remarks and click the Return button 
when finished. 
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6. When finished entering the required information at the Request Accounting screen, click the 
Save button.   

7. Release the Request for Advance to the AO for approval when ready.  Refer to the link 
“Releasing Request for Advance listed below under the “See Also” heading. 

See Also 
Entering Accounting  

Entering Remarks  

Deleting Request for Advance  

Canceling Request for Advance  

Releasing Request for Advance  

Saving Request for Advance  

Viewing Request for Advance  

Modifying Request for Advance  

Printing Request for Advance  

 

Deleting Request for Advance 
A Request for Advance that has not been released to the AO may be deleted by the Traveler or the 
Proxy. 

Note:  The AO cannot delete a Request for Advance.  If the request has already been forwarded to 
the AO, but should be deleted, the AO must return the request to the Traveler. 

 Deleting Request for Advance Traveler/Proxy view: 

1. Login to UTS and change the view to Traveler or Proxy, if necessary. 

  

2. At the UTS Request Status screen, select the Request for Advance you wish to delete by 
pointing and clicking on the desired item displayed in the Claims List. 

3. After selecting a Request for Advance, use one the following methods: 
�� Method 1: - Click the Delete button at the bottom of the screen and then click on Yes at the 

Are You Sure pop-up. 
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�� Method 2: - Click the File menu, select the Delete option from the drop down menu, and click 
on Yes at the Are You Sure pop-up. 

�� Method 3: - Click the Modify or View button at the bottom of the screen to access the 
Advance Request screen.  At this screen, click the Delete Request button then click on Yes at 
the Deleting this Request pop-up. 

�� Method 4: - Click the Modify or View button at the bottom of the screen to access the 
Advance Request screen.  At this screen, click the File menu and then click on the Delete 
Request option.  Click on Yes at the Deleting this Request pop-up to complete the process. 

Tip:  A Request for Advance created by a Proxy can only be deleted by the Traveler if the 
Traveler takes control of the request. 

 

Canceling Request for Advance 
If the initial input or current changes to a Request for Advance have not been saved, there are two 
ways to cancel a Request for Advance, or the changes being made: 

1. Click the Cancel button at the bottom of the Request for Advance screen.  A pop-up appears 
asking if you wish to cancel this screen.  Click on Yes. 

2. Click on the File menu at the top of the Request for Advance  screen, then click on the 
Cancel Request Changes & Return option.  A pop-up appears asking if you wish to cancel 
this screen.  Click on Yes. 

  

 

Releasing Request for Advance 
A Request for Advance can be released to the AO by either the Traveler or the Signature Proxy 
designated by the Traveler. 

 Use one of the following methods to release a Request for Advance: 

�� Method 1: - Click the Send to AO button at the bottom of the Request for Advance screen. 

  

�� Method 2: - Click on the File menu at the top of the Request for Advance screen, then click 
on the Send to AO option. 

�� Method 3: - Point and click on the desired Request for Advance listed in the Claims List on 
the UTS Request Status screen, then click the Send to Auth button. 
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�� Method 4: - Point and click on the desired Request for Advance listed in the Claims List on 
the UTS Request Status screen, then click on the File menu.  From the File drop down 
menu, select Send to Authorizing Official. 

1. After using one of the various Release methods, the Select Authorizing Official screen 
appears requiring the user to select an AO.   

  

2. At this screen, the name of the traveler’s unit will be displayed at the Site field and the 
designated Authorizing Officials are listed below.  If the correct AO is listed, click on the 
desired name, then click on the Transmit to AO button.  The user can also click on the 
Change Site button to select a different unit and see a list of Authorizing Officials for the 
newly selected unit.   

3. After selecting an AO, a pop-up appears requiring the entry of a Confirmation Password.  
This is the Secondary Password that was created when the user’s Personal Profile was 
created.  Type the confirmation password and click the Done button. 

4. After entering the confirmation password, UTS forwards the transaction to the AO and 
returns to the UTS Request Status screen.  
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Saving Request for Advance 
There are two ways to save a Request for Advance: 

 Saving a Request for Advance: 

�� Method 1: - Click the Save button at the bottom of the Request for Advance screen. 

  

�� Method 2: - Click on the File menu at the top of the Request for Advance screen, then click 
on Save Request Changes & Return. 

 

Viewing Request for Advance 
On occasion, it may be necessary to View a Request for Advance that has been created and saved.  
This can be accomplished using two different methods. 

 Viewing a Request for Advance: 

1. Login to UTS.   

2. At the UTS Request Status or UTS Request Requiring Action screen, point and click on 
the desired Request for Advance displayed in the Claims List.  After selecting a request, use 
one of the following methods to view the request. 

  
�� Method 1 - Click the File menu and then select the Modify or View option.   
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�� Method 2 - Click the Modify or View button at the bottom of the screen. 

Tip:  When finished Viewing the request, click the Cancel Changes button, the Save button, or 
the X in the top right hand corner of the Request for Advance screen, and answer Yes. 

 

Modifying Request for Advance 
On occasion, it may be necessary to Modify a Request for Advance that has been created and 
saved.  This can be accomplished using two different methods. 

 Modifying a Request for Advance: 

1. Login to UTS.  

2. At the UTS Request Status or UTS Request Requiring Action screen, point and click on 
the desired Request for Advance displayed in the Claims List.  After selecting a request, use 
one of the following methods to make modifications: 

  

�� Method 1: - Click the File menu and then select the Modify or View option.  

�� Method 2: - Click the Modify or View button at the bottom of the screen. 

3. At the Request for Advance screen, press Enter or Tab to move through the input fields, or 
point to the desired field and click the left mouse button.  Type the required change or select 
a new option as needed. 
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4. The Accounting Appropriation can be modified by clicking on the Modify Acctng button.  
When the Request Accounting screen appears, enter a new appropriation, modify the 
previously entered appropriation, or modify the accounting remarks, if necessary.  Click the 
Validate Accounting button at the bottom of the Request Accounting screen when finished 
to save the changes and return to the previous screen. 

5. The Request for Advance Remarks can be modified by clicking on the Remarks button, then 
typing the desired changes.  Click on the Return button at the bottom of Request Remarks 
screen when finished to save the changes and return to the previous screen. 

6. After making the desired changes, click the Save button at the bottom of the Request for 
Advance screen. 

See Also 
Entering Accounting 

Entering Remarks 

Saving Request for Advance 

 

Printing Request for Advance 
There are two ways to print a Request for Advance: 

1. Click the Print Request button at the bottom of the Request for Advance screen. 

2. Click on the File menu at the top of the Request for Advance screen, then click on the Print 
Request option. 

  



 

Travel Settlements 
About Travel Settlements 

�� The UTS program provides the user with the capability to create a Request for Settlement for 
TDY, Local and MILPCS travel.  Settlement claims are used to calculate the allowances the 
Traveler is entitled to for performing the ordered travel.  Upon completion of the travel, 
settlements are entered into UTS by either the Traveler,   Proxy, or Signature Proxy.   

�� Once approved by the Authorizing Official, settlement claims are transferred to IATS for 
computation. 

�� A Request for Settlement cannot be created unless there is an approved Travel Authorization 
or Travel Order record in the database. 

 

Creating Request for 1351-2 Settlement 
When there is an approved Travel Authorization or Travel Order record in the database, a 
Request for 1351-2 Settlement may be created by either a Traveler, Agency Proxy, or a 
Signature Proxy. 

The steps involved in creating a Request for 1351-2 Settlement depend on which of the following 
View modes is used: 

�� Traveler 
�� Proxy 
�� Signature Proxy 

 Creating Request for 1351-2 Settlement - Traveler View 

1. Login to UTS as a Traveler or change the view to Traveler if necessary. 

2. At the UTS Request Status screen, there are two ways to access the Request for TDY or 
MILPCS Travel Settlement screen: 

�� Method 1:  Click on the Fill out button.  A drop down menu appears listing a variety of travel 
actions.  Click on Request for 1351-2 Settlement and the Select Traveler Order screen 
appears. 

�� Method 2:  Click on the File menu and then point on the Create option.  A drop down menu 
appears listing a variety of travel actions.  Click on Request for 1351-2 Settlement and the 
Select Travel Order screen appears. 
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3. At this screen point and click on an order displayed in the table and then click the Create 
Settlement for Selected Order button.  If the correct order is not displayed, click on the 
Create Settlement for New Travel Order button. 

4. After clicking the Create Settlement for Selected Order button or creating a new order, the 
Request for TDY or MILPCS Settlement screen appears. 

5. Complete the Request for Settlement screen.  Refer to the links listed below under the 
heading “See Also for additional instructions. 

 Creating Request for 1351-2 Settlement - Proxy View 

1. Login to UTS as a Proxy or change the view to Proxy if necessary. 

2. At the UTS Request Status screen, there are two ways to access the Request for TDY or 
MILPCS Travel Settlement screen: 

�� Method 1: - Click on the Fill out button.  A drop down menu appears listing a variety of travel 
actions.  Click on Request for 1351-2 Settlement and the Select Traveler and Travel Order 
screen appears. 

�� Method 2: - Click on the File menu and then point on the Create option.  A drop down menu 
appears listing a variety of travel actions.  Click on Request for 1351-2 Settlement and the 
Select Traveler and Travel Order screen appears. 
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3. At this screen, the Travelers table lists all of the Travelers the Proxy can perform services 
for.  Click the desired Traveler’s name and any travel authorizations or travel orders that 
have already been created will appear in the Travel Orders table.   

4. Point and click on an order displayed in the Travel Orders table and then click the Create 
Settlement for Selected Order button.  If the correct order is not displayed, click on the 
Create Settlement for New Travel Order button. 

5. After clicking the Create Settlement for Selected Order button or creating a new order, the 
Request for TDY or MILPCS Settlement screen appears. 

6. Complete the Request for Settlement screen.  Refer to the links listed below under the 
heading “See Also” for additional instructions. 

See Also 
Entering TDY Settlements  

Entering MILPCS Settlements  

Request for 1351-2 Settlement Itinerary  

Reason for Stop  

Method of Reimbursement  

Entering Reimbursable Expenses  

 

Request for Settlement - Itinerary 
The Itinerary section is used to record the details regarding the trip.   

Note:  If a Travel Authorization was previously created and approved by the AO, the itinerary 
previously entered on the authorization is automatically copied to the Itinerary section.  The user 
should review this default itinerary and make any necessary changes, if applicable.   
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 Complete the Itinerary by entering the following information: 

  
�� Depart Date - The departure date on the first line of the itinerary automatically defaults from 

the beginning date entered at the Period Covered field in the Top section of the Travel Order.  
Press Enter to continue or type a different date if necessary. 

�� Depart Location - At this field, the Location Lookup screen automatically appears. 

  

At the State/Country field, type the first letter of the state or country then click the Up/Down 
arrows until the desired name is displayed.  Click on the name to select.   

At the City field, type the first two letters of the city name.  This displays a listing of city names, 
for the previously selected state or country, beginning with those letters.  Click on the desired city 
name to select. 
�� Transportation - At this field, a drop down listing of various transportation modes appears.  

Click the Up/Down arrows until the desired mode is displayed.  Click on the correct mode to 
select. 

�� Group ? - When Group Travel Rules has been activated in the Top section of the Travel 
Order, and the transportation mode is PP, CP, CV, GP, GV, TP, TV, AF, CS, the user must 
specify whether Group Travel rules apply.  If Group Travel rules apply to the leg, click this box. 
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Note:  When Group Travel rules are selected, the computation program will not calculate any 
per diem for the Group Travel leg. 
�� Arrive Date - The date at the previous Departure Date field defaults to the Arrival Date field.  

Press Enter to accept this date or type a new date if necessary. 
�� Arrive Location - Use the same method explained at the Depart Location field to complete 

the Arrive Location field.  This should be the location where the traveler stops to perform 
official duty. 

�� Reason for Stop - At this field, a drop down listing of various reasons for stopping appears.  
The default value for this field is TD - Temporary Duty.  Press Enter if this is correct.  If not, 
click the Up/Down arrows until the desired reason is displayed.  Click on the correct reason to 
select. 

�� Method of Reimbursement - At this field, a drop down listing of various per diem computation 
methods appears. The default value for this field is LDP - Lodgings Plus.  Press Enter if this is 
correct.  If not, click the Up/Down arrows until the desired method is displayed.  Click on the 
correct method to select. 

�� Quarters - At this field, a drop down listing of various lodging types appears.  The default 
value for this field is CQ - Commercial Lodging.  Press Enter if this is correct.  If not, click 
the Up/Down arrows until the desired type is displayed.  Click on the correct type to select. 

�� Messing - At this field, a drop down listing of various meal types appears.  The default value 
for this field is CM - Commercial Meals.  Press Enter if this is correct.  If not, click the 
Up/Down arrows until the desired type is displayed.  Click on the correct type to select. 

�� Lodging Cost - At this field, enter the daily lodging cost for the location where the traveler 
remained overnight.   

�� POC Miles - At this field, enter the official distance for the ordered travel if a privately owned 
vehicle was used.   

Note:  Use the procedures previously explained to complete the return travel leg or additional 
travel legs for the itinerary.  When finished with the itinerary, complete the Reimbursable 
Expenses section, if necessary, or save the claim and release it to the Authorizing Official for 
approval. 

See Also 
Entering Dates  

Reason for Stop 

Inserting Itinerary Legs 

Deleting Itinerary Legs 

Request for Settlement - Reimb. Expenses 

Exceptions  

Occasional Expenses 

Deleting Request for 1351-2 Settlement  

Canceling Request for 1351-2 Settlement  

Saving Request for 1351-2 Settlement  

Printing Request for 1351-2 Settlement  

Releasing Request for 1351-2 Settlement  

 

 151



 

Reason for Stop 
When completing an Itinerary, a Reason for Stop code is required on each arrival line.  A table 
appears at the Reason for Stop field displaying a variety of codes that may be used. 

  

The purpose of the code is to determine what action must be taken by the travel computation 
system and what allowances are applicable.  A listing of the various Reason for Stop codes and 
an explanation of their purpose is provided below: 

�� AT - Awaiting Transportation - This is used when the traveler is simply stopping at a location 
to change the mode of transportation. 

�� TD - Temporary Duty - This is the default value at this field since it is the most common 
reason a traveler stops.  Use this code when the point the traveler arrived at is the TDY point. 

�� LV - Leave - Use this code when the traveler has stopped at a location for the purpose of taking 
leave.  This code will cause the computation system to terminate per diem during the leave 
period. 

�� MC - Mission Complete - Use this code when the trip is finished and the traveler has arrived at 
the Permanent Duty Station (PDS). 

�� AD - Authorized Delay - Use this code when the traveler has made an official stop and 
remained overnight while enroute to an official duty point.   

�� VR - Voluntary Return - Use this code when a traveler has voluntarily returned to the PDS 
during a TDY trip.  This commonly occurs when travelers are on lengthy TDY trips and there is 
a holiday weekend involved.  Using this code causes the computation system to perform a cost 
comparison of what it would have cost the government had the traveler remained at the TDY 
location.  This cost is then compared to the expenses the traveler incurred for performing the 
VR travel.  The traveler is reimbursed these travel expenses up to what it would have cost the 
government to remain at the TDY location. 

Note:  The following Reason For Stop Codes apply to MILPCS travel: 

�� DV - Drop Off Vehicle At Vehicle Port - Use this code when the purpose of the stop is to drop 
off a Privately Owned Vehicle (POV) at a vehicle port facility for overseas shipment. 

�� PV - Pick Up Vehicle At Vehicle Port - Use this code when the purpose of the stop is to pick 
up a POV from a vehicle port facility for movement to a new PDS. 

�� ES - Enroute Stopover - Use this code when the traveler has made an official stop and 
remained overnight while enroute to an official duty point.  (This code may also be used with 
TDY travel). 

�� DP Drop Off Passengers - Use this code when the purpose of the stop is to drop off passengers 
at a passenger facility.  This ordinarily occurs when delivering a POV to a vehicle port facility 
for overseas shipment in conjunction with a PCS and passengers are dropped off first. 
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�� PP - Pick Up Passengers - Use this code when the purpose of the stop is to pick up passengers 
at a passenger facility.  This ordinarily occurs after a POV is picked up from a vehicle port 
facility in conjunction with a PCS and the passengers are picked up afterwards. 

�� DL - Designated Location - Use this code when the stop location is a point designated as a delay point 
for dependents pending orders for overseas PCS travel, or when overseas travel is denied.  This is also 
the appropriate code to identify a location as Consecutive Overseas Tour (COT) leave point. 

�� HP - Change of Home Port - Use this code when the purpose of the stop is deliver a POV at the new 
Home Port and the traveler returns to the old Home Port pending enroute travel. 

 

Method of Reimbursement 
A Method of Reimbursement code is used to determine what per diem entitlement rule is 
applicable for the trip.  When completing an Itinerary, a Method of Reimbursement code is 
required on each arrival line where the reason for stop code is TD, AD, or ES.  A table appears at 
the Method of Reimbursement field displaying a variety of codes that may be used.  Following, is 
a list of the Method of Reimbursement codes listed by UTS and an explanation of their meanings: 

�� LDP - Lodgings Plus.  This is the most common per diem reimbursement method.  Under the 
lodgings plus rules, the traveler is entitled to the actual amount spent for lodging, not to exceed 
the maximum rate established for the locality, plus a flat amount for meals and incidental 
expenses (M&IE), that has also been pre-determined.  For example; under the Lodgings Plus 
rules, the maximum locality rate for Washington DC is $115 for lodging and $46 for M&IE.  If 
the traveler actually pays $110 for lodging, the entitlement will be $161 for the day. 

�� FD - Field Duty. This is the method that should be used when the traveler is performing 
temporary duty under field conditions.  Under this reimbursement method, no per diem is 
payable.  This prohibition begins at 0001 on the day after the field duty begins and terminates at 
2400 on the day prior to the day the field duty ends. 

�� SD - Sea Duty.  This is the method that should be used by all Coast Guard members when 
performing temporary duty on-board a US Government Vessel.  Under this reimbursement 
method, no per diem is payable.  This prohibition begins at 0001 on the day after the traveler 
arrives on-board and terminates at 2400 on the day prior to the day the traveler departs. 

�� LTT - Long Term Training.  This reimbursement method applies to civilian employees of the 
federal government only. Under this reimbursement method, the employee is entitled to 55% of 
the maximum rate established for the locality.  There are two criteria for this entitlement rule.  
The first criteria is that the purpose of the TDY is for training and is for a period of more than 
30 days.  The second criteria is that the purpose for the TDY is any reason and is for a period of 
more than 180 days.   

�� AE - Actual Expense.  This is the method that should be used when it has been determined that 
the standard locality per diem rate will not adequately cover the expenses, and reimbursement of 
Actual Expenses for both lodging and M&IE is being requested or approved.  Under this 
method, the standard locality per diem rate is increased by 150%. 

Tip:  When AE is selected as the Method of Reimbursement, the user must click on the 
Exceptions button after completing the itinerary and then enter the amounts spent for M&IE at the 
Daily Exceptions screen. 
�� AELP - Actual Expense Lodgings Plus.  This is the method that should be used when it has 

been determined that the standard locality per diem rate will not adequately cover the expenses 
for lodging, and reimbursement of Actual Expenses for lodging only is being requested or 
approved.  Under this method, the standard locality per diem rate, for lodging only, is increased 
by 150%.  The M&IE is reimbursed using the standard flat rate established for the locality. 
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�� NPD - No Per Diem.  This is the method that should be used when the traveler is not entitled to 
per diem while performing official duty travel.  Some examples of travel situations when this 
rule may apply are Auxiliarist, Emergency Leave, and Medical Patient travel. 

�� INP - Inpatient Hospital.  This is the method that should be used when the traveler has been 
admitted to a hospital as an inpatient.  Under this reimbursement method, no per diem is 
payable.  This prohibition begins at 0001 on the day after the patient is admitted and terminates 
at 2400 on the day prior to the day the patient is discharged. 

�� REH Rehabilitation Center.  This is the method that should be used when the traveler has 
been admitted to a Rehabilitation Center as an inpatient.  Under this reimbursement method, no 
per diem is payable.  This prohibition begins at 0001 on the day after the patient is admitted 
and terminates at 2400 on the day prior to the day the patient is discharged. 

�� AF - Alaskan Ferry.  This is the method that should be used when the traveler has boarded the 
Alaska Marine Highway System, a.k.a., the Alaskan Ferry.  While on board this ferry, a per 
diem (M&IE) equal to the highest CONUS M&IE to cover meal and incidental expenses is 
payable for each full day.  Per diem is payable for the day of arrival (embarkation) on board the 
ferry at the rate applicable to the port of embarkation. 

�� BC Boot Camp.  This is the method that should be used by Reservists who are traveling from 
their home to their Basic Training location and return.  While at the training location, no per 
diem is payable.  This prohibition begins at 0001 on the day after the traveler arrives and 
terminates at 2400 on the day prior to the day the traveler departs. 

�� SAE - Super Actual Expense. This is the method that should be used when it has been 
determined that the standard locality per diem rate will not adequately cover the expenses, and 
reimbursement of Actual Expenses for both lodging and M&IE is being requested or 
approved.  Under this method, the standard locality per diem rate is increased by 300%.  This 
method is typically used for relief missions associated with disasters. 

Tip:  When SAE is selected as the Method of Reimbursement, the user must click on the 
Exceptions button after completing the itinerary and then enter the amounts spent for M&IE at the 
Daily Exceptions screen. 
�� SAEL - Super Actual Expense  & Lodgings Plus.  This is the method that should be used 

when it has been determined that the standard locality per diem rate will not adequately cover 
the expenses for lodging, and reimbursement of Actual Expenses for lodging only is being 
requested or approved.  Under this method, the standard locality per diem rate, for lodging only, 
is increased by 300%.  The M&IE is reimbursed using the standard flat rate established for the 
locality.  This method is typically used for relief missions associated with disasters. 

�� OB - On Board Ship.  This is the method that should be used by individuals who are not Coast 
Guard members and are performing temporary duty on-board a US Government Vessel.  Under 
this reimbursement method, civilian employees are entitled to a per diem rate of $2 per day 
when meals are provided at no cost.  If the employee is required to pay for meals, the 
government meal rate (currently $7.50) applies.  In addition, an additional $2 per day is 
reimbursed if the employee is required to pay for lodging while on-board.  This entitlement rule 
begins at 0001 on the day after the traveler arrives on-board and terminates at 2400 on the day 
prior to the day the traveler departs.  

�� FLT - Flat Per Diem.  This is the method that should be used when a special per diem rate, 
other than the rate specified for the locality, is directed in the travel orders. 
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Exceptions 

When an itinerary is entered, UTS prompts for the Daily Lodging Rate and the type of Quarters 
and Meals applicable at each stopover location.  These values are used as the default for the 
inclusive period involved.  On occasion, however, it may be necessary to deviate from the default 
values.  The lodging rate may have been different on a particular day or there may have been a 
deductible or government meal available that is not reflected in the default values.  If this situation 
occurs, the Exceptions function can be used for making adjustments on a daily basis. 

Note:  The Exceptions function must be used to capture the daily expenses for meals and 
incidental expenses if the traveler was authorized Actual Expenses for both lodging and meals at 
the official duty point. 

 Complete the following steps to process an Exception: 

1. The Exceptions button is located just below the itinerary on the Trip screen.  Click this 
button. 

  

2. After clicking on the Exceptions button, the Daily Exceptions screen appears. 

  

3. At this screen, adjustments can be made in the following areas for any listed day: 
�� Breakfast, Lunch, and Dinner Type 
�� Lodging Cost 
�� Breakfast, Lunch, Dinner and Incidental Expenses Cost 
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4. Point and click in the desired input field. 

5. If changing a meal type, a drop-down listing of various meal types appears.  Point and click 
on the new meal type to make a selection.   

6. If changing the lodging, meals, or incidental expenses cost, simply type the new dollar 
amount. 

7. When finished click the Save button. 

 

Occasional Expenses 
For certain types of travel situations, per diem is not payable.  If a traveler is required to use 
personal funds to purchase meals or lodging, however, these expenses are considered to be 
Occasional Expenses.  Reimbursement for the purchase of occasional expenses typically occur 
under one of the following circumstances: 
�� Round Trip performed in 12 Hours or Less 
�� Duty on board a Government Ship 
�� Field Conditions 

If one of these situations apply, the Occasional Expenses screen is used to capture the expenses 
for lodging and meals purchased by the traveler with personal funds. 

 Complete the following steps to make input for Occasional Expenses: 

1. The Occasional Expenses button is located just below the itinerary on the Trip screen.  Click 
this button. 

  

2. After clicking on this button, the Occasional Expenses screen appears. 
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3. At this screen, make the required input at each of the following fields: 
�� Date - Enter the date in which the occasional expense was incurred.   
�� Type of Expense - At this field, a drop down listing appears displaying various types of 

occasional expenses.  Point and click on the desired type. 
�� Amount - Type the dollar amount claimed for the occasional expense. 
�� Location - The location entered at this field should be the location where the official duty was 

performed or the traveler remained overnight.  At this field, click on the Choose City button 
and the Location Lookup screen appears. At the State/Country field, type the first letter of the 
state or country then click the Up/Down arrows until the desired name is displayed. Click on 
the name to select.  At the City field, type the first two letters of the city name.  This displays a 
listing of city names, for the previously selected state or country, beginning with those letters.  
Click on the desired city name to select. 

4. When finished with the input, click on the Save button. 

 

Request for Settlement - Reimb. Expenses 
The Reimbursable Expenses section is used to record the expenses incurred that were not 
associated with per diem.  Complete this section by entering the following information: 

  
�� Date - At this field, enter the date of the expense.  
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�� Nature of Expense - At this field, a drop down listing of various expense items appears.  Click 
the Up/Down arrows until the desired expense item is displayed.  If the user types the first letter 
of the description, UTS scrolls the listing until locating the first item beginning with this letter.  
The user may then use the Up/Down arrows to display the exact item.  Once the correct item is 
displayed, click on this item to select. 

�� Claimed - At this field, enter the amount claimed by the traveler. 

When finished entering the reimbursable expenses, take the required action to save the claim and 
forward it to the Authorizing Official for approval.  

See Also 
Inserting Expense 

Deleting Expense 

Exceptions 

Occasional Expenses 

Deleting Request for 1351-2 Settlement  

Canceling Request for1351-2 Settlement  

Saving Request for 1351-2 Settlement  

Printing Request for 1351-2 Settlement  

Releasing Request for Settlement  

 

Deleting Request for 1351-2 Settlement 
There are several ways to delete a Request for 1351-2 Settlement.  The method to use, however, 
depends on which input screen is currently displayed. 

 Deleting a Request for 1351-2 Settlement: 

  

1. Log into UTS and change the view to Traveler, or Proxy, if necessary.   

2. At the UTS Request Status screen, use one of the following methods: 
�� Method 1: - Point and click on the desired Settlement listed in the Claims List.  After selecting 

a claim, click the File menu and then select the Delete option.  A pop-up appears asking if you 
are sure you wish to delete this claim.  Click on Yes. 
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�� Method 2: - Point and click on the desired Settlement listed in the Claims List.  After selecting 
a claim, click the Delete button at the bottom of the screen.  A pop-up appears asking if you are 
sure you wish to delete this claim.  Click on Yes. 

�� Method 3: - Point and click on the desired Settlement listed in the Claims List.  After selecting 
a claim, click the Modify or View button.  The Request for TDY or MILPCS Settlement 
screen appears depending on the type of claim selected.  At this screen, click the Delete 
Request button.  A pop-up appears stating “Deleting this Request?.  Click on Yes. 

Tip:  The details for a particular Trip or Expense can also be deleted by clicking on the desired 
trip or expense appearing in the Trips Taken or Expenses Claimed box and then clicking on the 
Delete button.   

  
 

Modifying Request for 1351-2 Settlement 
On occasion, it may be necessary to Modify a Request for 1351-2 Settlement that has been created 
and saved.   

Regardless of whether the user is logged into UTS as a Traveler, Proxy, or Authorizing Official, 
the process for modifying a Request for 1351-2 Settlement is essentially the same.  The only 
difference is that the name of the initial screen is titled (UTS Request Status) for the Traveler 
and Proxy.  For the AO, this screen is titled (UTS Requests Requiring Action). 

 Use one of the following methods to Modify a Request for 1351-2 
Settlement: 

1. Login to UTS. 

2. At the UTS Request Status or UTS Request Requiring Action screen, there are two 
methods for accessing the Request for TDY or MILPCS Settlement screen. 

  
�� Method 1: - Point and click on the desired Settlement displayed in the Claims List.  After 

selecting a claim, click the File menu and then select the Modify or View option. 
�� Method 2: - Point and click on the desired Settlement displayed in the Claims List.  After 

selecting a claim, click the Modify or View button. 
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3. At the Request for Settlement screen, press Enter or Tab to advance through the input fields, 
or point to the desired field and click the left mouse button.  Type the required change or 
select a new option as needed. 

4. The Trip screen can also be modified be clicking on the desired trip or expense appearing in 
the Trips Taken or Expenses Claimed box and then clicking on the View/Modify button.   

  

Note:  Click the View/Modify button in the Trips Taken or Expenses Claimed section to 
modify the Itinerary, Exceptions, Occasional Expenses, or Reimbursable Expenses screens. 

5. After making the desired changes, click the Save button. 

See Also 
Request for Settlement - Itinerary 

Exceptions 

Occasional Expenses 

Request for Settlement - Reimb. Expenses 

Saving Request for 1351-2 Settlement  

 

Canceling Request for 1351-2 Settlement 
There are several ways to cancel the initial input or changes being made to a Request for 
Settlement.  The cancel function will only delete the current input, however.  If the request has 
been saved previously, the Delete Request for 1351-2 Settlement option must be used to 
completely remove the request. 

 Use one of the following methods to Cancel the input to a Request for 1351-2 Settlement: 
�� Method 1: - Click the Cancel button at the bottom of the Trip screen if you wish to cancel this 

screen and return to the previous screen.  A pop-up appears asking if you wish to cancel this 
screen.  Click on Yes.  This action will cancel the trip and return the user to the Request for 
Settlement screen. 

  
�� Method 2: - Click the File menu at the top of the Trip screen then click on the Cancel all 

Changes option.  A pop-up appears asking if you wish to cancel this screen.  Click on Yes.  
This action will cancel the trip and return the user to the Request for Settlement screen. 

�� Method 3: - Click the Cancel all Changes button at the bottom of the Exceptions or 
Occasional Expenses screen if you wish to cancel the input to one of these screens and return 
to the previous screen.  A pop-up appears asking if you wish to cancel this screen.  Click on 
Yes. 

 
�� Method 4: - Click on the File menu at the top of the Request for Settlement screen, then click 

on the Cancel all Request Changes & return option.  A pop-up appears asking if you wish to 
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cancel this screen.  Click on Yes.  This action actually cancels all of the input made to the 
settlement.   

  

See Also 
Deleting a Request for 1351-2 Settlement  

 

Releasing Request for 1351-2 Settlement 
There are several ways to release a Request for Settlement.  This process can be performed by 
either the Traveler or the Signature Proxy designated by the Traveler. 

 Use one of the following methods to release a Request for 1351-2 Settlement: 

1. Login to UTS.  Afterwards, change the view to Traveler or Proxy, if necessary. 
�� Method 1: - Click the Send to button at the bottom of the Request for Settlement screen and 

then click on Send to AO. 

  
�� Method 2: - Point and click on the desired Settlement listed in the Claims List on the UTS 

Request Status screen, then click the Send to Auth button. 

  
�� Method 3: - Click on the desired Settlement listed in the Claims List on the UTS Request 

Status screen, click on the File option, then click on the Send to Authorizing Official option. 

2. After using one of the (3) methods to release the settlement, the Select Authorizing Official 
screen appears requiring the user to select an AO.  
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3. At the Select Authorizing Official screen, the name of the traveler’s unit will be displayed at 
the Site field and the designated Authorizing Officials are listed below.  If the correct AO is 
listed click on the desired name, then click on the Transmit to AO button.  The user can also 
click on the Change Site button to select a different unit and see a list of Authorizing 
Officials for the newly selected unit.   

4. After selecting an AO, a pop-up appears requiring the entry of a Confirmation Password.  
This is the Secondary Password that was created when the user’s Personal Profile was 
created. 

5. After entering a confirmation password, UTS forwards the transaction to the AO and returns 
to the UTS Request Status screen.  

 

Printing Request for 1351-2 Settlement 
There are three ways to print a Request for 1351-2 Settlement: 

1. Click the Print Request button at the bottom of the Request for Settlement or Trip screens. 

2. Click on the Print Expense button at the Trips Taken or Expenses Claimed section of the 
Request for Settlement screen. 

3. Click on the File menu at the top of the Request for Settlement or Trips screens, then click 
on the Print Request option. 
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Saving Request for 1351-2 Settlement 
There are several ways to Save a Request for 1351-2 Settlement.  The method to use, however, 
depends on which input screen is currently displayed. 

 Use one of the following methods to Save a Request for 1351-2 
Settlement: 

�� Method 1: - Click the Save button at the bottom of the Request for Settlement screen. 

 
�� Method 2: - Click the File menu at the top of the Request for Settlement screen, then click on 

the Save Request Changes & return option. 

  
�� Method 3: - Click the Save button at the bottom of the Trips screen. 

  
�� Method 4: - Click the File menu at the top of the Trips screen, then click on one of the two 

Save options. 

  
�� Method 5: - Click the Save button at the bottom of the Exceptions or Occasional Expenses 

screens.  

 
 

Viewing Request for 1351-2 Settlement 
On occasion, it may be necessary to View a Request for 1351-2 Settlement that has been created 
and saved.   

Regardless of whether the user is logged into UTS as a Traveler, Proxy, or Authorizing Official, 
the process for viewing a Request for Settlement is essentially the same.  The only difference is 
that the name of the initial screen is titled (UTS Request Status) for the Traveler and Proxy.  For 
the AO, this screen is titled (UTS Requests Requiring Action). 
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 Use one of the following methods to View a Request for 1351-2 
Settlement: 

1. Login to UTS. 

2. At the UTS Request Status or UTS Requests Requiring Action screen, there are two ways 
to view the Request for TDY or MILPCS Settlement screen: 

�� Method 1: - Point and click on the Request for 1351-2 Settlement displayed in the Claims List.  
After selecting a claim, click the File menu and then select the Modify or View option.   

  
�� Method 2: - Point and click on the Request for 1351-2 Settlement displayed in the Claims List.  

After selecting a claim, click the Modify or View button. 

3. After using either method 1 or 2, the Request for TDY or MILPCS Settlement screen 
appears.   

  

4. At this screen, the user can view the input screens for a trip or expense by highlighting the 
desired item and clicking the View/Modify button. 

Note:  Click the View/Modify button in the Trips Taken or Expenses Claimed section to view 
the Itinerary, Exceptions, Occasional Expenses, or Reimbursable Expenses screens. 

5. When finished Viewing the request, click the Cancel Changes button, the Save button, or the 
X in the top right hand corner of the Request for Settlement screen, and answer Yes. 
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3. At the Request for MILPCS Settlement screen, click on the desired expense appearing in 
the Expenses Claimed box and then click on the Print Expense button.  

4. The Print Setup screen appears next.  At this screen, ensure that the PC is configured to print 
to the appropriate printer.  Click on the OK button when ready to print. 

 

TDY Settlements 
Entering TDY Request for Settlement 

The Request for TDY Settlement screen consists of two sections:   

  
�� Request - This section is used to gather the administrative information.   
�� Trips Taken - This section is used to gather the claim specific details.  

 Completing the Request section: 

1. Type of Settlement - At this field a listing of claim types appears.  Click on the desired type 
to make a selection. 

2. Type of Partial - At this field, a selection of various types of partial settlements can be made 
by clicking the buttons at the far right of the selection field.  If the claim is not a partial 
settlement, press Enter or click on the selection Not A Partial. 

3. Pay to Credit Card Co. - This feature is not operational at this time. 
4. Amt Previously Advanced - This field is used to specify the amount of the TDY funds 

advanced to the traveler. If the advance was recorded in UTS prior to the processing of the 
settlement, that amount is displayed.  Users may enter a higher amount if an additional 
amount was received and was not recorded in UTS.  Type the dollar amount of the advance 
received or a different amount, if necessary. 
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5. Accounting - Click on the Modify Acctng button to access the Request Accounting screen. 
6. Remarks - Click on the Remarks button to access the Settlement Request Remarks screen. 

 Completing the Trips Taken section: 

At the Trips Taken section, any trips previously entered for the selected travel order are listed.  
The user may add a new trip if desired or view, modify, print or delete a previously entered trip.   

The following links provide detailed instructions for performing the functions possible at the 
Trips Taken section. 

See Also 
Entering Accounting 

Entering Remarks 

Adding a Trip 

View or Modify a Trip  

Printing a Trip  

Deleting a Trip  

 

Adding a Trip 
The transaction that calculates the TDY travel entitlement is referred to as a Trip.  Normally, only 
one trip may be added to a Request for TDY Settlement.  If the travel order that directed the 
travel is a Blanket order, however, multiple trips may be added to a particular Request for TDY 
Settlement claim.   

 Complete the following steps to Add a Trip to a Request for TDY 
Settlement: 

1. Login to UTS.  Afterwards, change the view to Traveler, or Proxy, if necessary.  

2. Access the Request for TDY Settlement screen.  Refer to the topic “Creating Request for 
Settlement” if additional instructions are needed. 

  

3. At the Request for Settlement screen, click on the Itinerary button.  The Trip screen will 
appear.   

4. The Trip screen for a TDY settlement consists of three separate sections.   
�� Top - This section is also referred to as the Miscellaneous Questions section.  If the member 

was the owner or operator of the privately owned vehicle (POV), when one was used for the 
travel, then click on the Owner Operator of POV box.   
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At the Duration of TDY Travel field, a drop down listing appears displaying several choices 
representing the duration of the round trip.  Point and click on the correct choice for the duration 
of the trip.  
�� Itinerary - This section captures the details for the travel portion of the TDY settlement claim.  

Please refer the topic “Request for Settlement – Itinerary” by clicking on the “Itinerary” 
link under the heading “See Also”. 

�� Reimbursable Expenses - This section is used to capture any expenses that are not covered by 
per diem.  Please refer the topic “Request for Settlement - Reimb. Expenses” by clicking on 
the “Reimbursable Expenses” link under the heading “See Also”. 

5. After completing the Itinerary and Reimbursable Expenses sections, the user may need to 
access the Exceptions or Occasional Expenses screens to make changes or make addition 
input.  Click on the links for these topics under the heading “See Also”, for additional 
information. 

6. After completing the Trips screen, click on the Save button. 

See Also 
Itinerary  

Reimbursable Expenses  

Exceptions  

Occasional Expenses  

 

View or Modify a Trip 
After a trip has been added to a Request for TDY Settlement, the trip may be reviewed for 
accuracy or may be modified, if necessary.   

Note:  The Traveler or Proxy cannot modify a request that was released to the AO, unless the 
AO returns the request to the Traveler. 

 Complete the following steps to View or Modify a TDY Trip: 

1. Login to UTS.  Afterwards, change the view to Traveler, or Proxy, if necessary.  

2. Access the Request for TDY Settlement screen.  Refer to the topic “Modifying Request for 
Settlement” if additional instructions are needed. 

  

 173



 

3. At the Request for Settlement screen, click on the desired trip appearing in the Trips Taken 
box and then click on the View/Modify button.  The Trip screen appears.   

4. View or modify the input screens as desired.  If any changes were made, be sure to take the 
appropriate action to save the changes.   

 

Printing a Trip 
The details for a particular TDY trip may be printed by either the Traveler, Proxy, or 
Authorizing Official. 

 Complete the following steps to Print a TDY Trip: 

1. Login to UTS. 

2. Access the Request for TDY Settlement screen.  Refer to the topic “Modifying Request for 
Settlement” if additional instructions are needed. 

  

3. At the Request for TDY Settlement screen, click on the desired trip appearing in the Trips 
Taken box and then click on the Print Expense button.  

4. The Print Setup screen appears next.  At this screen, ensure that the PC is configured to print 
to the appropriate printer.  Click on the OK button when ready to print. 

 

Deleting a Trip 
After a trip has been added to a Request for TDY Settlement, the trip may be deleted, if necessary.   

Note:  The Traveler or Proxy cannot delete a trip associated with a request that was released to 
the AO, unless the AO returns the request to the Traveler. 

 Complete the following steps to Delete a TDY Trip: 

1. Login to UTS in the Traveler or Proxy mode.  Change the view to Traveler, or Proxy, if 
necessary.  

2. Access the Request for TDY Settlement screen.  Refer to the topic “Modifying Request for 
Settlement” if additional instructions are needed. 
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3. At the Request for Settlement screen, click on the desired trip appearing in the Trips Taken 
box and then click on the Delete button.  A pop-up appears asking if the entitlement should be 
deleted. 

  

4. Click on the Yes button.  After clicking the Yes button, the trip is no longer displayed in the 
Trips Taken box. 

5. Click on the Save button at the bottom of the Request for TDY Settlement screen to 
complete the process. 
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Supplemental Claims 
Entering Supplemental TDY Claims 

A Supplemental Claim must be processed when the original claim has been already been 
processed and exported to the computation system (IATS) to be computed and disbursed.  This 
procedure is necessary when an error was made on the original settlement or information was 
omitted.  When a supplemental claim is processed, the total entitlement is recalculated.  The 
difference is then either paid to or collected from the traveler. 

 Complete the following steps to process a Supplemental TDY Claim - 
Traveler View: 

1. Login to UTS as a Traveler or change the view to Traveler if necessary. 

2. At the UTS Request Status screen, there are two ways to access the Request for TDY 
Travel Settlement screen: 

�� Method 1: - Click on the Fill out button.  A drop down menu appears listing a variety of travel 
actions.  Click on Request for 1351-2 Settlement and the Select Traveler Order screen 
appears. 

�� Method 2: - Click on the File menu and then point on the Create option.  A drop down menu 
appears listing a variety of travel actions.  Click on Request for 1351-2 Settlement and the 
Select Travel Order screen appears. 

  

3. At this screen point and click on the desired order displayed in the table and then click the 
Create Settlement for Selected Order button.   

4. After clicking the Create Settlement for Selected Order button or creating a new order, the 
Request for TDY Settlement screen appears.  Notice that Supplemental is now displayed at 
the Type of Settlement field. 
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5. In the Trips Taken section, ensure that the correct trip is highlighted, then click the 
View/Modify button. 

6. The Trip screen appears displaying the itinerary originally entered. 

7. Make any required changes to the various sections of the Trip screen. 

8. When finished, save the claim and send it to the AO for approval. 

 Complete the following steps to process a Supplemental TDY Claim - 
Proxy View 

1. Login to UTS as a Proxy or change the view to Proxy if necessary. 

2. At the UTS Request Status screen, there are two ways to access the Request for TDY 
Travel Settlement screen: 

�� Method 1: - Click on the Fill out button.  A drop down menu appears listing a variety of travel 
actions.  Click on Request for 1351-2 Settlement and the Select Traveler and Travel Order 
screen appears. 

�� Method 2: - Click on the File menu and then point on the Create option.  A drop down menu 
appears listing a variety of travel actions.  Click on Request for 1351-2 Settlement and the 
Select Traveler and Travel Order screen appears. 
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3. At this screen, the Travelers table lists all of the Travelers the Proxy can perform services 
for.  Click the desired Traveler’s name and any travel authorizations or travel orders that 
have already been created will appear in the Travel Orders table.   

4. Point and click on the desired order displayed in the Travel Orders table and then click the 
Create Settlement for Selected Order button. 

5. After clicking the Create Settlement for Selected Order button or creating a new order, the 
Request for TDY Settlement screen appears.  Notice that Supplemental is now displayed at 
the Type of Settlement field. 

6. In the Trips Taken section, ensure that the correct trip is highlighted, then click the 
View/Modify button. 

7. The Trip screen appears displaying the itinerary originally entered. 

8. Make any required changes to the various sections of the Trip screen. 

9. When finished, save the claim and send it to the Traveler or the AO for approval. 

 

Entering Supplemental MILPCS Claims (Note: UTS is not used for PCS at this time) 

A Supplemental Claim must be processed when the original claim has been already been 
processed and exported to the computation system (IATS) to be computed and disbursed.  This 
procedure is necessary when an error was made on the original settlement or information was 
omitted.  When a supplemental claim is processed, the total entitlement is recalculated.  The 
difference is then either paid to or collected from the traveler. 

 Complete the following steps to process a Supplemental MILPCS Claim - 
Traveler View: 

1. Login to UTS as a Traveler or change the view to Traveler if necessary. 

2. At the UTS Request Status screen, there are two ways to access the Request for MILPCS 
Travel Settlement screen: 

 179

REtheridge
Note: UTS is not used for PCS at this time)



 

�� Method 1: - Click on the Fill out button.  A drop down menu appears listing a variety of travel 
actions.  Click on Request for 1351-2 Settlement and the Select Traveler Order screen 
appears. 

�� Method 2: - Click on the File menu and then point on the Create option.  A drop down menu 
appears listing a variety of travel actions.  Click on Request for 1351-2 Settlement and the 
Select Travel Order screen appears. 

  

3. At this screen point and click on the desired order displayed in the table and then click the 
Create Settlement for Selected Order button.   

4. After clicking the Create Settlement for Selected Order button or creating a new order, the 
Request for MILPCS Settlement screen appears.  Notice that Supplemental is now 
displayed at the Type of Settlement field. 

  

5. In the Expenses Claimed section, ensure that the correct expense is highlighted, then click 
the View/Modify button. 

6. The Trip or TLE/TLA Allowance screen appears, depending on the type of expenses 
selected, and displays the itinerary or expenses originally entered. 
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7. Make any required changes to the selected expense. 

8. When finished, save the claim and send it to the AO for approval. 

 Complete the following steps to process a Supplemental MILPCS Claim - 
Proxy View 

1. Login to UTS as a Proxy or change the view to Proxy if necessary. 

2. At the UTS Request Status screen, there are two ways to access the Request for MILPCS 
Travel Settlement screen: 

�� Method 1:  Click on the Fill out button.  A drop down menu appears listing a variety of travel 
actions.  Click on Request for 1351-2 Settlement and the Select Traveler and Travel Order 
screen appears. 

�� Method 2:  Click on the File menu and then point on the Create option.  A drop down menu 
appears listing a variety of travel actions.  Click on Request for 1351-2 Settlement and the 
Select Traveler and Travel Order screen appears. 

  

3. At this screen, the Travelers table lists all of the Travelers the Proxy can perform services 
for.  Click the desired Traveler’s name and any travel authorizations or travel orders that 
have already been created will appear in the Travel Orders table.   

4. Point and click on the desired order displayed in the Travel Orders table and then click the 
Create Settlement for Selected Order button. 

5. After clicking the Create Settlement for Selected Order button or creating a new order, the 
Request for MILPCS Settlement screen appears.  Notice that Supplemental is now 
displayed at the Type of Settlement field. 

6. In the Expenses Claimed section, ensure that the correct expense is highlighted, then click 
the View/Modify button. 

7. The Trip or TLE/TLA Allowance screen appears, depending on the type of expenses selcted, 
and displays the itinerary or expenses originally entered. 

8. Make any required changes to the selected expense. 
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9. When finished, save the claim and send it to the Traveler or the AO for approval. 

 



 

Local 1164 Travel 
About Local 1164 Travel 

Local Travel occurs when a traveler performs temporary duty within the designated local travel 
area of their official duty station.  Local Travel is claimed on Standard From 1164 and under 
this circumstance, no per diem is payable.  Typically, the traveler is reimbursed for local travel 
expenses, such as, mileage, parking, tolls, fares, etc.  In addition, some travelers may even be 
authorized reimbursement for occasional meals and lodging.   

 

Creating Local 1164 Travel Claim 
The steps involved in creating a Local 1164 Travel Claim depend on which of the following 
View modes is used: 

�� Traveler 
�� Proxy 
�� Signature Proxy 

 Creating Local 1164 Travel Claim - Traveler View 

1. Login to UTS as a Traveler or change the View to Traveler if necessary. 

2. At the UTS Request Status screen, there are two ways to access the Local Travel - 1164  
screen: 

�� Method 1: - Click on the Fill out button.  A drop down menu appears listing a variety of travel 
actions.  Click on Request for Local 1164 Settlement. 

�� Method 2: - Click on the File menu and then point at the Create option.  A drop down menu 
appears listing a variety of travel actions.  Click on Request for Local 1164 Settlement. 

3. After using one of these two methods, the Local Mileage Claim Rule screen appears.  After 
reviewing this rule, click OK to continue. 

  

4. After clicking on OK at the Local Mileage Claim Rule screen, the Local Travel - 1164 
screen appears. 
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5. Make the required input to complete this screen.  Refer to the topic, “Entering Local 1164 
Claim, listed below under the heading “See Also for additional instructions. 

 Creating Local 1164 Travel Claim - Proxy View 

1. Login to UTS as a Proxy or change the View to Proxy if necessary. 

2. At the UTS Request Status screen, there are two ways to access the Local Travel - 1164  
screen: 

�� Method 1: - Click on the Fill out button.  A drop down menu appears listing a variety of travel 
actions.  Click on Request for Local 1164 Settlement. 

�� Method 2: - Click on the File menu and then point at the Create option.  A drop down menu 
appears listing a variety of travel actions.  Click on Local 1164. 

3. After using one of these two methods, the Select Traveler screen appears.   
4. At this screen, point and click on the desired traveler’s name to make a selection, then click 

the Create Local 1164 for Selected Traveler button. 
5. After clicking on the Create Local 1164 for Selected Traveler button, the Local Mileage 

Claim Rule screen appears.  After reviewing this rule, click on OK to continue. 
6. After clicking on OK at the Local Mileage Claim Rule screen, the Local Travel - 1164 

screen appears. 

7. Make the required input to complete this screen.  Refer to the topic, “Entering Local 1164 
Claim, listed below under the heading “See Also for additional instructions. 

See Also 
Entering Local 1164 Claim  
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Entering Local 1164 Claim 
 Complete the Local Travel - 1164 screen by entering the required 
information at each input field.  Press Tab, Enter, or point and click to 
advance through the various fields. 

  

�� TONO - Type the travel order number for the Local 1164 claim being created. 
�� Type of Claim - At this field, a drop down listing appears displaying Final or Supplemental.  

If entering this claim for the first time, click on Final.  If this claim has been entered previously, 
but is being submitted for re-computation, click on Supplemental. 

�� Method of Payment - At this field, a drop down listing appears displaying Check and Direct 
Deposit.  The default value is Direct Deposit.  If this is the correct method of payment, press 
Enter to continue.  If not, click on Check.   

�� Funds Used - At this field, a drop down listing appears displaying various funding 
organizations.  Point and click on the desired organization to make a selection. 

  

�� Date - At this field, type the date of the first expense being requested for the period of the 
claim. 

�� Type of Expense - At this field, a drop down listing appears displaying a variety of the typical 
expenses associated with Local Travel claims.  Point and click on the desired expense type or 
type a description if the expense being claimed is not listed. 

�� Amount/Miles Claimed - At this field, enter the dollar amount being claimed for the selected 
expense or the number of miles if the expense type is Mileage. 

When finished entering expenses, complete this screen by adding the accounting appropriation 
and any desired remarks. 

See Also 
Inserting Expense  
Deleting Expense  
Entering Accounting  
Entering Remarks  
Canceling Local 1164 Claim  
Saving Local 1164 Claim  
Releasing Local 1164 Claim  
Printing Local 1164 Claim  
Deleting Local 1164 Claim  
Viewing Local 1164 Claim  
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Modifying Local 1164 Claim  

Canceling Local 1164 Claim 
If the initial input or current changes to an 1164 claim have not been saved, there are two ways to 
cancel a Local 1164 Claim or the changes being made: 

1. Click the Cancel button at the bottom of the Local Travel - 1164 screen. 

2. Click on the File menu at the top of the Local Travel - 1164 screen, then click on the Cancel 
all Changes and Return option. 

  

Note:  If the Request for Local 1164 Settlement has been saved previously, the Delete option must 
be used to completely remove the request. 

See Also  
Deleting Local 1164 Claim  

 

Saving Local 1164 Claim 
After completing the required input at the Local Travel - 1164 screen, there are two ways to save 
a Local 1164 Claim.  

1. Click the Save button at the bottom of the Local Travel - 1164 screen. 

2. Click on the File menu at the top of the Local Travel - 1164 screen, then click on the Save 
all Changes and Return option: 

  

3. UTS will save the claim and return the user to the UTS Request Status screen. 
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Releasing Local 1164 Claim 
Local 1164 Claims can be released by either the Traveler or the Signature Proxy.  In addition, 
there are two methods that can be used.   

 Use one of the following methods to Release a Local 1164 Claim: 

�� Method 1: - Click the Send to AO button at the bottom of the Local Travel - 1164 screen. 

  

�� Method 2: - Point and click on the desired Local 1164 Claim listed at the UTS Request 
Status screen, then click the Send to Auth button. 

  

1. After using one of the (2) Release options, the Select Authorizing Official screen appears 
requiring the user to select an AO. 

  

2. At the Select Authorizing Official screen, the name of the traveler’s unit will be displayed at 
the Site field and the designated Authorizing Officials are listed below.  If the correct AO is 
listed click on the desired name, then click on the Transmit to AO button.  The user can also 
click on the Change Site button to select a different unit and see a list of Authorizing 
Officials for the newly selected unit, if necessary.   

3. After selecting an AO, a pop-up appears requiring the entry of a Confirmation Password.  
This is the Secondary Password that was created when the user’s Personal Profile was 
created. 

4. After entering the confirmation password, UTS forwards the transaction to the AO and 
displays the UTS Request Status screen..  
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Printing Local 1164 Claim 
 Complete the following steps to print a Local 1164 Claim: 

1. Click the Print button at the bottom of the Local Travel 1164 screen. 

  

2. After the Print button is clicked, the Print Setup scren appears.  Verify that the PC is 
configured for the correct printer or make any necessary changes.  When satisfied that the 
correct printer information is displayed, click the OK button. 

  

3. UTS begins printing the 1164 form and displays a pop-up indicating that the form has been 
printed.   

  

4. Click the OK button to continue. 
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Deleting Local 1164 Claim 
There are several ways to delete a Local 1164 Claim.  The method to use, however, depends on 
which input screen is currently displayed. 

 Complete the following steps to delete a Local 1164 Claim: 

  

1. Login to UTS.  Afterwards, change the view to Traveler or Proxy, if necessary. 

2. At the UTS Request Status screen, there are three methods for deleting a Local 1164 claim: 
�� Method 1: - Point and click on the desired Local 1164 claim listed in the Claims List.  After 

selecting a claim, click the File menu and then select the Delete option.  A pop-up appears 
asking if you are sure you wish to delete this claim.  Click on Yes. 

�� Method 2: - Point and click on the desired Local 1164 claim listed in the Claims List.  After 
selecting a claim, click the Delete button.  A pop-up appears asking if you are sure you wish to 
delete this claim.  Click on Yes. 

�� Method 3: - Point and click on the desired Local 1164 claim listed in the Claims List.  After 
selecting a claim, click the Modify or View button.  After clicking the Modify or View button, 
the Local Mileage Claim Rule screen appears. 

  

After reviewing this rule, click on OK to continue and the Local Travel - 1164 screen appears.  
At this screen, click the Delete button.  A pop-up appears stating Deleting this Request?  Click 
on Yes. 

 189



 

Viewing Local 1164 Claim 
On occasion, it may be necessary to View a Local 1164 Claim that has been created and saved.   

 Use one of the following methods to View a Local 1164 Claim: 

1. Login to UTS. 

2. At the UTS Request Status, or UTS Requests Requiring Action screen, there are two 
methods for viewing the Local Travel - 1164 screen: 

�� Method 1: - Point and click on the desired Local 1164 Claim listed in the Claims List.  After 
selecting a claim, click the File menu and then select the Modify or View option.   

  
�� Method 2: - Point and click on the desired Local 1164 Claim listed in the Claim List.  After 

selecting a claim, click the Modify or View button. 
3. After using either of the two methods, the Local Mileage Claim Rule screen appears. 

  

4. After reviewing this rule, click on OK and the Local Travel - 1164 screen appears. 

5. When finished Viewing the claim, click the Save button, the Cancel button, or the X in the 
top right hand corner of the Local Travel - 1164 screen, and answer Yes at the Cancel this 
screen pop-up. 
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Modifying Local 1164 Claim 
On occasion, it may be necessary to Modify a Local 1164 Claim that has been created and saved.   

 Use one of the following methods to Modify a Local 1164 Claim: 

1. Login to UTS. 

2. At the UTS Request Status, or UTS Requests Requiring Action screen, there are two 
methods for viewing the Local Travel - 1164 screen: 

�� Method 1: - Point and click on the desired Local 1164 Claim listed in the Claims List.  After 
selecting a claim, click the File menu and then select the Modify or View option.   

 

�� Method 2: - Point and click on the desired Local 1164 Claim listed in the Claims List.  After 
selecting a claim, click the Modify or View button. 

3. After clicking on the Modify or View button, the Local Mileage Claim Rule screen appears. 

  

4. After reviewing this rule, click on OK to continue and the Local Travel - 1164 screen 
appears. 

5. At the Local Travel - 1164 screen, press Enter or Tab to advance through the input fields, or 
point to the desired field and click the left mouse button.  Type the required change or select 
a new option as needed. 

6. After making the desired changes, click the Save button. 

See Also 
Inserting Expense  

Deleting Expense  

Entering Accounting  

Entering Remarks  
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UTS-Email 
About UTS-Email 

A new feature has been added to UTS that allows a Traveler, Proxy or AO to send an E-mail 
message to each other to notify the recipient that a Request for Authorization, Settlement, or 
Advance was forwarded.  When this new feature is used, UTS automatically generates an E-mail 
message containing information pertaining to the Traveler’s ID, Travel Order Number and the 
Trip Dates.   

In addition, the user may also include a Personal Email Message if additional information is 
needed.  UTS automatically appends this message to the system-generated message when a 
Request for Authorization, Settlement, or Advance is forwarded. 

  

See Also 
Set-up Email Address  

Create Personal Message  

Sending Email  

 

Set-up Email Address 
In order to use the UTS feature to receive an Email message, an Email address must be entered 
into the Additional Information section of the Personal Profile.   

Note:  This task can be performed by a user in the Traveler view mode only. 
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 Complete the following steps to enter an Email address: 

1. Login to UTS as a Traveler or change the view to Traveler if necessary. 

2. At the UTS Request Status screen, click on the Profile menu.   

  
3. At the Profile drop down menu, click on the Modify or View Profile option. 

4. At the Personal Profile screen, click on the Security button.  The Security Information 
screen appears. 

5. At the Personal Profile screen, click on the Security button.  The Security Information 
screen appears. 

6. At the Security Information screen, click in the Office Email Address field in the 
Additional Information section. 

  

7. Type the traveler’s Office Email Address in this field.   

8. After completing the Office Email Address field, click the Previous Screen button.   

9. At the Personal Profile screen, click the Save button to save the Email address entries. 

 

Create Personal Message 
A new feature has been added to UTS that allows a Traveler, Proxy or AO to send an E-mail 
message to each other to notify the recipient that a Request for Authorization, Settlement, or 
Advance was forwarded.  When this new feature is used, UTS automatically generates an E-mail 
message containing information pertaining to the Traveler’s ID, Travel Order Number and the 
Trip Dates.   

In addition, the user may also include a Personal Email Message if additional information is 
needed. 

 Use one of the following methods to send a Personal message: 
�� Method 1: - Point and click on the Tools menu, if displayed, and then select the Create an 

Email Message option. 
�� Method 2: - Point and click on the Envelope icon located at the top of the UTS Request 

Status or UTS Request Requiring Action screen just below the menu bar. 

1. After using method 1 or 2 above, the Email Message screen appears. 
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2. At this screen, type the desired Personal Email message.  UTS will add the text entered to the 
system-generated Email message when a Request for Authorization, Settlement, or 
Advance is forwarded. 

3. After typing a Personal message, click the Return button to return to the previous screen. 

 

Sending Email 
If an Email address has been set-up for the intended recipient in the UTS database, UTS 
automatically creates and sends the Email message at the time the Request for Authorization, 
Settlement, or Advance is forwarded.  No additional action is necessary. 

See Also 
About UTS Email  

Set-up Email Address  

Create Personal Message  
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